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How to Find Information Resources

You can access the information resources for Server Automation using any of the following methods:

Method 1: Access the latest individual documents by title and version with the new SA Documentation
Library

Method 2: Use the complete documentation set in a local directory with All Manuals Downloads
Method 3: Search for any HP product document in any supported release on the HP Software
Documentation Portal

To access individual documents:

1 Gotothe SA 10.x Documentation Library:

http://support.openview.hp.com/selfsolve/document/KM00417675/binary/
SA_10_docLibrary.html

2 Loginusing your HP Passport credentials.

3 Locate the document title and version that you want, and then click go.
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To use the complete documentation set in a local directory:

1 To download the complete documentation set to a local directory:

a

b
c
d

e

Go to the SA Documentation Library:

http://support.openview.hp.com/selfsolve/document/KM00417675/
binary/SA_10_doclLibrary.html

Log in using your HP Passport credentials.

Locate the All Manuals Download title for the SA 10.1 version.
Click the go link to download the ZIP file to a local directory.
Unzip the file.

2 To locate a document in the local directory, use the Documentation Catalog (docCatalog.html), which
provides an indexed portal to the downloaded documents in your local directory.

3 Tosearch for a keyword across all documents in the documentation set:

a
b
c

d

Open any PDF document in the local directory.
Select Edit > Advanced Search (or Shift+Ctrl_F).
Select the All PDF Documents option and browse for the local directory.

Enter your keyword and click Search.

To find additional documents on the HP Software Documentation Portal:

Go to the HP Software Documentation Portal:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, click
the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service.
Contact your HP sales representative for details. See Documentation Change Notes for a list of any
revisions.

Product Editions

There are two editions of Server Automation:

e Server Automation (SA) is the Ultimate Edition of Server Automation. For information about Server
Automation, see the SA Release Notes and the SA User Guide: Server Automation.

e Server Automation Virtual Appliance (SAVA) is the Standard Edition of Server Automation. For more
information about what SAVA includes, see the SAVA Release Notes and the SAVA at a Glance Guide.
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1 SA Provisioning Concepts

HP Server Automation (SA) provides the ability to provision servers out-of-the-box, including, but not
limited to, the base operating system for a variety of targets both physical and virtual.

You can also use SA to provision firmware and applications and any other steps required to promote
servers into production.

SA can also reliably and consistently provision a large number of operating systems with no manual
intervention. SA includes both out of the box content and an extensive framework that allows you to
customize the way servers are provisioned.

SA Provisioning Features

SA Provisioning has the following benefits:
*  Provisioning that simply works right out-of-the-box

SA Provisioning provides you with a distinct advantage over other operating system installation and
multi-purpose provisioning tools by providing a reliable, intuitive interface that is consistent no
matter the configurations being provisioned. SA provides a set of baseline Build Plans (provisioning
templates) that, out-of-the-box, can be used to provision and configure almost all SA supported
operating systems. You can easily customize your own Build Plans by copying an existing plan and
modifying it for your specific needs.

*  Flexible architecture designed to work in many environments

SA Provisioning supports many types of servers, networks, security architectures, and operational
processes across a large variety of hardware models. This flexibility ensures that you can provision
operating systems to suit your organization's needs.

* Update server baselines without re-imaging

Unlike many other provisioning solutions, systems provisioned by SA can be easily changed when you
need to adapt to new requirements. The key to this flexibility is SA’s use of reusable templates and an
installation-based approach to provisioning.

* Integration with other SA features

Because SA Provisioning is integrated with the suite of SA automation capabilities, including patch
management, software management, and distributed script execution, hand-offs between IT groups
are seamless. SA ensures that all IT groups are working with a shared understanding of the current
state of the environment, which is essential to high-quality operations and delivery of reliable change
management.
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SA Provisioning Basics

The provisioning feature has three main moving parts:
*  The Build Plan framework
* A minimal service 0S

*  Qut of the box content

The Build Plan Framework

A Build Plan consists primarily of a list of steps that can be executed against a target server (the server to
be provisioned). These steps carry out various tasks that ultimately provision a server. The framework
includes an execution engine that runs the steps sequentially. This makes understanding Build Plans and
their actions easy and intuitive.

Build Plans are SA objects, and as such, they can be viewed and manipulated in the SA Client Library.

A number of baseline Build Plans are included when an SA Core is installed. These Build Plans can, by
default, perform many common provisioning tasks.

Multiple Build Plan steps types are supported such as running a script, deploying a zip package or
deploying a configuration file with parameter substitution.

Other step types integrate with various SA features and provide the ability to attach software policies,
start remediation, join a device group and more.

The Service 0S

SA ships with several minimal RAM-based operating systems that can be started over a network, from
physical or from virtual media (CD, DVD or ISO images), on a physical server or virtual machine.

These are called Service OSes.

Because of the limited functionality within a service 0S, only a subset of SA operations can be run against
a server that has been booted into a service 0S. The primary purpose of a service 0S is to enable
installation of a full operating system, also known as a Production 0S as well as other maintenance tasks
that cannot be performed from a production 0S.

The service 0S is the means by which the Build Plan framework gathers information and executes tasks on
a target server.

These service 0Ses make use of a special instance of the SA Agent configured to run in this limited
environment. Starting a server in the service 0S is also known as bringing the server into Maintenance
mode. Servers in Maintenance mode are recognizable by the icon that is displayed in the SA Client and by
their Maintenance status.

Maintenance Icon

33
Service 0Ses can be booted on any server, whether or not it has an installed 0S. A server can safely be
booted from a production 0S into Maintenance mode and back.

» Note: While running the Service 0S is not in itself destructive, you can execute destructive actions inside
the Service 0S, like erasing the disk so care must be taken.
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Out-of-the-box Content

The out-of-the-box content is a collection of Build Plans populated with Build Plan steps that deliver
functionality for common use-cases and are the basic building blocks for user-created Build Plans.

This includes provisioning of operating systems, network configuration and end-to-end provisioning of HP
ProLiant servers (including firmware and hardware configuration management).

Using this functionality is as simple as running the Build Plans.
The out-of-the-box content is installed as part of SA Core installation or upgrade.

Installation-specific parameters can be customized either by editing the command-line arguments of
script steps in the Build Plans or by specifying Custom Attributes. The custom attributes that influence the
behavior of an out-of-the-box Build Plan are set with blank values on the Build Plan object.

Custom attributes can be specified using a Build Plan or can be specified at the server, device group or
facility level. Custom Attributes are a generic parameter passing mechanism in SA.

See the Defining Custom Attributes on page 136.

SA Provisioning uses a Media Server to serve large objects like 0S installation media, system images (e.g.
Windows WIM images) and collections of drivers and firmware to the server being provisioned.

Multiple transfer protocols are supported: HTTP, HTTPS, NFS and SMB (Windows shares).

Please refer to the SA Provisioning Matrix to determine which protocols are supported with the operating
system(s) you want to provision.

SA includes a media server that can serve media through SMB and NFS. The Media Server is installed when
you choose to install the SA Provisioning Components.

» Note: You can use any server that supports the transfer protocols above to store and serve media. The
location of the media server is specified in the Build Plan.

SA Provisioning Concepts 15
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2 Performing SA Provisioning

This section describes the SA Provisioning process.

Required permissions

Before you can configure or perform SA Provisioning, your SA Administrator must have granted you a
specific set of SA Provisioning permissions.

You must also have permissions to access the servers associated with SA customers, facilities or server
groups. For more information, see the SA Administration Guide, Appendix A: “Permissions Reference”.

The SA Provisioning Process

This section will guide you through provisioning servers in three easy steps using only the out-of-the-box
provisioning content (baseline Build Plans).

The Provisioning process consists of several phases:

Phase 1: Preparing the Media

Phase 2: Preparing Target Servers

Phase 3: Running a Build Plan

If you want to customize how SA performs provisioning, see Creating New SA Build Plans on page 67.

You can find examples in SA Provisioning Common Use Cases on page 47.

> Note: Ensure that the DHCP Server has been configured for SA Provisioning as described in the SA
Installation Guide, “DHCP Configuration for OS Provisioning”.

See Creating New SA Build Plans on page 67 for advanced information and SA Provisioning Common
Use Cases on page 47 for sample step-by-step procedures.
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Phase 1: Preparing the Media

Depending on platform and operating system, one or more of the following protocols are supported for
provisioning using Build Plans:

- HTTP/HTTPS
- NFS
- SMB/CIFS.

See the Provisioning section of the SA Support and Compatibility Matrix for more information about
supported platforms and protocols.

In addition, Solaris 11 installations will require an IPS package server, provided either by Oracle Corp. or
hosted in-house.

General Guidelines for Preparing the 0S Media

*  Unpack the vendor provided ISO(s) on the media server in a shared path.
For example, extracting an IS0 on a Linux system:

mount -o loop,ro /path/to/media.iso /mnt/media
cp -ar /mnt/media /shared/path/extracted_media

*  Ensure that the Media Server does not alter file paths. For this reason HP recommends that you use a
Linux-based Media Server.

*  See the Set Media Source step in the Build Plan you want to run. Double-check the protocol, media
server and share path to the media. Note that some deployments support multiple protocols.

*  Verify that the processor architecture of the media matches the architecture of the Build Plan you are
using.

HTTP/HTTPS

0S installations that support fetching media through HTTP/HTTPS provide flexibility when accepting
media sources. You can use an in-house server, an external server or an official mirror (this allows you to
bootstrap a media server without handling 0S installation yourself).

See the documentation for your preferred HTTP/HTTPS serving solution for instructions about how to set
up a share.

*  Apache HTTPD documentation:
http://httpd.apache.org/docs/

* Nginx documentation:
http://nginx.org/en/docs/

*  Microsoft IIS documentation:

http://www.iis.net/learn

> Note: Accessing a media server using HTTP/HTTPS through a proxy is not supported.
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NFS

0S Media files shared through NFS must be read-accessible by any user from the servers that require
provisioning. Check and adjust file and directory permissions as necessary.
See the documentation for your operating system for information about how to export NFS shares.

The following is a sample /etc/exports file, which exports the directory /media (and all its
subdirectories) as read-only to all hosts:

/media *(ro)

Run the following command to test-mount the NFS share from a client machine:
Linux

mount -t nfs -o ro <media-server-host>:/media /mnt/

Solaris

mount -F nfs -o ro <media-server-host>:/media /mnt/

The SA Core has, by default, two NFS exports dedicated to sharing 0S Media activated.
These exports are listed in /etc/exports as:

/media/opsware/linux * (ro,no_root_squash, async, insecure)
/media/opsware/sunos * (ro,no_root_squash, async, insecure)

SMB/CIFS

SA Provisioning supports SMB shares hosted on a variety of platforms, including Windows, Linux or UNIX
servers and dedicated NAS appliances. Files can be accessed either through guest accounts or secured
with username/password.

For more information about configuring SMB shares under Windows, see the Windows documentation at:
http://technet.microsoft.com/en-us/library/cc770406.aspx

For more information about configuring SMB shares under UNIX platforms using Samba, see the Samba
documentation at:

https://www.samba.org/samba/docs/
The SA Core provides an SMB share named OSMEDIA which is active by default, in:

/media/opsware/windows

Solaris 11 IPS

In order to successfully complete provisioning, Solaris 11 Build Plans require an IPS repository that is
accessible through HTTP in addition to the installation media.

> Note: You must use a dedicated IPS server. Serving a local file-based repository through HTTP using a
generic server (e.g. Apache, Nginx) is not supported.

The simplest Solaris 11 IPS solution is to use the central Solaris 11 IPS repository, available at:
http://pkg.oracle.com/solaris/release/

However, you may want to host an in-house repository for performance, package validation before
entering production, inclusion of custom packages etc.

See the instructions for setting up and administering a local repository at:

http://docs.oracle.com/cd/E23824_01/html/E21803/repo_int1.html
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> In addition to these instructions, HP recommends setting up a reverse caching proxy on top of your local
IPS server. Performance testing has shown that a non-cached IPS server cannot successfully provide
packages to more than five simultaneous Solaris 11 deployments.

Phase 2: Preparing Target Servers

This section describes setting up and configuring your provisioning target servers.

Target Server Requirements

Before you can discover servers for SA Provisioning, you must ensure that the servers are set up properly
and meet the following requirements:

Ensure that at least one network interface is configured. If you are going to network boot, the
deployment interface must be on the same network as the SA Boot infrastructure. Otherwise, at least
one SA Agent Gateway must be reachable.

There can be only one network interface (NIC) attached to the deployment network.

For HP ProLiant servers, ensure that the iLO is connected to the network and is reachable by SA
through the same SA Realm as the server it controls.

» Note: Realms are an SA construct that allow SA to manage servers on different networks in the same
Facility without fear of IP address conflicts. A realm is a unique identifier, appended to the IP address of a
device in a Facility's network, that allows SA Gateways to uniquely identify devices on different networks
in a Multimaster Mesh that may have conflicting IP addresses. See also the SA Overview and Architecture
Guide.

Choosing How to Boot Servers

SA Provisioning supports the following methods to boot a server:

Network booting: suitable for fully automated deployments on heterogeneous hardware and virtual
machines. This requires that the server be on the same network as the SA Boot Server and that the SA
network boot infrastructure is configured (DHCP and PXE server is running).

CD booting: targeted for environments where network booting and DHCP are not configured or the
server is not in the same network as the SA boot server.

Embedded 0S booting: eliminates the need to configure an SA network boot infrastructure without
sacrificing automation. Only available for HP ProLiant Gen8 or newer servers and is also known as
Intelligent Provisioning.

When Do | Add Servers Using iLO Registration?

You have an HP ProLiant server with iLO 2 or newer remote management available.
You have theiLO credentials for your target server.
You have an HP ProLiant Gen8 or newer server and you do not want to use DHCP and network boot.

You do not want a special access account automatically created on your iLOs. See iLO Support on
page 29.
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When Should | Network Boot Using iL0?

You want to discover all the server information so you can see it and use it for search in the SA Client
prior to provisioning.

You want to verify the server network connection before running a Build Plan.

You want to see the server listed by its default DNS name.

You do not have iLO credentials for your target servers.

You do not want to use Intelligent Provisioning on your ProLiant Gen8 or newer servers.

You prefer the simplicity of a power-on discovery because your servers automatically network boot.

You have a large number of servers and you find it more practical than compiling a list of iLO network
addresses and credentials.

When Do | Use Intelligent Provisioning?

You want to run a Build Plan immediately and do not want to manually boot the server.
You want to leave the server powered off until you are ready to install it.

All your servers are of the same type so you do not need the full properties information.

Network Booting

SA provisioning supports network booting X86 and X86_64 target servers. UEFI network booting support
is also available but only on UEFI-capable HP ProLiant servers.

SA, by default, is configured to network boot servers that are not yet registered with the SA Core into the
“Linux” boot option. This enables you to bring a server into Maintenance mode simply by ensuring that the
target server requirements are met and powering on the server. Subsequent boots will default to the
“Local disk” boot option.

You can network boot manually to a desired maintenance 0S but booting can also be controlled using the
Managed Boot Clients Web Extension or by adding a “Boot” step to a Build Plan. If iLO support is available,
selecting the desired network boot option and powering on the server will also be handled by the “Boot”
step. For servers without iLO, HP recommends specifying the “Network” boot option in the boot order first
S0 you can boot a server to a maintenance 0S without intervention.



From the network boot menu for a legacy BIOS server you can boot 32/64-bit Linux, Windows PE or Solaris
maintenance 0S..

HPSA 03 Build Plan Service 05 Menu
HPSA 0S Sequence Build Agent Menu
Boot from local disk

Autoboot: Linux 6d4-hit Service 03

Hardware Information

Automatic boot in seconds. ..

From the network boot menu for a UEFI server you can boot a 64-bit Linux or Windows PE maintenance
0s.

GNU GRUB versiom 2.00

"Linux b4-bit Service 03" from ZEPPELIN (192.168.59.2)

"Windows 64-bit Service 05" from ZEPPELIN (192.168.59.2)
Continue in UEFI boot order

Use the & and * keys to select which entry is highlighted.
Press enter to boot the selected 0S, ‘e’ to edit the commands
before booting or "¢’ for a command-line. ESC to return
previous menu.

The highlighted entry will be executed automatically in 6s.




After the server is running a Maintenance mode Linux 0S, you see a screen similar to:

waiting for hardware to initialize...
dete
ting hardware...
waiting for hardware to initialize...

funming anaconda 13.Z21.195, the Red Hat Enterprise Linux system installer - plea

Ee wait.
sing 192.168.59.2:3881 as ngent Gateway.
lease wait for the server to register with the HP SA core...
Ferver successfully registered with the HPSA core.
PSA Serwver ID : 186881
Ethd Link encap:Ethernet HWaddr BB:58:56:B1:82:23
inet addr:192.168.59.163 Bcast:192.168.59.255 Mask:255.255.255.8

Link encap:Local Loopback

inet addr:127.8.8.1 Mask:255.8.8.8
Btarting up the HP3A OGF3 agent. ..
berver is now in MAINTENANCE mode.

or, in a Maintenance mode Windows PE 0S:

Tail for Win32 - [Non-Workspace Files - X:\windows\TEMP\_tail_.
File Edit View Settings Window Help

P
Autoconfiguration Enabled . . . . : Yes
IPv6 Address. . . . . .. . ... : fc00:699:1:0:dce7:29f6:3b60:f4d2(Preferred)
Temporary IPv6 Address. . . . . . : fc00:699:1:0:493f1be8:b268:89e0(Preferred)
Link-local IPv6 Address . . . . . - fe80::dce7:29f6:3b60f4d2 % 2(Preferred)
IPv4 Address. . . . .. .. ... : 19216859 15(Preferred)
Subnet Mask . . . ... ... .. : 255.255.2550
Lease Obtained. . . . . ... .. - Wednesday, May 28, 2014 1:17:31 PM
Lease Expires . . . . ... ... : Wednesday, May 28, 2014 4:17:31 PM
Default Gateway . . . . . . ... : feB0:224:a8fffe32:cd00%2
152.16859.1
DHCP Server . . . .. .. .. .. - 1592.168.59.2
DHCPvE 1AID . . . . . . ... .. : 33574998
DHCPvE Client DUID. . . . . . . . : 00-01-00-01-1B-18-0A-C)-00-50-56-B1-02-23
DNS Servers . . . ... ... .. - 1592.168.162.139
MNetBIOS over Tcpip. . . . . . . . : Enabled
Starting up the HPSA OGFS agent..
Please remove the boot CD you may have used up to this point before proceed to OS5 Provision
Server is now ready for provisioning.
! | o
Last updated: 13:18:08 | |
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Also note the identifying information like the SA object ID (machine ID, or MID), IP address or MAC, so you
will be able to find the device in the SA Client’s Unprovisioned Servers list.

[EA|HP Server Automation - 192.168.59.2

_ |0 x
File Edit Wiew Tools Window Actions Help

@ Logged in as: axis_osbuildplan_test_user
Search i’H Unprovisioned Servers

I Servers Properties

I Saved Searches .. Fil| localhost-WMuare-yMware Virtual FlatFarm localhost 192.168.59.163 00:50:56:81:02:23
Advanced Search

& i Device Groups
. @ axis_osbuildplan_test_user

B Public

Er ) Servers

BB All Managed Servers
A8 Oracle Solaris Zones
[T Unpravisioned Servers
E] 54 Agent Installation

Hostriame P Address MAC Address

100001 OGFS Agent =

Properties V]
Management Information 2
MName: localhost-YMware-YMware Virtual Platform
IP Address: 192.168.59.163
Description: -
Customer: Mot Assigned
Boime Facility: ZEPPELIM
Realm {link speed): -
@ Virtualization Server Lse: Mot Specified
Server Lifecycle: Available
@l@ Lbrary uum: 4231e032-c5d4-2ecS-c063-3c0d5395 189
Object 1Dt 100001
W Repatls Reboot Required: Mo
@ Jobs and Sessians O3 ersion: Uniknowin
Deployment Stage: Mot Specifisd
E} Administration Locale:
Status:

In Maintenance

.

1 item selected

avis_nsbuidplan_test_user | 5{26/14 6:04 AM AmericafLos_Angeles
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Managed Boot Clients

The Managed Boot Clients Web Extension allows you to create a server record with a pre-configured

network boot option or configure network booting for an existing server record matched by a MAC
address.

It also enables you to select a Build Plan to run automatically when the server reaches Maintenance mode.
To do this, run the extension and perform the steps below.

[EAJHP Server Automation - 192.168.59.2 _ O] x

File Edit View Tools ‘Window  Actions  Help @I;Dggsdinas: axis_osbuildplan_test_user

Search

I Servers LI
|
[

Properties =

Mame =

Location Version Modified

<]
I Saved Searches ... @5 Run O3 Build Plan 1Cpsware/Tools/O3 Provisioning S5.0,501... Si21714 343 AM opsware ;I
Advanced Search %ﬂ MEC DHCP Cleanup IOpsware/Tools/O3 Pravisioning/Manage... 55.0,497... 5f21f14 3142 AM opsware
% HP-UX Wirtualization Manager fOpsware/ToolsMirtualization Programs 55.0.456... S5fZ1714 3:43 AM opsware
By Type | O | @5 HP-LI% Provisioning o [Opsware|ToolsfOS Pruv?s?on?nngP-UX 550,475, SZ1/14 543 AM opsware
%ﬂ HP-U Custom Config Editor T0psware/Tools/OS Pravisioning/HP-Ux S5.0,475... Sf21f14 3143 AM opsware
Bl Application Conifiguration 5 E3 Custom Field Management fOpsware/Tonlsfadministrative Extensions  55.0.456... 521114 3:42 &M opsware
[]“@( At snd R emedistion % Command-line Logging Uity fOpsware/ToolsfAdministrative Extensions  55.0.456... S5fZ1/14 3:42 AM opsware
fiig Business Applications €3 Active Directory Credential Store fOpsware/Tools{OS Provisioning/BROC 5., 55.0,497...  5/21/14 3:42 AM opsware
(-5 Chef Cookbooks
|3 Databases
ﬁ Extensions
@3 Web
% Program
05 Build Plans j
[E23 Packages S .
#1-(3) Patches Hame: Manage Boat Clients
[]--a Scripts
r_:,..\ar Saftware Policies Set up PHE boot behaviar, sutomatic OS installation, and mass-set custom attributes on servers
b ary k=4
| _>l_I
Description:
Egﬁ Devices
@ Wirtualization
| G@ Library Location: [Opsware|Tools{OS Provisioning/Manage Boot Clients

Reports URL: https:if192, 168,59, 2fwehapp/osprov manage boot clisnts wab,

Last Modified:
Eﬂ Jobs and Sessions

S/21/14 3:42 AM by opsware

Created: 5/21/14 3142 aM by opsware
{:‘} Administration
Unigue Mame:  osprov.manage_book_clients_web
»
b3 Object ID: 80001

1 item selected axis_osbuildplan_test_user | 52714 5:36 AM America/Los_Angeles
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1 Define a server.

You can also register an iLO with the target server during this step. Select “Enabled iLO Settings” for
additional input.

Managed Boot Clients - General Form

Specify the server's unigue MAC Address and optionally selectwhich Customer and Facility the server should be assigned io '@
* MAC Address: Joo-01-02-03-04-05 B
DHCF Hostharme |5howcasehostname.dev.sa.hp.com

DHCP IP Address: |192 168.55.13

E-mail notification on ll—
failure:

E-mail nofification an l—
SUCCESS!

Customer: INot Agsigned 'I

Facility IZEPPEL\N 'I

[T Enable iLO Settings

Multiple Client Form... |

L«

2 Select aboot image and a Build Plan

Managed Boot Clients - OS-Specific Parameters

Configura how the server will reach the unprovisioned server pool. You may choose between an OS Build Plan or an OF Sequence to be automatically run, @
elirinating the need to use the Run OF Build Plan arthe Install 05 Sequences wizards, =

= gﬁﬂggﬁf;ﬂ?ﬁ;m @ 03 Build Plans © 05 Sequences
= PHE image: winpebd_40-ogfs 'I
05 Build Plan: IWindows 2012 R2 xB54 Default Install j

< Back |
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3 Customize by adding custom attributes, if required, and press Start.

Managed Boot Clients - Add Custom Attributes

Custom atfribute namefvalue pairs may be associated with the server record by adding them to the table belowr @
Name Value
|Pr0duct|—(ey |a valid product key

| |
ﬂl Remove |

Ticket ID [sample]

= Back | Siar{l

After the Build Plan job completes, a Pre-Unprovisioned server record is created with any defined

Custom Attributes.
[A[HP Server Automation - 192.168.59.2 9=l E3
File Edit Wiew Tools \Window Actions Help @’ Logged in as: axis_osbuildplan_test_user

5] Custom Attributes ¥

I Servers

I Saved Searches ...

dhiy

Ll i@ L

et 1 LIMET W 11, Age

Agent
Advanced Search

E!--@ Device Groups
% axis_osbuildplan_test_user
@ Public
Eii}' SErvers
i E}H Al Managed Servers
(’ Oracle Solaris Zones
@}" Unpravisioned Servers

S Agent Installation

=
= om Attrib &
Mame -
Mame - Source Valug |E§
'@"] auto_partition Locally Specified Value 1 ;I
Q‘] buildplan_id Locally Specified Yalue 940001
'@"] Productkey Locally Specified Value a valid product key
E& Devices
@ Yirtualization
@@ Library
Reports
=
Jobs and Sessions
{;ﬁ Administration
»
- =
3 items axis_osbuildplan_test_user ‘ 527114 5:25 AM Americaflos_Angeles
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Additionally, DHCP is configured in /etc/opt/opsware/dhcpd/dhcpd_mbc . conf:

# Begin Opsware added hosts (do not edit)
host showcasehostnamedevsahpcom {
hardware ethernet 00:01:03:04:05:06;
option host-name showcasehostname;
fixed-address 192.168.59.13;

}
# End Opsware added hosts (do not edit)

SA Provisioning-supplied CD Boot Images

SA Provisioning provides several service operating system boot CD images (IS0s) that you can burn to CD/
DVD. These images enable you to bring a server into maintenance without having configured DHCP.

You can also configure these IS0 images in virtual machine CD-ROM drives or mount them usingiLO Virtual
Media or similar technology.

To download the desired ISO, open the SA Client and in the Navigation Pane, go to the Library tab then
select the “By Folder” view and navigate to:

/Opsware/Tools/0S Provisioning/
/Opsware/Tools/0S Provisioning/WinPE

Select the desired ISO image and from the Actions menu select Export software...

After booting the CD, you can use the boot configuration screen to enter all the information needed to
bring a server into Maintenance mode. The settings that you specify here are preserved on the server in
the hpsa_netconfig custom attribute.

Maintenance mode Linux OS static boot configuration screen:

IP Configuration details

= Interface:
(%) ethd BB:58:56:B1:82:23

IF Address

Network Mask [£55.255.255.8

Default gateway: Enter Network Router details
DHS Server(s):

DNS Search Path:

FQDN:

xS0 Server 1p:

The 3SA Server I[P should be the nearest SA core slice component or 3A
satellite.

= Mandatory fields




Maintenance mode Windows PE OS static boot configuration screen:

Initializing WinPE. Please he patient....
Interface™ [Intel(R) PROJ1000 MT Network Connectio ~ |
MAC Address:  00:50:56:B1:02:23

" DHCP -

f |IPAddress:  [168][z5a)[s5 |[60]

? | Netmask: @EHII 2:cd@@x2
i ’ Gateway: EIEIEIEI
i DNS Server: l:”:”:”:l

| | DNS Suffix: |

file in the floppy dei]

OBTAIN A DHCP IP.

-Server Automation Agent Gateway

Hostname } IP; |

0K Cancel I

Embedded 0S Booting (Intelligent Provisioning)

Embedded 0S booting is supported only for HP ProLiant Gen8 or newer models. This boot method’s
advantage is that you can move a server into Maintenance mode without enabling network booting or
configuring DHCP, as long as you provide static IP information.

Note that embedded 0S booting must be initiated from the SA-provided “Boot” step and you can boot
either a 64-bit maintenance mode Windows PE or Linux 0S. See the “Boot” step description for more
details.

iLO Support

iLO support is provided by SA to enable operations like:
Power control
Querying or changing the one-time boot option
Querying or changing the server boot mode (Legacy or UEFI) for UEFI capable HP ProLiants

Instructing HP ProLiant Gen8 or newer model servers to boot from the embedded 0S (Intelligent
Provisioning)

iLO support is enabled in SA, either automatically (see Auto-Discovery) or through manual registration
when an iLO manager is associated with a server.

iLO Auto-discovery

When bringing an HP ProLiant server with iLO 2 or newer into a Maintenance mode 0S, SA automatically
starts an iLO registration job to associate an iLO manager with that server.

As part of this process, a new iLO user is created, hp_automatic_integration_user, with a strong
random password. If the iLO is unregistered or the server record is deleted, this iLO user will also be
removed (if connectivity to theiLO is still available).



Manual Registration

To manually register iLOs:

1 Select AddiLO Device from the drop-down menu in the SA Client’s Unprovisioned Servers list:

[El]HP Server Automation - 192.168.59.2

=] B3
File Edit View Tools MWindow Actions Help B}flzoggedlnas:ax\sfosbuwldplanftestfuser
IServars

Properties

[=]
I
[=]

P Address Customer
I Saved Searches ..
Advanced Seatch
Manage Boot Clients...
[=2 @ Device Groups
- % axis_osbuildplan_test_user

‘g Public

i servers

81" All Managed Servers
@ Orarle Solaris Zones
Em'ﬂ Unprovisioned Servers
IJ SA Agent Installation

Mo devices matched the filter criteria

@ Wirtualization
ﬁ@ Library
Reports

@ Jobs and Sessions

ﬁ Administration

g

0of 2 items

[

axis_osbuildplan_test_user ‘ Si27/14 7:02 AM AmericafLos_Angeles
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2 Specify theilLO IP address or hostname, port and credentials. You may also need to select a different
SA Realm if iLO connectivity is only available to SA Agent gateways from a specific realm. Note also
that you can register multiple iLOs if they share credentials.

After iLO registration completes, a new server record is created and associated with an iLO manager.

&8 'Run 05 Build Plan =
Add iLD Devices
AddiLD Devices

To add a new iLO/Gens device ko HP SA enter the following information,

iLD IP Addresses /iLO Hostname:

iLO Port (Dptional):

User Name:

Password:

Realm: Select Realm

Current Realm: ZEPPELIN-agents

b AddilO Devices

Add iLD Devices Results:

iLD IP Address Status Result

Detailed Status: -

However, a new server record is not be created if an existing server matches the one discovered by the iLO.

See the SA Users Guide: Server Automation, “Exploring Servers and Device Groups in the SA Client”.

Performing SA Provisioning

@ Run 05 Build Plan I[=]
AddiLO Devices
Add iLO Devices

To add a new iLO/Gen? device to HP SA enter the following information.

iLO IP Addresses /iLO Hosthame:

iLO Port (Dptional):

User Name:

Password:

Realm: Select Realm

Current Realm: ZEPPELIN-agents

dgp AddilLO Devices

Add iLO Devices Results:

iLD IP Address Status Result

Detailed status for job:280001

The job completed succassfully on the devica with id 30001
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Customizing a Target Server for Build Plans

Before you perform SA Provisioning on a target server, you can do some customization for the target
server.

Using Custom Attributes
Custom attributes allow you to control the behavior or outcome of a Build Plan without modifying the SA
provided baseline Build Plans.

To see the list of supported Custom Attributes, in the SA Client Navigation pane, set the View to By Type
and open a Build Plan. In the Views pane, select the Custom Attributes view to see each set of custom
attributes with a blank value. Depending on the customization the attribute targets, you may want to set
it to different resources.

Note that a Custom attribute must have a non-blank value in order for it to be considered present on a
resource.

During a Build Plan execution, custom attributes are searched in order on the following resources:
Server
Device Group
Customer
Realm
Facility
Build Plan

Using Device Groups
Device groups allow you to customize a Build Plan run using Custom Attributes on more than one server.
SA supports two types of device groups:
Dynamic

Device membership in a dynamic device group is defined by a device membership policy from the
beginning and its group membership is recalculated periodically. See the SA Users Guide: Server
Automation, “About Dynamic Device Groups”.

Static
Static device group device membership is based on your specification.

Build Plans also support modifying the membership of a static device group using the Add to
Device Group step. See the SA Users Guide: Server Automation, “About Static Device Groups”.



The following example shows a dynamic device group that only targets servers that have an iLO manager:

—'é Group: My iLOs

Fle Edt ‘View Actions Help

=] E3

Summary

Propetties
@ Compliance
Patches

%’ Patch Policies
----'\'?d’ Software Policies
i) Audits

Histary

-5 05 Build Plan Usage

Search For: | Servers = I

Where!

<

I Managed by Manager Type

;I I Equals

| Fr_io_manacer

[

{ =

MName -

Serlal Number

IP Address (Primary)| Operating Syste...

Manufacturer

Preview | Cancel

Mame

| | |

IHostname | ==}

ILOHOST-192,168.244....

192,168.244.,126

UMKMOWN

IMode\

ILOHOST-192,1,,, =]

=

1 item

Performing SA Provisioning

axis_osbuildplan_test_user | S{z9f14 7:24 AM Americajlos_Angeles
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Phase 3: Running a Build Plan

To provision an operating system on a server or multiple servers using a Build Plan, first log on to the SA
Client specifying the SA Core that manages the servers you will install the operating system on. There are
several ways to start the provisioning process.

Opening the Run Build Plan Wizard from Unprovisioned Servers

1 Inthe SA Client Navigation pane, select Devices > Unprovisioned Servers.

2 Right-click on a listed server and, from the context menu, select Run > 0S Build Plan...

P Server Automation - alice.dev.opsware.com

File Edit View Tools Window Actions Help

[ servers 2|
[

| saved searches ...

i}«l Unprovisioned Servers

Sumary -

Name

1P Address 05 ]
OSPROY-192-168-146-93, 85, 050rov. 53, hp. com-VMware-viware Virt,., 192,168.146,93 Red Hat Enterprise Linux 6.5 ... 34110001 =
OSPRON-192-168-146-00, axis. 0sprov.sa.hp. com-YMware-Wbware Virt... 192.168.146.90 Red Hat Enterprise Linux 6.5 . 34080001 —
OSPROY-192-168-146-89,axis. 0sprov.sa.hp.com-VMware-yiware Virt,., 192.168.146,89 Red Hat Enterprise Linux 6.5 34070001
OSPROY-192-168-146-86, axis. 0sprov, sa.hp. com-YMware-Viware Virt,.,  192.168.146,56 Red Hat Enterprise Linux 6.5 ... 34030001
OSPROY-192-168-146-04, 815, 05prov. 53, hp. com-VMware-viware Virt,., 192.168.146,54 Red Hat Enterprise Linux 6.5 ... 34020001
OSPRON-192-168-146-75. axis. 0sprov.sa.hp. com-YMware-Wibware Virt... 192.168.146.75 Red Hat Enterprise Linux 6.5 . 33900001

Kl

Advanced Szarch

=) I Device Groups

T axis_osbuidplan_test_user OSPROV-192-168-146-74,axis.05prov.5a.hp. com-Yhware-Wiware Vit.., 192.168.146.74 Red Hat Enterprise Linux 6.5 ... 33890001
! Public OSPROV-192-168-146-71 axls. 05prov.58.hp. com-YMware-wiware Virt.., 192.168.146.71 Reed Hat Enterprise Linuz 6.5 33860001
2 servers OSPROV-192-168-146-70,a%i5.05pr0v.53.hp. Com-VMware-wiware Virt..,  192.168.146.70 Red Hat Enterprise Linux 6.5 ... 33870001

) Al Managed Servers
il oracle Solaris Zones

dhep-client-00:50:56:20:07: 76 127.1.2.3 UNEROWN 33860001
dhep-client-00:50:56:25:60: 1C. 127.1.2.3 UNKROWN 33810001
dhep-client-00:50:56:0A:26:12 127.1.2.3 UNKROWN 33800001
OSPROY-192-166-146-61,4%i5.05prov. 58, hp, com-YMware-¥Mware Virt,.,  192,168.146.61 Red Hat Enterprise Linusx 6.5 ... 33790001
dhep-client-00:50:56:2C :A6:FO 127.1.2.3 UNEROWN 33780001
dhep-client-00:50:56:1F:D3:ED 127.1.2.3 UNKROWN 33770001
OEPROV-192-168-146-55, axis. 05prov.5a.hp. com-Yhware-Wiware Vitt..,  192.168.146.55 UBLNTL-12.04-286_64 33750001
dhep-client-00:50:56: 10:E0:52 127.1.2.3 UNERNOWHN 33740001
minint-97atoer-YMware-YMware Wirtual Platform 192.168.146.49 W INPEES 33700001
minint-Snegeus-Viware-Vkware Virtual Platform 192.168.146.45 WINPEG+ 33590001
™ o JPEE4

L) Unpravisined Servers

S Agent Instalation
Storage

SAN Arrays

@ NAS Filers

Open
Open with HP Server Automation (Web)

minint-4iziunu||_Run 03 Build Plan...

Run O Sequence. ..
System ES
Remcve from 54

Renarme F2

Configure static network information

Computer Manage Boot Clients. .. A

AddiLO Device...
MW ARE VIRTUAL FLATFORM
(23 - Intel(R) ®eon(R) CPU ES-2670 0 @ 2.60GHz
€[ Devices

2 GB of RAM
I vituazation

Agent ES
(ff@ Lo Status is In Maintenance
: Last registered at 6/3/14 1:06 AM
Reports
0 applications registered
@ o — 0 patches registered

E} Administration

Litem selected axis_asbuildplan_test_user | 6/3(14 6:39 AM America/Los_Angeles
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Opening the Run Build Plan Wizard from Managed Servers

1
2

In the SA Client Navigation pane, select Devices > All Managed Servers.

Right-click on a listed server and, from the context menu, select Run > 0S

HP Server Autom. ali

Edit Help

ev.opsware.com

File Wiew Tools Window Actions

Build Plan...

=15

@ Logged in as: axis_osbuildplan_test_u

Searcn |

Bl

Il Managed Servers

| Servers [T] Summary

Mame 1P Address 05

Manufacturer

Reparts

(] 3obs and sessions

@ Administration

[avedsearches . | B RIS ST ToZ o T R ETTCETESE T, WA, T ST
) ©OSPROV-192-168-146-72.axs.0sprov.sa.hp.com 192,168.146.72 WMWARE, INC. 22140001 ~
R S B} OSPROV-192-168-146-81,axis.0sprov sa.hp.com 192,168, 146,51 WMWARE, TNC, 14990001
) WINDOWS-BLOMHSR 192,168.79.186 Windaws Server 2008 ... YMWARE, INC, 24730001
_ ) OSPROV-192-168-146-70.axis.0sprov.sa.hp.com 192,168.146.70 Red Hat Enterprise Lin,..  YMWARE, INC, 14860001
= Device Groups ) provisioningsa 192,168.79.70 Red Hat Enterprise Lin,..  YMWARE, INC, 23760001
] s bl st _user ) OSPROV-192-168-146-63 . axis.0sprov.sa.hp.com 192,168.146.63 SUSE Linux Enterprise ... YMWARE, INC, 26080001
Pl ) provisioninga1 192,168.79.102 Red Hat Enterprise Lin,..  YMWARE, INC, 12370001
, ) provisioning3n 192,168.79.41 Cent0S § Xa6_64 WMWARE, INC., 23390001
= servers ) provisioninglaz 192.168,79,193 Red Hat Enterprise Lin... WMWARE, INC. 24300001
£ Al managed servers ) provisioninga 192.168,79.110 Red Hat Enterprise Lin.. WMWARE, INC. 12350001
1 oracle Solaris Zones B ©SPROV-192-165-146-71 . axis.0sprov.sa.ip.com 192, 168,146.,71 Red Hat: Enterprise Lin,.,  WMWARE, INC, 9600001
(3¢} unprovisioned Servers B solaris 192,168.79.104 SUn0S 5.1 %86 WMWARE, INC., 24540001
54 igent Installation ) OSPROV-192-168-146-72.axis.0sprov.sa.hp.com 192,168.146.72 Red Hat Enterprise Lin,.  YMWARE, INC, 28330001
-6 storage [] 2 0 2
B san Arrays i open
LG NAS Filers Open with
Wiew Event History
! .'" Install 4
[',‘ / Uninstsl »
- attach »
System e > A
Remediate. .
A Create »
Export Patch Tnfo to C5V...
Computer ™5,y » Communication Test °
Run Extension » Agent Recert...
( Run Script 4 agent Upgrade. .
4 Reboot Server... Flow...
Deartivate 54 Agent IsM Cantrol...
E@i Devices Agent Refresh Server 05 Build Plan... &
Virtualization f Add to Device Group. . 05 Sequence...
Rename Fz Chef Recipe...
0 wrery !
Configure static network information ..

1 item selected

axis_psbuildplan_test_user | 6/3/14 6:37 AM America/Los_Angel
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Opening the Run Build Plan Wizard from the SA Client Library

1 Inthe SA Client Navigation pane, open the Library panel and select 0S Build Plans.

2 Right-click on a listed Build Plan and select Run.

HP Server Automation - alice.dev.opsware.com

File Edit View Tools Window

Last Modified: 63114 4:48 AM

il Devices

Last Modfied By: detuser

I vitusization

[f@ s

Created: 3/27/14 5:37 &M
Created By: opsware
Chject ID: 150001

Reparts

({]) s and Sessions

E} Adrinistration

[ servers K|
[ Name: - Description Location Last Modfied Object ID =
[[Saved searches .. (= ]| | @ Windows 2003 x64 DeFaut Tnstall Tnstalls the OF using .. [Opsware/Took/05 ...  6/3{14 443 AM 740001 B
P —— Windows 2003 x64 WIM Install Installs the OS5 using .. [Opsware/Tooks/O5 ...  6{3{14 449 AM 350001
Windows 2006 Default nstall Tnstalls the 05 using ... fOpsware/Tools/0S ... 6/3(14 448 AWM 820001
Windows 2008 Guest Customization Prepare Windows 20...  [Opsware/Tools/Buld... 6/3(14 4:48 AM 200001
£ Windows 2008 R2 %64 Default Install Installs the OS5 using .. [Opsware/Tooks/05 ... 6/3{14 448 AM 450001
[y TR | By Folder | 5 Windows 2006 R2 %64 Guest Custarnization Prepars Windows 20...  [Opsware/Tools/Buld... 6/3(14 448 AM 700001
[ nippication Configuration Windows 2006 R2 x54 Hyper-¥ Default Install Installs the ©S using ... fOpsware/Tooks/OS ... 6/3{144:48AM 310001
[ udt and Remediation Windows 2008 RZ x64 WIM Instal Installs the OS using ... fOpsware/Tools/0S ... 6/3{14 448 AM 370001
- 4 Business Applictions 9 Windaws 2008 WIN Install Installs the OS5 using .. [Opsware/Tooks/05 ... 6/3{14 446 AM 670001
£ chef conkbocks 59 Windows 2008 x64 Default Instal Installs the OS5 using .. [Opsware/Tools/O5 ... 6{3j14 448 AM 50001
- Windows 2008 x64 Guest Customization Prepare Windows 20,.,  [Opsware/Tools/Build. 130001
- [4 Databases
Qf Extensions Windews 2012 R2 %64 Default Instal | open Enter Installs the O5 using ... fOpsware/Tools/OS ... 6/3(14 448 AM 830001
-1 05 Build Plans Windows 2012 RZ2 %64 Guest Customization — Prepare Windows 20,..  fOpsware/Tools/Build. .. 6f3f14 4148 AM 190001
(@ 05 Installation Profiles Windows 2012 RZ x64 Hyper-¥ Install Tnstalls the G5 using ... fOpsware/Tools/OS ... 6/3{14 448 M 30001
{3, 05 Sequences Windows 2012 RZ %64 WIM Instal Locate in Folders Installs the OS using ... [Opsware(Tools/05 ... 6[3{14 448 AM 550001
(57 Parksges £ Windows 2012 %64 DeFault Install \ Run... \ Installs the OS5 using .. [Opsware/Tooks/05 ... 6/3{14 448 AM 640001
BY Patch Polcies 59 Windows 2012 =64 Guest Customization — o Frepars Windows 20...  [Opsware/Tools/Buld... 6/3j14 4:43 AM 660001
Y windows 2012 %64 Hyper-V Instal Tnstalls the 05 using ... fOpsware/Tools/0S ... 6/3(14 4148 AWM 780001
Patches ¥ Delete Delete
= Windows 2012 x64 WIM Instal Installs the OS using ... [Opsware/Tools/0S ... 6/3{14 448 AM 110001
&7 Scripts
Y softuare Poliies B Windows 2008 x64 WIM Install ©
UNI Uisers And Groups
o] Windows COM+ General P
?_i Windows 15 Metabase Narme: Windows 2008 x64 WIM Instal
iy anduws 15 setinas Description: Installs the O Using a WIM image
5 windows Local Securlty Settings
@ windows Registry
& Windaws Services
5 windows Users And Groups
Location; JOpsware|Tools/OS Provisioning/05 Build FlansiWindaws

1 item selected

axis_osbuidplan_test_user | 6/3/14 7:43 AM America/Los_Angeles
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Opening the Run Build Plan Wizard from an Open Build Plan

1 Inthe SA Client Navigation pane, open the Library panel and select 0S Build Plans.
2 Open the Build Plan.

3 From the Actions menu select Run...

EE 05 Build Plan Red Hat Enterprise Linux Server 6 X86_64 Install M=

File  Edit  View

Open

Enter
i Plan ltems

g Add Alt+D

ove | i B | BB copy Plan... ok Add Action Ikem
fenove Dokt | [ | 69 Add to Device Group
4] custom At Y rovere B ait For HP SA Agent (OGRS Seript) | |43 apply Configuration File
B thistory ¢ MoveDomn  AltDomn | et Media Source (Python Script) 9y attach Software Policy
8 Copy Plan... Altrc onfigure Red Hat Default ks.cfg Y Attach Patch Policy
Run... Inject Required Kickstart Settings (OGFS Script) L;;’ Install ZIP Package
5 7 Inject Kickstart Personalization Settings (OGFS Seript) £ Run Script
3 ] Create Stub Partition (Unix Seript) |2 remediate Server
7. &) Copy Boot Medis (Unix Script) 4 Upload Configuration File
8 g GRUB Boot Loadsr <86
9. - Deploy Agent {Unix Script)
10, Embed Files initrd (Unix Script)
11, £} Install botioader For RedHat Erterprise Linux Server {Linbe Script)
12, -} Reboot (OGFS Seript)
13. £ Wait for HP SA Agent [OGFS Seript)
14, -} Monitor Installation (OGFS Script) =l
Seript: [fopsware{Toolsfos Provisioning0S Buid Plan Stepsfet Media Source Select

Script Type:  Python

Parameters: ['nfs:{@Mediaserver@imnt share/rhelp_66-54"

| axis_osbuidplan_test_user | 5i16/14 1:47 &M AmericafLos_Angeles

Alternatively, you can select the Action menu, then Run > Build Plan and choose a target server in the Run
Build Plan window or use the search pane to search for a list of Build Plans.

» Note: If the Run Build Plan option is not available in any of the previous examples, the SA Agent on the
targeted devices is not reachable.
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Starting the Build Plan

3‘3‘ un 0% Build Plan

Select Build Plan (Step 1 of 3)

Choose an ©5 Build Plan fraom the software library,

In the Run 0S Build Plan window, confirm the selected Build Plan by pressing Next.

(O]

Filter:

Name
Fed Hat Enterprize Linux Server 5 Instal
Red Hat Enterprise Linux Server 5 H36_§6

Red Hat Enterprise Linux Server 6 Instal

ed Hat Enterpri

Selact Filter

Current Filter: Narme

Description Folder

Installs Red Hat Enterprise Linux Server fOQpsware/Tools/O35 Provisioning/ 0% Build Plan *

Installs Red Hat Enterprise Linux Server /Opsware/Tools/OS Provisioning/O§ Build Plan

Installs Red Hat Enterprise Linux Server  fOpswarefTools/OS Provisioning/OS Build Plan

Installs Red Hat Enterpri

S Build Plan

RedHat Enterprise Linux Server Guest Cu
SAMPLE: Capture HP RAID Caonfiguration
SAMPLE: Deploy HP ProLiant RAID with R
SAMPLE: Deplay HP ProLiant RAID with %

SAMPLE: Deploy HP RAID Configuration

Propetties:

Marne: Red Hat Entarprize Linux Server &
HEE_64 Install

ID: 660001

Description: Installs Red Hat Enterprise
Linux Server & 64 bits

23 Refresh Build Plan List

Press Start.

&8Run 05 Build Plan

Select Servers to Provision (Step 2 of 3)

Prepares Linux virtual server for custorni /Opsware/Tools/Build Plans/Virtualization/Gue:

Captures the HP RAID configuration fron fOpswarefTools/OS Provisioning/OS Build Plan

Deploys RAID configuration to a compati /Opsware/Tools/ &8 Provisioning/ 3 Build Plan

Deploys RAID configuration to a compati /Opsware/Tools/OS Provisioning/ 0§ Build Plan

Deploys a HR RAID Configuration to a s¢ fOpsware/Tools/OS Provisioning/OS Build Plan| - |

Staps:
Name

1 Wiait for HP SA Agent

2 Set Media Source

Configure Red Hat Default ks.cfg
Inject Required Kickstart Settings
Inject Kickstart Personalization Se
Create Stub Partition

Copy Boot Media

GRUB Boot Loader x36

QU

Step Type
Run OGFE Script -
Run Server Script
Apply Configuration File
Run OGFE Script
Run OGFS Script
Run Server Script
Run Server Script

Install Zip

@

Select one or more servers on which to run the selected Build Plan.

JH[=] E3

Choose ane or maore seruers frarm the provisioning paol. You can also add a new iLO device or impart iLO devices, by clicking the buttans
below, To add a server to the posl, it must be network booted using the Server Automation bosot image. Click the next buttan if you want
to add mere options to the Run ©F Build Plan Job or the start butten to directly start the &5 Build Plan,

Selected ©F Build Plan:

3 Refresh Server List

£ Red Hat Enterprise Linux Server 6 X86_64 Install

gk AddiLD Devices [uy ImportilD Devices

Filter:

MName MALC

1P Address os

select Filter

Mo filter selected

Facility Model

]ll provizioningl-VMware-VMware 00:50:56:19:04:00 192 168.191.7& S5.11-Xee

4 Back & Next
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4 The progress of the Build Plan job is displayed.

5  When the Build Plan job completes, the server is up-and-running and under SA management.

Searching for Active/Completed/Failed Run Build Plan Jobs

1 Inthe SA Client Navigation pane, select Jobs and Sessions > Job Logs.

2 Inthe Jobs and Sessions list, Build Plan jobs are listed with the job type of Run 0S Build Plan with a
description that displays the Build Plan name.

|Job (1 |Type |Descripti0n |
68350001 Run OS5 Build Plan Run 'AxIS_OSER_Linuwxe_CentCS_6_Static 6486 For osprowwc001' build plan (id = 48390001 ) against 1 server(s)
63340001 Run OS5 Build Plan Run '&xI5_0SBP_Linux_Oel_5_CD_510x64 for osprowyc001’ build plan (id = 48380001) against 1 server(s)
68330001 Run OS5 Build Plan Run XIS _0SBP_Linu_Oel_S_DHCP_S10x64 for osprowvwc001' build plan {id = 48370001) against 1 server(s)
E 63300001 Run OS5 Buid Plan Run 'AxIS_05BP_Linux_Oel_6_CD_64x64 For asprovwc01' build plan {id = 48350001} against 1 server(s)
1 68790001 Run OS5 Build Plan R AxIS_0SEP_Linu_Oel_6_DHCP_é4x64 For osprowwc001' build plan (id = 48340001 against 1 server(s)
I 63720001 Run OS5 Buid Plan Run '&xIS_OSBP_Linuw_Oel_6_Skatic_64x86 For osprowwec001' build plan (id = 48320001 against 1 server(s)
1 68710001 Run OS5 Build Plan Run AxIS_0SEP_Linw:_Rhel_S5_DHCP_S10x86 for osprovwo001' build plan {id = 48300001) against 1 server(s)
I 63700001 Run OS5 Buid Plan Run 'AxIS_0SBP_Linuwx_Rhel_5_CD_59x64 For osprovec001' build plan {id = 48310001 ) against 1 server(s)
1 63690001 Run OS5 Build Plan Run AxIS_0SEP_Linux_Rhel_5_DHCP_S10x&6_Http for osprosec001' build plan {id = 482900017 against 1 server(s)
I 63670001 Run OS5 Buid Plan Run 'AaxIS_0SBP_Linuwxe_Rhel_5_0OLPers_59x64 For osprovyec001 build plan {id = 48280001 ) against 1 serveris)
1 68660001 Run OS5 Build Plan Run AxIS_0SBP_Linux_Rhel _5_oldStatic_S9x64 for osprowwc001’ build plan (id = 482700017 against 1 server(s)
I 63530001 Run OS5 Buid Plan Run '&xIS_0SBP_Linuwx_Rhel_6_0OLPers_65x64-part-1 For osprowyc001' build plan {id = 48260001) against 1 serve. ..
1 68530001 Run OS5 Build Plan Run XIS _0SEP_Linux_Rhel_6_DHCP_alxe4 Workstation for osprowwc001” build plan {id = 45230001 ) against 1 s...
I 63520001 Run OS5 Buid Plan Run 'A&xIS_0SBP_Linux_Rhel_6_CD_65x86 For osprovec001' build plan {id = 48240001 ) against 1 server(s)

3 The Jobs and Sessions screen displays information about each Build Plan job including

— JoblID

— Job Type

— the name of the Build Plan

— Job Description

— the number of servers the job was run against

Personalize Network Settings

SA supports complete network personalization, both during the provisioning process and for the installed
operating system. Network settings for existing servers can be also changed.

Network personalization is achieved using the hpsa_netconfig Custom Attribute using simple JSON
(http://json.org/) syntax to specify the network configuration to be configured on the target system. For

example:
{
"hostname"
"domain"
"workgroup"
"interfaces"
{

Performing SA Provisioning

"testname",

"testname",

"someWorkgroup",

[

"macAddress": "11:22:33:44:55:66",

"enabled": true,

"dhcpv4": true,

"provisioning": true,

"dnsServers" : [ "192.168.0.30", "192.168.0.31" 1,
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"dnsSearch" : [ "domain.com" 1],

"winsServers" : [ "192.168.0.34" 7],

"staticNetworks": [
"192.168.0.34/24",
"192.168.2.0/255.255.255.0"

1,

"vlanid" : 2,
"ipvdgateway": "192.168.0.1",
}
1,
"virtualInterfaces" : [
{
"interfaceName" : "br0",
}

Mandatory and Optional Fields

If you do not specify the hpsa_netconfig Custom Attribute, SA automatically determines the interface
used by the SA Agent to communicate with the SA Core when the personalization runs. This interface, also
known as the Provisioning Interface, is set by default for automatic configuration through DHCP.

If the hpsa_netconfig Custom Attribute is present and contains interfaces, the macAddress field
defaults to the MAC address of the provisioning interface if not present.

Because there is a single provisioning interface, there can only be one interface definition in
hpsa_netconfigthat doesn't have a MAC address.

MAC Addresses are needed to uniquely identify the network interfaces of the server. All other fields are
optional and have default values.

The hpsa_netconfigformat does not make any assumptions about how the networks to which the
server is joined are configured. For this reason, only minimal validation is performed.

SA does not verify that the network settings lead to valid connectivity between the SA Agent and the SA
Core. You should verify that the specified network settings will allow the SA Agent to connect to the SA
Core after they are applied. Other obvious error cases, like disabling the provisioning interface, are
validated.

Description of individual fields

enabled

The value reflects the state in which the interface will be after the network is configured. If the value is
false, the interface will still be configured as intended but it will be deactivated.

hostname, domain

The host name (also known as computer name) is the name used to identify the node on the network. The
domain name is the DNS registered domain of the server. Together they account for the fully qualified
domain name (FQDN) of the server.

interfaces
A list of the physical network interfaces of the system that are to be configured.
Eachinterface (as identified by the MAC address) can have a single entry in the list.

macAddress
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The Media Access Control (MAC) address of the network interface.

Multiple formats are accepted, colon or dash separated, or just a string of hexadecimal numbers.
dhcpvi

Control the use of the DHCP for acquiring network addresses.

provisioning

This field is used to explicitly specify the interface to be used for provisioning. Only one provisioning
interface is supported.

Use of this field is not recommended outside of complex scenarios. In most cases, SA will be able to (and
will) configure this automatically.

dnsServers, dnsSearch, winsServer

Controls the name resolution settings. The order in which the values are specified will be the order of
configuration.

The first dns nameserver, dns domain or winserver in the list will be the primary selection.
staticNetworks

A list of static networks to configure on the interface. IPv4 addresses can use the CIDR notation, or IP
address / network mask notation.

The first address in the list will be the first one to be applied.
ipvdgateway

The IP version 4 default gateway (next hop) address.
vlanid

The VLAN ID used to tag packets for this interface.
virtualInterfaces

This section configures the non physical interfaces. These are not identified by their MAC address but by
their interfaceName. The virtual interfaces are configured similar to the physical ones (using fields as
dhcpv4, staticNetworks, etc.)

interfaceName

Identifier for the configured virtual interface. This field is not necessary for the physical interfaces which
are identified by their MAC address.

Where is hpsa_netconfig Used?

You can personalize the network settings at different stages of the provisioning process. The network can
be personalized across all these stages, or selectively. For example it can start out with DHCP based
provisioning and switch to static networking after the system is provisioned.

Service 0S with Personalized Network Settings

Servers can be brought into Maintenance mode using the static provisioning CDs, that provide a boot Ul
used to configure these network settings. In this case, the boot Ul will configure hpsa_netconfigto be
used throughout the provisioning process. The network settings you specify in this Ul will be applied to
the final installed 0S as well.

For HP ProLiant Gen8 servers, you can also use the embedded service 0S for PXE-less and DHCP-less
provisioning, by registering the server with its iLO address in and setting the hpsa_netconfig custom
attribute. In this case, the MAC address is mandatory, since the SA Agent has not reported hardware
information to the SA Core yet so the MAC address can not be determined automatically.
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The ability to configure the service 0S statically allows you to provision without DHCP and network boot
infrastructure (PXE and TFTP server).

During the Provisioning Process

Using the information from the hpsa_netconfig custom attribute, SA automatically injects the required
settings in the OS installation profile for the provisioning interface to run the vendor 0S installer with the
specific network settings. This will be the only interface and only one IPv4 address will be configured on it.

This configuration is only meant to allow SA to install in an environment that doesn't use DHCP.
The network configuration is completed after the 0S is installed.
Network Personalization of an Installed System

The complete configuration of all network interfaces and all addresses can be accomplished using
Personalize Network Settings of Installed Systemscriptasa Run Scriptstep.

This step is already specified in most baseline Build Plans. It can be added to any Build Plan, or you can
create a Build Plan only for network configuration.

Because this step can lead to loss of connection to the SA Agent, it must always be followed by a Wait
for HP SA Agent step.

Running the personalization step configures the targeted device in a series of steps: updating the
computer name (hostname), the domain and DNS information and the specified network settings. After
updating the network settings for a persistent configuration a network stack reset is executed. Then the
SA Agent will be forced to report the new hardware changes. All changes are platform specific, the
Personalize Network Settings of Installed Systemstep being able to detect the targeted
platform.

Applying the new configuration must handle different possible scenarios. Updating the DNS and domain
information means reorganizing the previous configuration so that the new configuration will act as the
primary (for example, setting the new DNS IP as the first nameserver). Updating the network settings
requires clearing up the old configuration (only the fields that are handled by the hpsa_netconfig)
before committing to the new configuration, clearing and creating aliases if needed (one of the cases
would be if multiple static networks are specified) and enabling or disabling the dual stack network
interface.

Note: In all scenarios, the old configuration is preserved if you do not intentionally modify it.
Example 1
A device has three configured interfaces (eth0, ethl with ethi:1 alias, eth2).

If hpsa_netconfigis set to configure eth0 to static with an alias and eth1 configured to DHCP, the
personalization step applies the personalization to eth0 creating the alias and to ethil deleting the
existing alias (the result being: eth0 with eth0:1 alias, eth1, eth2). Other interfaces remains
unchanged (in this case eth?2).

Red Hat Enterprise Linux, CentOS, Oracle Enterprise Linux Platforms

* Updated configuration files for the new computer name: /etc/hosts, /etc/sysconfig/network
— the hostname command is also executed for the runtime configuration

*  Updated configuration files for the domain and DNS information: /etc/resolv.conf

*  Updated configuration files for the network specific configuration: /etc/sysconfig/network, /
etc/sysconfig/network-scripts/ifcfg-ethxXxX

¢ Restarting network: /etc/init.d/network restart

— this step could lead to loss of connection to the SA Agent
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Ubuntu Platform

Network configuration does not support mapping in /etc/network/interfaces because
hpsa_netconfigdoes not support multiple naming. Example of unsupported configuration:

mapping etho
script /usr/local/sbin/map-scheme
map HOME ethO-home
map WORK ethO-work

iface ethO-home inet static
address 192.168.1.1
netmask 255.255.255.0
up flush-mail
iface ethO-work inet dhcp
»  Updated configuration files for the new computer name: /etc/hosts, /etc/hostname
— the hostname command is also executed for runtime configuration

*  Updated configuration files for the domain and DNS information: /etc/resolv.conf,
/etc/resolvconf/resolv.conf.d/original

*  Updated configuration files for the network specific configuration: /etc/network/interfaces
* Restarting network: /etc/init.d/networking restart
— Step could lead to loss of connection to the SA Agent
SUSE Platform
Updated configuration files for the new computer name: /etc/hosts, /etc/HOSTNAME
— The hostname command is also executed for the runtime configuration

* Updated configuration files for the domain and DNS information: /etc/resolv.conf,
/etc/sysconfig/network/config

* Updated configuration files for the network specific configuration: /etc/sysconfig/routes, /
etc/sysconfig/network-scripts/ifcfg-ethXX, /etc/sysctl.conf

* Restarting network: /etc/init.d/networking restart
— Step could lead to loss of connection to the SA Agent
VMware ESXi Platform

Network configuration is not supported for this platform because, after installation, the ESXi 0S is
agentless. Static network configuration is applied during installation by injecting it into the kickstart file.

Windows Platforms

The same configuration process can be used to apply persistent settings or to configure the device when
running the installer. Applying personalization implies executing a series of Windows specific commands
that configure the system with the specified information. This also means that the configuration is visible
immediately without the necessity to apply it after reboot.

The device must rebooted so that the changes to the hostname are visible to the 0S.
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Extending Windows Hardware Support

SA Windows Service 0S images are bundled with drivers for most common devices. However, there will be
cases when new hardware requires new drivers. The procedure below describes how to add new drivers to
existing Windows Service 0S images.

Decide which Windows Service 0S you will upgrade. For example:
*  WinPE2.1 32bit (built from Windows Server 2008/Windows Vista)
* WinPE3.1 64bit (built from Windows 7 SP1/Windows Server 2008 R2)
* WinPE4.0 64bit (built from Windows 8/Windows Server 2012)
The SA Core and SA Satellite images are located in:
/opt/opsware/boot/tftpboot/winpe/sources/
— opswarex86-ogfs-enabled.wim: WinPE2.1 with OGFS SA Agent
— opswarex64-ogfs-enabled.wim: WinPE3.1 with OGFS SA Agent
. opswwinpe4 .wim: WinPE4.0 with OGFS SA Agent

*  Make a backup of the image and copy it to a Windows machine where you have installed the latest
WADK (http://technet.microsoft.com/en-us/library/hh824947.aspx).

*  Obtain the required drivers. For example, if you want to update a WinPE3.1 based image, look for
drivers for Windows 7 or Windows Sever 2008 R2.

*  Use the procedure described on the Microsoft page Add Device Drivers on an Offline Windows PE
Image
(http://technet.microsoft.com/en-us/library/dd799289\(v=ws.10\).aspx).

*  Replace original image with the modified image.

Joining a Windows Domain or Workgroup

Windows Build Plans also provide the ability to join a provisioned machine into a Windows Domain or
Workgroup. To do this, use the step called: Inject Windows Domain or Workgroup
Personalization Settings.

To use this step and join the machine to a Windows Domain, you must use the following custom attributes:
°  DomainName: the name of the domain that you want the server to join.

°  DomainUser: the user name which has the permissions to add the server to a domain.

*  DomainPassword: the password of DomainUser.

To join the machine to a Workgroup, you must use only one custom attribute:

*  WorkGroup: the workgroup name.

To use this step in new Build Plans, do the following:

*  Ensure that this step is added after Configure Windows Default Unattend.xml, Inject
Required Unattend.xml Settingsand Inject Personalization Settings.

*  Ensure that this step is added before the Run Windows Setup step.

+  Use Custom Attributes, if necessary, as described in Defining Custom Attributes on page 136.

Chapter 2



Provisioning an Already Provisioned Server

Build plans support re-purposing (reprovisioning) a server. You can do this either fully automatically or
manually.

> Note: Reprovisioning can cause data loss on the server and decommissions the server in SA. For more
information on the effects of decommissioning, see the SA Users Guide: Server Automation,
“Deactivating a Server”.

Automatic Reprovisioning

To reprovision a server automatically, you use a Build Plan such as SAMPLE: Prepare server for
reprovisioning to Linux to prepare the server. You run this Build Plan on the managed server. It
decommissions the server and brings the server into Maintenance mode. After the Build Plan job
completes, you can use any baseline SA Build Plan to provision to a new 0S.

For example, to reprovision the server with Windows, use a Build Plan based on SAMPLE: Prepare
server for reprovisioning to Linux, editing the parameters of the boot step to prepare the
server before starting the Windows provisioning Build Plan.

If you expect to be executing reprovisioning jobs often, you may want to create a Build Plan that specifies
both the reprovisioning steps and the steps that provision to a new 0S.

Manual Re-provisioning

SA also supports manual preparation of servers for reprovisioning (for example, to boot using the CD
image in a DHCP-less environment). Before you can do this, you must manually decommission (deactivate)
the server from SA before booting it into Maintenance mode, see the SA Installation Guide, “Uninstalling
an SA Core”.

Failure to decommission the server will lead to the server failing to boot into Maintenance mode (due to a
registration error with the SA Core).

> Under certain platforms, a server can boot into Maintenance mode without being decommissioned,
however, this capability was designed for maintenance tasks only, not reprovisioning, therefore a failure
to decommission the server will lead to an inconsistent representation of the server in SA. For example,
old software policies might still be attached.

The Decommission Server procedure cannot be used in this setup, because it disables SA Agent, so the
stepisn't able to continue, and will fail in the subsequent wait for HP SA Agent step, or any step that
needs SA Agent to be active.

Device Naming

Device Naming allows you to customize the name of a server when the server is not yet registered with the
SA Core or when you first boot a server into a Maintenance mode OS.

You can also modify the server's name from the SA Client which will take precedence over the Device
Naming function. You can do this by specifying a set of rules to match certain device properties. This
allows you to have different names based on the device information registered by the SA Agent.
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The rules must be added to the device_discovery naming_rules custom attribute associated with
the Server’s assigned Facility.

The rules are in the form of pairs of regular expressions and templates like:

REGEX1: : =TEMPLATE1
REGEX1 : : =TEMPLATE2

Where each REGEX tries to match a string constructed from the SA Agent reported information.

When a match is found, the TEMPLATE is applied to construct the server's name.

The TEMPLATE follows Python 2.7 format string conventions, where given a dictionary in the form of
{key: [ {'inner key': 'valuel',6 value2], ...}

you are able to reference the values as follows:

valuel = {key[0] [inner key]}
value2 = {key[1l]}

The dictionary used for the TEMPLATE is constructed by the SA Agent during hardware registration. The
following fields are relevant:

* chassis_id- chassis ID
* dvc_id- server SA object ID, machine ID
*  dvc_mfg - server's manufacturer

*  dvc_model - server's model interfaces\[0\]\[hw_addr\] - the MAC address of the first reported
network interface

* os_version - SA Agent reported OS version

* serial_num- serial number

* server_location - server's location (only available for HP ProLiant blades)
° system_name - hostname

° uuid-UUID

The following is a simple example:

.*server_location.*::={system name}-{server_location|[rack]}-{server location|[
enclosure] }-{server_location[bay]}

This specification matches any server that reported a location and sets the name to the hostname
followed by rack, enclosure and bay.

The following is a slightly more advanced example:

. *ProLiant
BL.*::={server location[rack]}-{server location[enclosure] }-{server location|[
bay]}

.*ProLiant*::={serial_num}

. *VMware. *: :={system name}-{interfaces[0] [hw_addr]}

The first line of this example matches only ProLiant BL servers and assigns a name. The second line is
needed only when the first line finds no matches and finds HP ProLiants other than the BL model. The
third line explicitly matches only VMware hardware and assigns the hostname followed by the hardware
address of the first network interface.
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3 SA Provisioning Common Use Cases

> Before attempting the following use cases, you must have configured DHCP on the SA Core. See the SA
Installation Guide, “Post installation Tasks”.

Now that you are familiar with the three phases required for SA Provisioning, you are ready to start
provisioning. The following are some examples that will help you get started.

Provisioning Windows-based Servers

Provisioning Windows Server 2008 R2
Network boot a server as described in Network Booting on page 21.

On the network boot menu, select HPSA 0S Build Plan Service 0OS Menu.

HPSA 03 Build Plan Serwice 035 Menu >

HPSA 05 Sequence Build Agent Menu >
Boot from local disk

Autoboot: Linux B4-bit Service 05

Hardware Information




Select Windows 64-bit Service OS.

Linux 64-bit Service 0S

Linux 32-bit Service 0S8

Hindows 64-hi

Hindows G64-bit Service 03 - HinPE4.8
HWindows 32-bit Serwvice 035

Solaris 11 xB6 Serwvice 03

<—— Returwn to HMain HMenu

Hindows 64-bit Service 0S (Winpeb4-ogfs)

Wait for the server to enter Maintenance mode.

Tail for Win32 - [Non-Workspace Files - X:\windows\TEMP\_tail

File Edit View Settings Window Help

P @
Autoconfiguration Enabled . . . . : Yes
IPvE Address. . . .. ... ... : fc00:810:1:0:bc2e:268d:9956:cfOf(Preferrad)
Temporary IPv6 Address. . . . . . @ fc00:810:1:0:15b3:/b58:35c3:3642(Preferred:!
Link-local IPve Address . . . . . : feB0:bc2e:268d:5556:cfUf % 2(Preferred)
IPvd Address. . . ... .....: 192.168.191.78(Preferred)
Subnet Mask . . . .. ... ... 255255255192
Lease Obtained. . . . ... ... : Friday, May 16, 2014 2:16:31 &M
Lease Expires . . . . ... ... : Friday, May 16, 2014 5:16:31 AM
Default Gateway . ... ... .. : feB0:224:58ffe32:cd00%2
1592.168.151.65
DHCP Server . . ... ... . .. : 192.168.191.66
DHCPvE TAID .. . L. 33574598
DHCPvE Client DUID. . .. .. .. : 00-01-00-01-1B-07-3D-E{-00-30-36-82-65-A1
DNS Servers . . ... ... ... : 192168162139
MetBIOS over Tcpip. . . . .. . . : Enabled
Starting up the HPSA QGFS agent.
Flease remove the boot CD you may have used up to this point before procead to QS Provision
Server is now ready for provisioning.
1| | 3
Last updated: 02:17:24

Note the server's IP address; this will help you identify the machine later on.

Start the SA Client and in the Navigation pane, select Library, set the view to By Type and select 0S
Build Plans...



7  From the displayed list of available Build Plans, select and open the Build Plan, Windows 2008 R2
x64 Default Install.

HP Server Automal

Servers

e Edit View Tools ‘Window Actions Help

Properties

Hame -

Description

Location

Last Modified

[
[ Saved Searches ... k3|

Advanced Search

By Type | By Folder |

IiG# Application Corfiguration =
[ Audit and Remediation
483 Business Applications
L5 chef Cockbooks
- [4l Databases
(&5 Extensions
05 Build Plans

g Packages

B Patch Policies

Patches

Scripts

@ software Policies

UNIX Users And Groups

5] Windows COM+

& Windows 115 Metabase

5 windows 115 Settings

3 windows Local Security Setting
B windows Registry =

Windows Services =
1 »

windows 2003 WIM Instal
Windows 2003 x4 Default Install
windows 2003 x64 WIM Instal
Windows 2005 Default Install
windows 2008 Guest Custamization

windows 2008 R2 64 Guest Customization

windows 2008 R2 %64 WIM Instal
Windows 2005 WINM Instal

windows 2008 x64 Default Instal
Windows 2005 x64 Guest Cuskomization
windows 2008 x64 WIM Instal
Windows 2012 RZ x64 Default Install

WWindmiie P17 0% wAd Guack Cuickaminskinn

Windows 2008 R2 x64 Hyper-V Default Install

Installs the 05 using a WIM image
Installs the O3 using a generic default config.
Installs the OS using a WIM image
Installs the O3 using a generic default config.

Prepars Windows 2008 virtual server for cust

Prepars Windows 2008 R2 %64 virtual server ..,

Installs the O3 using a generic default config.
Installs the OS using a WIM image
Installs the O3 using a WIM image

Instals the O using a generic defaul config...
Prepare Windows 2008 virtual server For cust. ..

Installs the OS using a WIM image
Installs the O3 using a generic default config.

Oransrs Windmue 7117 07 vhd vk sl cavsar

JopswareiTools|OS Provisioning/Os Buld Pla. .
JOpswarefTaolsi0S Provisioning/OS Buld Pla. ..
JopswareiTools|OS Provisioning/Os Buld Pla. ..
JOpswarefTaolsi0S Provisioning/OS Buld Pla. ..

. JOpsware{ToolsjBuld Plansvirtuslization/Gus

JOpsware{ToolsiBuid Plans/virtuslization/Gus..

JOpswarefTaolsi0S Provisioning/OS Buld Pla. ..
JopswareiTools|OS Provisioning/Os Buld Pla. ..
JOpswarefTaolsi0S Provisioning/OS Buld Pla. ..
JopswareiTools|OS Provisioning/Os Buld Pla. ..
JOpswarejTaolsiBuld Plans/¥irtualization/Gue. .
JopswareiTools|OS Provisioning/Os Buld Pla. ..
JOpswarefTaolsi0S Provisioning/OS Buld Pla. ..

IO imarai TrnledF il Dlame ik alinskinm s

5/16114 1105 AM
S/16i14 1:06 AW
5/16114 1:06 AM
S/16i14 1:06 AW
5/16114 1105 AM

5116114 1106 AM
S/16i14 1:06 AW
5/16114 1:06 AM
S/16i14 1:06 AW
5/16114 1:05 AM
S/16i14 1:05 AM
5/16114 1:05 AM
S/16i14 1:06 AW
hiaita 1ins om

[ I

[ Davices

@ Yirtualization

‘ (@ sy

Reports

(§]] 10bs ang sesstons

{a} Adrinistration

P

dows 2008 R2 x64 Default Install L

Last Modified:  5/16/14 1105 AM
Last Modified By: detuser

Created: 515114 10:35 A
Created By: opsware
Object ID: 670001

General
Mame: windows 2006 R2 %64 Default Instal
Description: Installs the OF using a generic default configuration From Microsoft
Lacation: iOpsware(ToolsfOS Provisioring/0s Build Plans Windows

8 Inthe Build Plan Edit window, from the Views panel tree, select Build Plan Items. A list of Build Plan
steps is displayed.

9  From the listed steps, select Set Media Source. The Run Script panel displays the Parameter setting
for this step. Note the default protocol, sMB, and the media path

/osmedia.

10 Select the Run Windows 2008 R2 x64 Setup Build Plan step

SA Provisioning Common Use Cases
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11 Inthe Parameters field, note the path under which “setup.exe’ is expected to be found,
z:\windows\2008x64\r2\setup.exe.

EE 05 Build Plan Windows 2008 R2 x64 Default Install

File Edi view Actions

=l B3

Propetties

Custom Attributes
LB Histary

[ | = Remove | it B | BB Copy Flan...

ok Add Action Ttem

| Name

1 - Fj Wait For HP SA Agent (OGFS Script)

2 = E‘} Walidate Job Settings (OGFS Script)

3, Q Canfigure Windows 2008 R2 x64 Default Unattend. <l
4 m 3 Inject Required Unattend.xml Settings (OGFS Script)

5 - E}’ Inject Personalization Settings (OGFS Scripk)

B, Z“} Set Media Source (Pythaon Script)

7 @ 3 Run Windows 2008 R2 %64 Setup (Windows .BAT Script)
&, = E‘} Integrate HP 54 Agent (DGEFS Script)

9 7 Reboot (OGFS Stript)

10, - 3 Wait for HP SA Agent (OGFS Script)

11, i E}’ Personalize Metwork Settings of Installed System {Python Scripk)
12, Z“} Wait For HP SA Agent (OGFS Scripk)

“éj Add to Device Group

_grj Apply Configuration File
\?j’ attach Software Policy
Ej’ attach Patch Policy

L:_d Install ZIP Package

E‘j Run Script

g}’ Remediate Server

_grj Upload Configuration File

& Run Script LY

Script: IjOpswara)’TnnlsJ‘OS Provisioning/0S Build Plan Steps/windowsiRun Windows 2008 R2 x64 Setup

Script Type:  Windows \BAT

Select |

IParametsrs: I"z:\winduws\2008x64\r2\setup.exe"

12 Prepare a media server and a SMB share with the Windows Server 2008 R2 ISO unpacked under:

/osmedia/windows/2008x64/r2/

a concatenation of the Set Media Source and Run Windows 2008 R2 x64 Setup parameters.
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13

14

15
16

In the Edit Build Plan Views pane, select Custom Attributes.

B DS Build Plan Windows 2008 R2 %64 Default Install [_ O[]
File Edit View Actions Help

Q Custom Attributes

7 Build Plan Items

MName -

Attributes

D Hiskaory

AdminPassword
Computerflame
Domainbame
DomainPassword
Daomainl lser
DriversPath
hpsa_netconfig
Language

Locale

MediaServer
Productkey

require_netconfig
SystemDiskMumber
SystemDrive
WindowsImageName
WindowsPartitionID

b b | B\ 1D iy & ) b )

Complete the MediaServer and ProductKey custom attributes as follows:
— MediaServer is the hostname or IP address of the media server.
— ProductKey must be a valid Microsoft Windows Server 2008 R2 product key.

Optional: If you want to add an additional driver search path, specify the DriversPath custom
attribute field as well.

Save the Build Plan by pressing Ctrl+S or File > Save.

From the Actions menu select Run...

B 05 Build Plan Windows 2008 R2 %64 Default Install [_[O]
File  Edit View Help
[ open Enter
) Properties - Aen ove | @ B | BB Copy Flan... b Add Action Item
Remave Delete
r id Plan Ity e wn | Name | '@ Add to Device Group
t Q Custom Att E M::: Dswn AIHD:wn ait For HP 54 Agert (OGFS Script) £ Apply Canfiguration File
T History — lalidate Job Settings (OGRS Script) (9 attarh Softwars Policy
Copy Plan... Ali+C anfigure Windows 2008 R2 x64 Default Unattend.xml ?3' Atkach Patch Policy
Run. . nizct Required Unattend.xml Settings (QGFS Script) ¢ Instal ZIP Package
S. =[] Inject Personalization Settings (OGFS Script) £ Run Seript
6 (] SetMedia Source (Pythan Scrpt) 2 Remediate Server
7. & RunWindows 2008 R2 x64 Setup (Windows [BAT Script) £ Upload Canfiquration Fie
8. -] Intedrate HP 5A Agent (OGFS Script)

9. -7 Reboot (OGFS Script)

10, - £ wait for HP SA Agent (OGFS Stript)

11, {7 Personalize Network Settings of Installed System (Python Script)
12, - £ wait for HP SA Agent (OGFS Stript)

- :
& Run Script L
Script; I/'ODSWar’E/TDO\S/OS 05 Build Plan ject P Settings Select

Seript Type: OGRS

: Freaurenetaon .

SA Provisioning Common Use Cases
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17 The Run 0S Build Plan window is displayed. Confirm the Build Plan selected by pressing Next.

18

19
20

& Run 05 Build Plan

M= E3
selact Build Plan (Step 1 of 3)
Choose an OF Build Plan from the software library,
Select Filter

Filtar:

2 %64 Dafault Install

£ Windows 2008 R2 x64 WIM Install
£J windows 2008 WIM Install

) windows 2008 x64 Default Install

£J windows 2008 %64 Guest Custornization

£J windows 2008 <64 WIM Install

£J windows 2012 R2 x64 Default Install

Properties:

Wame: Windows 2008 RZ x64 Default Install

ID: 670001

Description: Installs the OS using a generic

default canfiguration from Microsoft

%5 Refresh Build Plan List

windows 2008 R2 %64 Guest Custormnizal

£J windows 2008 R2 x64 Hyperv Default I

Installs the

Description

Prepare Windows 2008 R2 x64 virtual se

Installs the ©F using  generic default <

Installs the @5 using a WIM image

Installs the ©F using a WIM image

Installs the ©S using a generic default ¢

Frepare Windows 2008 virtual server far

Installs the ©F using a WIM image

Installs the O using  generic default <

Steps:

[ R S R N A VT

DY eE

Name
wiait for HP SA Agant

validate Job Settings

Current Filker: Hame

Folder

g & generic default <[ /0

fOpsware/Tools/Build Plans/Virtualization/ Gue:
fOpsware/Tools/OS Provisioning/OF Build Plan
#Opsware/Tools/ 08 Provisioning/ 0% Build Plan
fOpsware/Taols/ OS5 Provisioning/OS Build Plan
fOpsware/Tools/OS Provisioning/OS Build Plan
fOpsware/Tools/Build Plans/virtuslization/ Gue:
fOpswarefTools/OS Provisioning/0S Build Plan |2

{GpswarefTaals/ 05 Provisioning/ 0% Euild Plan |

Step Type
Run OGFS Seript =

Run OGFS Script

Configure Windows 2008 RZ x84 [ Apply Configuration File

Inject Required Unattend.xml Setl Run OGFS Script

Inject Personalization Settings

Set Madia Source

Run OGFS Script

Run Server Script

Run Windows 2008 R2 x64 Setup  Run Servar Script

Integrate HP $A4 Agent

Run OGFS Script I~

e E >

The next screen displays a list of available servers. Select the server on which to run the Build Plan
(for this example, the previously network booted machine).

Press Start. The progress of the Run Build Plan job is displayed.

When the Run Build Plan job is complete, the server should be up-and-running and managed by SA.

Provisioning Linux-based Servers

Provisioning Red Hat Enterprise Linux 6 x86_64

1
2

Network boot a server, as described in Network Booting on page 21

In the network boot menu, allow the *Autoboot:" option to boot (the default out-of-the-box is Linux

64-bit Service OS.

Alternatively, select HPSA 0S Build Plan Service 0OS Menu, then choose Linux 64-bit

Service OS.
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Wait for the server to enter Maintenance mode.

ting hardware

waiting for hardware to initiali

waiting for hardware to initialize...

Running anaconda 13.21.195, the Red Hat Enterprise Linux system install

P3Aa Server ID
£ Link
inet

Link
inet

48081
encap:Ethernet HWaddr BB:58:56:82:64:F9
addr:192.168.191.75 Bcast:192.168.191.127 Mask:255.255

encap:Local Loopback
addr:127.8.8.1 Mask:255.8.8.8

[Starting up the HPSA OGFS agent...
[Server is now in MAINTENANCE mode.

Note the server's IP address and the HPSA Server ID; these will help you identify the server later on.

Start the SA Client and in the Navigation pane, select Library and set the view to By Type and select
the 0S Build Plans folder.

From the displayed list of available Build Plans, select and open the Build Plan, Red Hat
Enterprise Linux Server 6 X86_64 Install.

B2 05 Build Plan Red Hat Enterprise Linux Server 6 X86_64 Install [_ O]

File Edit “iew Actions Help

- General A
Ewild Plan Items -
Custom Attributes Mame: IRed Hat Enterprise Linus: Server 6 x86_64 Instal
B History Description:

Location: [OpswareToolsfO5 Provisioning/ O3 Build Plans)Linu:x Select
Lask Modified: 5/16/14 1:05 AM

Last Modified By: detuser

Created: 5/5i14 10:35 AM

Created By: OpsWare

Object 1Dt 660001

Installs Red Hat Enterprise Linux Server & &< bits




54

8

In the Build Plan Edit window, from the Views panel tree, select Build Plan Items. A list of Build Plan
steps is displayed.

From the listed steps, select Set Media Source. The Run Script panel displays the Parameter setting
for this step. Note the protocol, NFS, and the media path /mnt/share/rhel_X86-64.

ﬁ DS Build Plan Red Hat Enterprise Linux Server 6 X86_64 Install _[O]
File Edit VWiew Actions Help

Properties @ | Remave | @ @ | Copy Plan... db add Action Ttem
/3% Build Plan Ttems | Name | [ 2 o pevice Growe
@ Custom Attributes L.+ Wal For HP 54 Agent (OGFS Script) (4] |&) ey Configuration File
B wstory 2 a Set Media Source (Pythan Script) %v Attach Software Palicy

3 _B Configure Red Hat Default ks.cfg E’f Attach Patch Palicy

4. £} Inject Required Kickstart Settings [OGFS Script) (! Instal ZIP Packags

5, - Ej" Inject Kickstart Personalization Settings (OGS Script) 8 Run Script

3 E? Create Stub Partition (Unix Script) “137' Remediate Server

7 @ Copy Boot Media (Unix Seript) @':j Upload Configuration File

8 (5 GRUB Boot Loader x86

9, i a Deploy Agent (Unix Script)

1, E? Embed files initrd (Unix Script) 1=

1, Ej" Install baotloader for RedHat Enterprise Linux Server (Unix Script)

12, 7} Rebook (OGRS Script)

13, @ Weait For HP 54 Agent (OGFS Script)

14. a Monitor Installation (OGFS Script) ;I

Seripk: |)’OpswareJ‘Too\s;’OS Provisioning/©5 Build Plan Steps/Set Media Source Select |

Scripk Type:  Python

Parameters: I"nf;:H@Med|aServer@,l’mntfsharefrhelﬁ_xﬁﬁ-ﬁ4"

Prepare an NFS share with the Red Hat Enterprise Linux 6 x86_64 DVD extracted under
/mnt/share/rhel_X86-64.
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9  Inthe Edit Build Plan Views pane, select Custom Attributes.

£l 05 Build Plan Red Hat Enterprise Linux Server 6 ¥86_64 Install H= ER
File Edit Wiew Actions Help

Properties —
.
L'_j Build Plan Tkems Name »
'Q Custom Attributes @ but_disk ﬂ
U History ’@ hpsa_netconfig
] kernel_arguments
'€§] Mediaserver _l_u
@ require_netconfig
’@ rook_password
|

10 Complete the MediaServer custom attribute field with the hostname or IP address of the machine
serving the NFS share you prepared previously.

11 Save the Build Plan by pressing Ctrl+S or use File > Save.
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12 From the Actions menu select Run...

=]

&

Add Action Item

| @ Add to Device Group

- Q Apply Configuration File
\?_}' Attach Software Palicy
@Y Attach Patch Policy

L:ﬁ Install ZIP Package

fj Run Scripk

¥ Remediate Server

;& 05 B Plan Red Hat Enterprise Linux Server b X86_64 Install
File Edit View | Actions | Help
Open Enter
1 Plan ltems
Add Al+D
ove | It B |
Remnove Delete
[l L Alb+L fame
£ Custom At ovEle sl
& custom ait For HP 54 Agent (OGFS Script)
) History Move Down Alt+Down
wet Media Source (Python Script)
Copy Plan... Al+C onfigure Red Hat Default ks.cfg
Run... Inject Required kKickstart Settings (OGFS Scripk)
5. ‘ﬁ' Inject Kickstart Personalization Settings (0GFS Script)
m i‘{ Create Stub Partition (Unix Script)
FA E}' Copy Boot Media {Unix Script)

8. 5y GRuB Boot Loader x5

9. i‘,‘ Deploy Agent (Unix Script)
10, E‘;{ Embed Files initrd {Unix Script)
11. E“ﬁ' Install bootloader for RedHat Enterprise Linux Server {Unix Script)
12. -} Reboot (OGFS Script)

13, E}' ‘Wait For HP 54 Agent {OGF3 Script)
14, E‘:{ Monitar Installation (OGFS Scripk)

B

Q Upload Configuration File

Scripk:

Script Type:

& Run Script L

Python

Ip’ODswarefTDD\s,iOS ProvisioningfCS Build Plan StepsfSet Media Source

Select

Parameters: I"nfs:J'ﬂ'@Medla5erver@p’mntjsharefrhel67X86-64”

Select Build Plan (Step 1 of 3)

Chooze an ©5 Build Plan from the software library,

| ‘ axis_osbuildplan_test_user | 5/16/14 1:47 AM America/Los_Angeles

13 The Run 0S Build Plan window is displayed. Confirm the Build Plan selected by pressing Next.

O[]

Filter:

Name
Red Hat Enterprize Linux Server 5 Instal
Red Hat Enterprize Linux Server § K8E_&

Red Hat Enterprise Linux Server 6 Instal

d Hat Enterp

RedHat Enterprise Linux Server Guest Cu
SAMPLE: Capture HP RAID Configuration
SAMPLE: Deplay HP ProLisnt RAID with R
SAMPLE: Deplay HP ProLiant RAID with %

SAMPLE: Deploy HP RAID Configuration

Propetties:

Marne: Red Hat Entarprize Linux Server &
HEE_64 Install

ID: 660001

Description: Installs Red Hat Enterprise
Linux Server & 64 bits

%3 Refresh Build Plan List

Description

Installs Red Hat Enterprize Linux Server
Installs Red Hat Enterprise Linux Server
Installs Red Hat Enterprise Linux Server

d Hat Enterprize Lin

Prepares Linux virtual server for customni
Captures the HP RAID configuration from
Deploys RAID configuration to & cormpati
Deploys RAID configuration to a campati

Deploys 5 HP RAID Configuration to a se
Steps:

Name
1 7 waitfor HP SA Agent

2 E? Set Media Source

Select Filter

Current Filter: Narme

Folder
fOpsware/Tools/ @5 Provisioning/ ©5 Build Plan
fOpsware/Tools/ OF Provisioning/ OF Build Plan

fOpsware/Tools/ OS5 Provisioning/ O35 Build Plan

fOpsware/Tools/Build Plans/Virtualization/Gue:
fOpsware/Tools/ OS5 Provisioning/O5 Build Plan
fOpsware/Tools/ @5 Provisioning/ ©5 Build Plan
fOpsware/Tools/ @5 Provisioning/ ©5 Build Plan

fOpsware/Toals/OS Pravisioning/ 0% Build Plan

Step Type
Run OGFS Seript

Run Server Script

3 4] Configure Red Hat Default ks.cfg  Apply Configuration File
7 Inject Required Kickstart Settings Run OGFS Script

5 E:{ Inject Kickstart Personalization Se Run OGFS Script

6 [ Create Stub Partition
7 7 copy Boot Madia
5 [y GRUB Boot Loader w36

Run Server Seript
Run Servar Script

Install Zip

@
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14 Select the server on which to run the Build Plan the previously network booted machine).
15 Press Start. The progress of the Build Plan job is displayed.

& Run 05 Build Plan =]

Select Servers to Provision (Step 2 of 3)

Chaose ane or mare servers fram the provisioning poel, You can alse add a new iLO device or impart iLO devices, by clicking the buttans
below, To add a server to the pool, it must be network booted using the Server Automation boot image. Click the next buttan if you want
to add more options to the Run OS Build Plan Job or the start buttan to directly start the OS Build Plan.

Selected 5 Build Plam: ;Fj Fed Hat Enterprise Linux Server & RE6_64 Install

5 Refresh Server List 4 AddilD Devices s ImportilD Devices

Filter: Select Filter @l

Mo filter selected

Mame MAC IP Address Facility Model

provisioning0-YMwal Fed Hat Enterprise m—

%{l provisioningl-VMware-VMware 00:50:56:19:04:00 192,168.191.76 5.11-Ke6 corvo

4 Back & Next

When the Build Plan is complete, the server should be up-and-running and Managed by SA.

SA Provisioning Common Use Cases
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Provisioning Solaris x86-based Servers

Provisioning Solaris 11.1 x86
Network boot a server, as described in Network Booting on page 21.

On the network boot menu, select HPSA 0S Build Plan Service 0S Menu.

HPSA 0S5 Build Plan Service 05 Menu >

HPSA 05 Sequence Build Agent Menu >
Boot from local disk

Autoboot: Linux 64-bit Service 03

Hardware Information

Select Solaris 11 x86 Service OS.

Linux B4-bit Service 035

Linux 32-bit Service 03

Hindows 64-bit Service 03

Hindows 64-bit Service 05 - WinPE4.8
Hindows 32-bit Service 03

Solaris 11 xB6 Service 03

<-— Return to mMain mMenu

Solaris 11.1 x86 OSBP Service 035




Wait for the server to enter Maintenance mode.

Note the server's HPSA Server ID. This will help you identify the machine later on.

Start the SA Client and in the Navigation pane, select Library and set the view to By Type and select
the 0S Build Plans folder.

From the displayed list of available Build Plans, select and open the Build Plan, Solaris 11.1 x86
Default Install.

[RHP Server Automation - corvo.dev.opsware.com [_[O]x]
Fle Edt Wiew Took ‘Window Actions Help [ Logged in as: axis_oshuildplan_test_user

B = - | Name -
| Hame Description Lacation | Last Modified |=
[ 5aved Searches .. =1 SAMPLE: Deploy HP RATD Corfiguration Deploys & HP RATD Conflguration to a server  (Opsware/TooksjOS ProvisioningjOS Bulld Plans  5/16/14 1:05 AM =
Advanced Search SAMPLE: Deploy Ubuntu Server 12.04 ¥86_6¢ Ins... Installs Ubunku Server 12,04 64 bits on s Pro...  [Opsware/TooksjO5 ProvisioningjOS Build Pla...  5/16/14 1:06 AM
SAMPLE: Prepuare server for reprovisioning ka Linux — Prepars managsd server for re-provisioning, ... [Opsware/TooksjO5 PravisioningjOS Build Pla...  5/16/14 1:05 AM
SAMPLE: Windows 2003 Install to Alternats Drive  Installs the OF to 4 non-C drive letter using a... |Opsware/TooksjO5 ProvisioningjOS Build Pla...  5/16/14 1:06 AM
B T | 5y Fldr | SAMPLE: Windows WIM Imags Capture Capture & Windows volume inko 8 WIM imags.  [Opsware/TooksjGS ProvisioningjOS Build Pla...  5/16/14 1:06 AM
Solaris 10 xB6 Defaut Install Instals Cracle Solaris 10 x86 [Opsware/Toolks|O5 ProvisioningjOS Build Pla...  5/16/14 1:06 AM

5[16{14 1:05 AM

Application Configuration Solaris 11 %86 Default Instal Installs Oracle Solaris 11 1111 x86 jOpsware{Taols|OS ProvisioningiOS Buid Pl

" Audit and Remediation

42, Business Appications SUSE Linux Ertepriss Srver 11 Trstal Trstlls SUSE Linuss Enerpriss Server 11 {Copswate Tanks|25 Frovisioningis Build Pls...  5/16/14 1305 M
£ Cher Cokbocks 3 SUSE Linux Erterpriss Ssrver 11366 6 Install  Tnstalls SUSE Linux Entepiriss Ssrver 11 64 bits  [pswars/Taok (05 Frovisioningios Build Pls... 51614 1305 M
(3 Dotebases 3 5USE Linux Erterpriss Ssrver Gusst Customizstion  Frepares LinUz virtusl ssrvsr For cUstomizstio...  [Opswars/Taok(BUld Flars(WitUslizstion/Gus... 51614 1:05 M J
- 3 Switch to Legacy IS ook mods and Powsr OFF  Switchiss HF Prolisnt ssrver t0 Lsgacy BIOS . [pswars/Tak (05 Frovisioningios Build Plans 5716714 1:05 M
& Extensions 3 Switch to UEFT boot mods and Rower OFF Switches HP ProLiant server to UEF] book ma...  {Opsware/Tools/aS Provisioning/S Buid Flans  5{16/14 1:06 AM
J 05 Build Plans 3 Ubuntu Server 12,04 486 Tnstal Tnstalls Ubuntu Server 12,04 32 biks iOpsware{Tools{OS Provisioningios Buid Pla...  5/16/14 1:05 AM
Ly Packages £tk Sarwar 17 N4 YAA Ad Treksl Trckalle | bk Serwar 17 0d Ad kike iPim e ara T anle AMVS Brewsicinmine 1S Faild Dl AN 10 AW ﬂ
o )
B patcr ks B Solaris 11.1 x86 Default Install ()
[ Patches
} serpts General A
Y Setware Policies
3 Ut sers i Grops Name: Solaris 11,1 %86 Default Instal
- Description: installs e Soleris 11.1 0
Windews TI5 Mstsbase
5 Winudows T15 Settings
BB Windows Local Security Setting
Windows Regitry Location: JopswareiTools/0S Provisiening/0S Build PlansSalaris

Windows Services Last Madified: 5/16/14 1:06 AM

Last Modified By: detuser

- Created: 5/5/14 10:35 AM
63 fj pevices il
CreatedBy:  opsware
U Virtualization Object ID: E0001
e
i Reports

@j Tnbs and Sessinns

{‘I‘} Administration

In the Build Plan Edit window, from the Views panel tree, select Build Plan Items. A list of Build Plan
steps is displayed.



9  From the listed steps, select Set Media Source. The Run Script panel displays the Parameter setting
for this step. Note the protocol, NF'S, and the media path /mnt/share/solaris/
Solarisll.1-x86.

05 Build Plan Solaris 11.1 ®86 Default Install

File Edit iew Actions Help

2 Properties [} | = Remove | ¢ $ | B Copy Flan... b fdd Action Trem
> -
g Bulld Plan Items | Name | [@ s o Device Grop
] Custam Attribut > r
‘g Hstom Attriouies 1. 0 Wait for HP 54 Agent (OGFS Script) || £ Appky Configuration File
- Histary DY attach Software Policy
3. 4] Configure Solaris 11 Defaul ai.xml %T Attach Patch Policy
4. &) Configure Solaris 1.1 Default sc.xml ¢ Install ZIP Package
s, 77 Inject Required AT Settings (Python Script) 7 Run Script
6. 7 Inject AT Personalization Settings (Python Script) 2 Remediate Server
: - N
7 7] Create Solaris Stub Partition (Python Seript) £ Upload Canfiguration Fils
8 7 Copy Solaris Boot Media (Python Script)
[ 7 Deploy Agent {Uniz Seript)
10. & Integrate Solaris 11 HP SA Agent (Python Script)
11, {7 Modify Boot Archive (Python Script)
12, {7} Deploy Solaris Book Flles (Python Seript)
13, {7 Instal Solaris Grub (Python Script) =
- .
& Run Script (<]
Seript: [iomswareiToolsos Provisioning/S Build Flan Steps/Set Media Source Select

Script Type:  Python

|Parameters: [rfs:fi@MediaServer@imntisharefsolaris/Solaris1 1.1-485 --resolve-hostname |

10 Prepare an NFS share using the Solaris 11.1 x86 AI Install CD extracted under
/mnt/share/solaris/Solarisll.1-x86

11 Ensure that your network has access to a Solaris 11.1 IPS package repository:
— The official Oracle repository at http://pkg.oracle.com/solaris/release/.

— Aself-hosted repository available through HTTP (see your Oracle documentation for set up
information)
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12 In the Edit Build Plan Views pane, select Custom Attributes.

05 Build Plan Solaris 11.1 ®86 Default Install
File Edit iew Actions Help

@ Custom Attributes

Praperties =

%, Buid Plan Items
y Nare »

boot_disk
encrypted_root_password
hittp_prosy

L Histary

ips_source
MediaServer

System_locale
tirmezane:

13 Complete the MediaServer and ip_source custom attribute field:

— MediaServer must be the hostname or IP address of the NFS share you set up earlier.

— 1ips_source must be the complete URL for accessing a Solaris 11.1 IPS package repository.
14 Save the Build Plan by pressing Ctrl+S or using File > Save.

15 From the Actions menu select Run...

8 05 Build Plan Solaris 11.1 k86 Default Install M=l E3
File Edit View | Actions | Help
P open Enter
o A ove | 4+ 4 | BB Copy Plan... o Add Action Irem
= Remove Delete -
P R Name | |§ dd to Device Group
Custom Aty H st for S At (0575 St &) Apply Configuration File
listary et Media Source (Python Script) 91 attach Software Policy
Copy Plan... AltC onfigure Salaris 11 Default aianl Y attach Patch Policy
[ Run. onfigure Solaris 11.1 Default sc.ml 59 Install ZIP Package

5. 07 Inject Required Al Settings (Python Script)
6. [ Inject Al Personalization Settings {Python Script)
7. [ Create Solaris Stub Partition {Python Script)

8 3 Copy Salaris Boot Media (Python Script)

9 3 Deploy Agent (Unix Script)

10, &} Integrate Solaris 11 HP 54 Agent (Pythan Script)
11~} Madfy Book Archive (Python Script)

12, [ Deploy Solaris Boot Files (Python Script)

13, Install Solaris Grub (Python Script)

14, 7} Rebook (OGFS Script)

15, ) it for HP SA Agent (OGFS Script)

16, &} Manitor Solaris 11 Installation (OGFS Script)

17, &} Rebook (OGFS Script)

18, ") it For HP SA Agent (OGFS Script)

SA Provisioning Common Use Cases

3 Fun Script
9% Remediate Server
&) Upload Canfiguration File
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16 The Run 0S Build Plan window is displayed. Confirm the Build Plan selected by pressing Next.

Plan 9= E3

Select Build Plan (Step 1 of 3)

& Run 05 B

Choose an ©F Build Plan from the software library.

Filter: Select Filter

Current Filter: Marme

Mame Description Folder

SAMPLE: Deploy Ubuntu Server 12.04 X8 Installs Ubuntu Server 12.04 64 bits on  fOpsware/Tools/OS Provisioning/OS Build Plan |+
SAMPLE: Prepare server for reprovisionin Prepare managed server for re-provisior fOpsware/Tools/©S Provisioning/ 0§ Build Plan
SAMPLE: Windows 2003 Install to Alkernz Installs the ©F to a non-C drive letter u: fOpsware/Tools/OS Provisioning/ 0§ Build Plan
SAMPLE: windows WIM Image Capture  Capture a Windows volume ints 3 WIM i fOpsware/Tools/OS Provisioning/OS Build Plan
Solaris 10 x86 Default Install Installs Gracle Solaris 10 x86 fOpsware/Tools/ OS5 Provisioning/ 0§ Build Plan

Solaris 11 %86 Default Install Installs Gracle Solaris 11 11711 =96 {Opsware/Tosls/ G5 Provisioning/©8 Build Plan

Build Plan

SuSE Linux Enterprise Server 11 Install Installs 5uSE Linux Enterprise Server 11 fOQpsware/Tools/ 05 Provisioning/ 0% Build Plan

SuSE Linux Enterprise Server 11 ¥86_64 Installs SuSE Linux Enterprise Server 11 /Opsware/Taols/OS Provisianing/03 Build Plan |+ |

Properties: Steps:
Marne: Solaris 11,1 %86 Default Install Name Step Type
ID: 880001 = - :
Dascription: Installs Oracle Solaris 11,1 xg6 | | 1 (§ Waitfor HP SA Agent Fun OGRS Seript
2 [ setMadia Source Run Server Script
3 érj configure Solaris 11 Default ai.xm Apply Configuration File
4 4] configure Solaris 11,1 Default sc: Apply Configuration File
5 [ Inject Required Al Settings Run Server Script
-] Fj Inject Al Personalization Settings  Run Server Script
7 ;J Create Solaris Stub Partition Run Server Script
8 [ cCopy Solaris Boot Madia Run Server Script
¥ Refresh Build Plan List Gl >

17 Select the server on which to run the Build Plan the previously network booted machine).

18 Press Start. The progress of the Build Plan job is displayed.

Plan M= 3

Select Servers to Provision (Step 2 of 3)

Run 05 Buil

Choose ane or mare servers fram the provisioning pool. You can also add a new iLO device or impart ILO devices, by dicking the buttans
below. To add a server to the poal, it must be network booted using the Server Automation boot image. Click the next buttan if you want
to add more options ta the Run O Build Plan Job or the start button to directly start the ©F Build Plan,

Selected S Build Plan: j Golaris 11,1 =26 Default Install

3 Refresh Server List g AddilD Devices puy ImportilO Devices
Filter: Select Filter
Mo filker selacted
Name MAC IP Address os Facility Model
Pﬁ{l minint-j4f0ajc-vMware 00:50:56:82:65:A1 192,168,191.78 WINPESS corvo
Bl provisioningd-Mware- 00:150156182i64F8  192,168,191,75 Red Hat Enterprise Lin corvo

provisioningl-WMware- 00:50:56:19:04:00 192.168.191. 76 S5.11-XB86 corun

&

4 Back & Next

When the Build Plan is complete, the server should be up-and-running and Managed by SA.
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Updating an HP ProLiant Server's Firmware

An HP Service Pack for ProLiant (SPP) is an ISO image that contains firmware, drivers, and software
packages for Linux and Windows.

The components of each SPP are pretested together for stability.

To upgrade the firmware on target servers to the latest HP Service Pack, SA offers the baseline Build Plan
“ProLiant SW - Offline Firmware Update".

Downloading an SPP
1  Goto:
https://www.hp.com/go/spp
2 Select Download.
3 Select Current Version.
4 Select Download next to the Complete IS0 Image selection.
5  Enter your HP Passport user ID and password.
6  Follow the instructions to download the SPP ISO file.
Deploying a SPP Image to your Media Server
The HP-provided Build Plans that deploy SPPs require the SPP contents to be in the directory
<File share name>/Media/spp
on your Media Server.
Each SPP version has its own folder named after the SPP version.
For example, if the SPP is version 2014.06.0, the contents of the SPP ISO image should be extracted to
<File share name>/Media/spp/2014.06.0
on your Media Server.
Preparing and Running the “ProLiant SW - Offline Firmware Update” Build Plan

It is important to note that the offline firmware update must be performed in the Linux service 0S. As
such, the server will be automatically rebooted into the Linux service 0S if needed.

If you are updating firmware on a server already provisioned with an 0S and you want your server booted
back to this 0S after the firmware update is complete, perform the following steps to create a Build Plan
that boots your server back into its provisioned 0S:

1 Save the HP-provided Build Plan to a new name.

Edit the Build Plan copy.

Delete the last two steps of the Build Plan: **Boot** and **Wait for HP SA Agent**.
Add a Reboot step at the end of the Build Plan.

o b WODN

Addawait for HP SA Agent step to the end of the Build Plan and specify these parameters:
— —-production

— --atLeast 3

— -—-atMost 10

6 Save the Build Plan.

SA Provisioning Common Use Cases 63



The following steps must be completed before running the Build Plan:

1

Deploy the HP Service Pack for ProLiant (SPP) on your Media Server (see Downloading an SPP on
page 63 and Deploying a SPP Image to your Media Server on page 63).

Edit the parameters of the Set Media Source step, specifying the media URI containing the SPP
files (as specified in Deploying a SPP Image to your Media Server on page 63).

Example, using NFS:

é 05 Build Plan ProLiant S¥ - Offline Firmware Update*
File Edit Wiew Actions Help

5 Properties [ | = Remove | @ & | BB Copy Flan... b 4dd Action Ttem
: b Build Plan Ttems | Name | E’ Add to Device Group
: Q Custom Aftributes 1. ) Checkilo Service (OGFS Seript) £ Apply Configuration File
B Hstary 2. Fj Werify Supported Boot Modes (OGFS Script) Qir Attach Saftware Palicy
3. - Book (OGFS Script) E_Y Attach Patch Palicy
4 f"g’ Wait For HP 5A Agent (OGFS Script) L:jl Install ZIP Package
5. -} SetMedia Source (Python Script) 73 Run Script
6. (5 LinuxPE add-on packages 2 Remediate Server
7. ;j Update Firmware Using SPP (Unix Script) Q Upload Configuration File
8.~} Boot (OGFS Script)
9, E‘} Wit For HP 54 Agent (OGFS Script)

& Run Script ©

Scripk: Ip’OpswareJ‘TooIs,iOS Provisioningf©5 Build Plan StepsjSet Media Source Select |

Scripk Type:  Python

Parameters; I"nfs:J'.I'@MediaServer@,l’mnt,l’share"

| | calin | Thu Jun 05 12:40 2014 EtefUCT

> Note: When performing an offline firmware update, only the firmware components are installed from the
SPP; software and driver components are not installed.

Additional Parameters for the “Update Firmware Using SPP” Build Plan Step

64

--spp_version - specify the SPP version to use. By default, the latest SPP version is used.

--hpsum_options - specify any additional arguments to the HP SUM utility used to perform the
firmware update.

For a detailed description of the available HP SUM options, refer to the hp/swpackages/assets/
doc/CLIHelp. txt filein the SPP.

The syntax of this option is:
--hpsum_options="<optionl option2 ... optionN>"

—--hpsum_logs_dump_dir - specify a directory on a file share where a zip file containing the HP
SUM logs will be written.

--no_show_1log - disables showing the hpsum_log.txt contents in the job log.
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Example of a working parameter set:

Properties @ | = Remove | ﬁ @ | BB Copy Plan. o Add Action Ttem
BugRieltens | Name | @ Add to Device Group
Sheamptithtes 1. & CheckiLO Service (OGFS Seript) & Apply Configuration File
Hist | )
Ieery Sl a VYerify Supported Boot Modes (OGS Scripk) @J’ Attach Software Palicy

3. & Boat (0GFS Seript) 'E_‘( Attach Patch Palicy

4. {7 Wait For HP 54 Agent (OGFS Seript) [ Tnstall ZIF Parkage

5. [ Set Media Source (Python Script) & Run Seript

B, &'f LinuxPE add-on packages gr Remietinte server

@ Upload Configuration File
7} Book (0GFS Script)
g, * fj Wait For HP 54 Agent (OGFS Script)

'Qr. Run Script &

Script: IfOpswarE,iTDU\szuild Flans{Steps/ProLiant/Update Firmware Using SPP Select |

Scripk Type:  Unix

Parameters:

--spp_version=@35PPversion:latest@ --hpsum_options="{0n_failed_dependency: OmitComponent [f:all" --hpsum_logs_dump_dir={mnt/logs
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Creating New SA Build Plans

This section describes how to create new Build Plans, either by copying and modifying SA-supplied
baseline Build Plans or manually creating new Build Plans.

A Warning: Do not edit the source baseline Build Plans and Build Plan steps that are installed in the SA Client
Library during SA installation. If you do so, when you upgrade SA any changes you made to these baseline
Build Plans will be overwritten by the upgraded Build Plans. Always create renamed copies that you can
then customize. These customizations will be preserved during upgrade.

> Note: Making copies of Build Plan script steps that are installed by SA is not recommended, as you may
miss out on updates and bug fixes.

Customizing Out-of-the-box Build Plans

Before customizing a Build Plan, the Best Practice is to find a baseline Build Plan that is similar to the
configuration you want to install and copy it.

To do this, perform these tasks
1 Inthe SAClient Library, select the By Folder tab.
2 Navigate to the folder containing the Build Plan you want to copy.

3 Select a Build Plan and select Copy from the Actions menu or from the context menu.

= E

2 Logaedin as: auis_osbuldolan fest_user

b‘l [OpswarelTeols/0S ProvisioninglOS Build Plans/Linux

Servers -
=]

[ 5aved searcres .. =] 7 oozt maa
achvarced Semch 5 Coreers S osh_ge el ol gmaere SUIAEY. opowwe  BL..
3 Ceneos s sl 5B oo SNAEA. cpmere Bl
B Careers 6 o0 Inetsd smd.. - ocpowir  SRNARL.. cpowis L.
Iy Typa] B oo | “J Erase A Savver Deis 5B .. oo SN cpmere SR
=) |8 sasa osmd.. - opowire  SRNARL.. cpowis 10,
il 3 505 Defut ratal o5Eud .. i 0.
8 [ Managed Ratformy " radis Drnarprist L S Batal . - T
wlod Y racke Erberprise L 485 64 nstal 5B .. 81
= (] o Proviionng T Oracs Linuse & Ingtal G, - [
@ [ enne sweart 55 Oracks Lingx §336_6A Irakhol 5B .. 0.
L 2T "3 Prodiant O - Ubsarku Server 12,04 X06_éA lratal Chbud .. - opmere  SMHI4EL.. cpsware S0,
2 [ Manage st € 5 oo Hat Erdipeiin Linnse Serves 5§ bt 5B .. e SIMED. e 10
® [ o5 Buld Pan & ") Foed Hat Enberpeise Linus Server § 56_64 instal oM. - opeere G148, opswa PR
i-uerha T Hat Endeie Linue Server 6 bt 05 B .. oo S &3 g 10
st i | || P g e L. e SOIAES.. cowwen .
e BJ SAMBLE: Prepars sever forreproviel | Mew P oowae  SPAN4ED. cpswae G4
Sl T 11 bty - wore SPIAEL. orwen T
=[] Windows *3) SuSE Linue Exterprise Server 11136, ; swwre  SEMAEL. opswws 00
w [ weee ol |5 vt s 1200 88 emrt Py : mws SRS comees 1.
- J—I 59 Uty Server 12.00 0w oo e || 12008 Confiuration Tenglts from ... swere SEI4EDL. opewae S
e — o it
iy evies Fanare F2
| H Dot Detete.
2 vetusizsnen
l’ Ot ChrbeShiftad
o
Ly Crethited
6] movents . iakiaickl
(3] 0t ot s
¥} s
1o sekected v _sbnablplon oot ver | S/1S/14 £:16 AN Americallen_fenshes

4 You can then paste the Build Plan to one of your own folders and open it to customize it. To avoid
confusion, be sure to change the name and description.
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You can also create a new Build Plan by starting the SA Client, selecting the SA Library panel in the
Navigation pane, selecting the By Type tab and right clicking to select New Build Plan from the
context menu.

Editing a Build Plan

After opening a Build Plan, the Edit Build Plan window opens. You can add/edit steps and scripts, modify
parameters for each step or delete steps and scripts.

é 05 Build Plan Red Hat Enterprise Linux Server 6 X86_64 Install [_ O] =]
File Edit Miew Actions  Help

) rroperties | = remove | @ 3 | BB copy Flan... b dd Action Ttem
?_'d Build Plan Items | Name | E’ Add to Device Group
" custom Attribures 1. o] wait for HP 54 Agent (OGFS Script) | |:£1 Aoy Configuration Fie
2 & Set Media Source (Py Seript) (2 nttach Software Policy
3 %ri Configure Red Hat Default ks.cfg EY Attach Patch Palicy
4 E‘j Inject Required Kickstart Settings (OGFS Script) Q‘j Install ZIP Package
5 g Inject Kickstart Personalization Settings (OGFS Script) 7 Run Script
6. E‘j Create Stub Partition (Unix Script) EJ Remediate Server
7 g Copy Boot Media (Ui Script) Q Upload Configuration File
5. Ly GRUB Boot Loader k86
9 g Deploy Agent {Unix Script) I

10, E‘j Embed files initrd {Unix Script)

11, g Install bootloader For RedHat Enterprise Linux Server (Unix Script)
12, [} Reboot (OGFS Script)

13, g ‘Wait For HP SA Agent (OGFS Script)

El
- .
& Run Script 2
Script: |,|'Opsware)’ToDIs,l’OS Provisioning/ O35 Build Plan Steps/Set Media Source Select |

Script Type:  Python

Parameters: |"nfs:fI@Mediasarvar@;’mntishareirhel67x86-64"

| | axis_osbuildplan_test_user | 5/15/14 6:35 AM AmericafLos_angeles

Be careful when changing the order of Build Plan steps (Items). Certain steps must be performed in a
specific order and changing that order can cause errors.

\J

After upgrading to a newer release of SA, HP recommends that you compare the upgraded baseline Build
Plans with any Build Plans you may have modified, since these might have improvements you could
benefit from.

\/
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Custom Attribute Substitution

Using Custom Attributes on page 32 describes how to use the Build Plan step parameters using custom
attributes for personalization.

Build Plans make use of custom attributes for unlimited personalization including the ability to define and
use your own custom attributes.

As you can see in the Edit Build Plan Window above, Build Plans support a simple syntax for custom
attribute substitution in the form:

@CustomAttributeName:default value@

This pattern is replaced by the custom attribute value you specify or the default value if there is no custom
attribute specified. This substitution occurs in every text-based resource that Build Plans use as such as
scripts, configuration templates and script parameters.

For example, if you want to specify a parameter for the media protocol for a Build Plan, edit the parameter
of the Set Media Source step to:

@MediaProtocol:nfs@://@MediaServer@/mnt/share/rhel6_X86-64

This specification is persistent, unless you define a different @MediaProtocol custom attribute in the
server hierarchy or in the Build Plan. The media protocol can be changed to, for example, HTTP by setting
this Custom Attribute to HTTP.

Even though Build Plans are not attached to servers, custom attributes defined in the Build Plan are still
used. The Build Plan custom attributes have a lesser priority and are overwritten if the same custom
attribute is present on the server hierarchy. For more information about custom attributes and how they
are inherited, see Defining Custom Attributes on page 136.

Customizing Installation Profiles

The installation profiles provided by SA are designed to install a minimal working system.

> Note: These profiles should not be confused with the Installation Profiles used with the older SA 0S
Sequences.

You can use these profiles to:
*  Customize partitioning
*  Customize the firewall

* Install additional software from the installation media

> Note: For ease of troubleshooting, you should not use any scripts as part of an installation profile. SA
Scripts should be run as part of the Build Plan after the step that installs the 0S. This makes the scripts
easier to maintain.

For instructions abut how to change individual installation profiles, see the vendor documentation for the
0S you are installing and for the supported syntax. The name of the configuration template provides
keyword suggestions searching the syntax.

Depending on the 0S that you are installing and how much you want to change, you can either create a
new profile or copy and modify an existing profile.

Modifying an Existing Installation Profile

To modify an existing installation profile that is already in the Build Plan:

1 Start the SA Client and in the Navigation pane, set the view to the By Type tab.
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2 Select the folder 0S Build Plans.
3 From the list of available plans, open the plan you intent to modify.

4 Select the step in the Edit Build Plan window and note the location as shown below:

£ 05 Build Plan Red Hat Enterprise Linux Server 6 X86_64 Install =]
File Edit VWiew Actions Help

Properties f1 | =Remove | b 3| BB copy Plan... o Add action Tkem

Euild Plan Trems I Name | g’ Add to Device Group
Clpm it 1. ) wat for HP 54 Agent (OGFS Script) | | &3 apply Configuration Fi
i History 2. 7 set Media Source (Python Script) @ nttach Software Policy

3 & configure Red Hat Default ks.cfg ET #kkach Pakch Policy

4 ?:‘g Inject Required Kickstart Settings (OGRS Scripk) 59 Install ZIP Package

5. {7} Inject Kickstart Personialization Settings (OGFS Script) _@ Run Script

& - Creaks Stub Partition (Unix Script) |2 Remediate Server

7 @ Copy Boot Media {Unix Script) ér,j Upload Configueation File

8 [ GRUB Boot Loader %86

9, L Z‘J? Deploy Agent {Unix Script)

10. ?:‘g Embed files initrd {Unix Script)

18, ’3 Install bootloader For RedHat Enterprise Linux Server {Unix Script)
12, ~{} Reboot (DGFS Script)

13. ﬁ Wit For HP SA Agent (OGFS Scripk)

& Apply Configuration File

Configuration File: I,iOpswarep’ToolstS Provisioning/05S Build Plan Steps/LinuxiTemplatesConfigure Red Hat Defaulk ks.cfg Select I
Fnsta\l Path: Jitmp/user ks.cFa I

Overwrite files on server [

| | axis_osbuildplan_test_user ‘ Sf15/14 6:57 AM AmericafLos_Angeles

5 Select the Apply Configuration Filestep.Notethe Install Path and the step's order
position in the Build Plan. You will need this information when adding your own Apply
Configuration Filestep.

6 Inthe SA Client Library panel, select the By Folder tab, locate the configuration file and create a copy
of the file.

7  Open the configuration file copy and in the edit window, remove the old step in the Build Plan by
clicking on the Remove button.
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8  Add the new step as shown below:

| B} 05 Build Plan Red Hat Enterprise Linux Server 6 X86_64 Install [_ O] =]

File Edit View Actions

Help

o add Action Item

| @ Add ko Device Group

3 _{J Apply Configuration Fils
2% attach Software Policy
Y aktach Patch Policy

Ef” Install ZIP Package

3 Run Script

2f Remediate Server

éj Uplaad Canfiguration File

- |

& Apply Configuration File o

[Fopsware Tacls( s PravisioningfOS Buid Plan StepsflinusTemplatesfConfigure Red Hat Defaul ks.cfg

Select

axis_pshuidplan_test_user | 5/2114 £:13 AM AmericafLos_Angeles

Propetties @ IE Ramnval ﬁ @| Copy Flan..:

' 5 Build Flan Trems | Harne

1 =] Custom Attribut

; Q stom Attributes 1 o] Walt for HP SA Agent (OGFS Sript)

P! Hist

| D Ry Ej Set Media Source (Pythan Scripk)

|

I 4, f} Inject Required Kickstart Settings (OGFS Script)

I 5 3 Inject Kickstart Personalization Settings (OGFS Script)
& - Create Stub Partition (Unix Script)
5 3 Copy Boaot Media (Unix Script)
6. [ GRUB Baot Loader =66
9. -7 Deploy Agent (Unix Script)
10. z} Embed Files inited (Unix Script)
i1, 3 Instal bootloader for RedHat Enterprise Linux Server {Unix Script)
12, +-{ Reboot (OGFS Script)
3 3 Wait for HP 54 Agent (OGFS Scripk)

! Canfiguration File:
Install Path: [fempfuser ks.crg
Overwrite files on server [

4

é 05 Build Plan Red Hat Enterprise Linux Server 6 X86_64 Install*

Fle Edt View Actions

Help

M= |

Propertics
7 Build Plan Items
i-6] Custom Attributes

| 3 C History

[ | = rencve| ¢ |

Copy Flan...

b Add Action Tkem

[ T

| @ Add ko Device Group

1. fj Waik for HP 54 Agent (OGFS Scripk)

2i a Set Media Source (Pythan Scripk)

3. g Apply Configuration Fie

4, Zj Inject Required Kickstart Settings (OGFS Script)

5 Ej Inject Kickstart Personalization Settings (OGFS Script)
& i~ Create Stub Partition (Unix Script)

2 Ffj Copy Boaot Media (Unix Script)

8 [y GRUB Baot Loader <86

3, i~ Deploy Agent (Unix Script)

10. Zj Embed Files inited (Unix Script)

11, ?:j Instal bootloader for RedHat Enterprise Linux Server {Unix Script)
12, +-{] Reboot (OGFS Script)

By ’E}’ Waik for HP 54 Agent (OGFS Scripk)

14, -7 Monitor Installation {OGFS Script)

Q Apply Configuration Fils
9 attach Software Policy
E}’ Attach Patch Policy

E‘E} Install ZIP Package

7 Run Script

9f Remediate Server

Q Uplaad Canfiguration File

|»

E

& Apply Configuration File e

Canfiguration File: |

Select I

Tnstall Path: |

COvenwrite files on server [
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Note that the Apply Configuration File step applies only to the configurations from Configuration
Templates.

9  Ensure that the Apply Configuration Filestepisinthe correct order and has the same
Install Path.

10 After you add the Apply Configuration File step, you can double click it to edit it if necessary.

You can also create a new Configuration File in the SA Client Library By Folder view by selecting the New...
context menu option and selecting Configuration Template, or by navigating to the Configuration
Templates folder when viewing the SA Client Library in By Type view. Be sure to change the Parser Syntax.
Build Plans only support the Custom Attribute Syntax. You can copy/paste your installation profile in the
content section of the Configuration Template. You can add the new Configuration Template in the same
way as before.

Build Plans modify the installation profile using the Inject Requiredand Inject
Personalization family of scripts that are specific to each profile type. The Inject Required
scripts change the profile to integrate it with the SA Provisioning process. For example, the path to the
install media is added to the profile. The Inject Personalization scripts extend functionality in
addition to the profile. For example, steps that add network configurations to the profile.

Network Setup

Build Plans support customizing the network settings in all stages of the install process including the final
0S. For this reason, network settings present in the Build Plan take precedence over those settings
specified in the installation profile.

Network settings in the installation profiles are optional. For more information on how to configure the
network with SA Provisioning, see Personalize Network Settings on page 39.

Firewall Considerations

SA Provisioning Build Plans may make minor modifications to the firewall configurations on managed
servers on Windows platforms so that communication between the SA Core and the SA Agent is not
blocked.

For other managed server platforms, the installation profiles may disable the firewall.

Note: If you customize installation profiles to contain a firewall, ensure that the connection between the
SA Core and the SA Agent is not blocked.

Examples

For Red Hat Enterprise Linux, the following line in your ks . cf£g profile enables the firewall and allows the
SA Agent to function correctly:

firewall --enabled --port 1002:tcp

For SUSE Linux Enterprise Server, the following lines in the autoyast . xm1 profile enable the firewall and
allow the SA Agent to function correctly.

<firewall>
<FW_SERVICES_EXT TCP>1002</FW_SERVICES_EXT TCP>
<enable_firewall config:type="boolean">true</enable_firewall>
<start_firewall config:type="boolean">true</start_firewall>
</firewall>
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Build Plan Steps

The following section describes SA Build Plan steps.

Run Script Step

The Run Script stepis a key Build Plan component. The vast majority of steps used in Build Plans make
use of this step. The Run Script step executes a script either on the target server or in the SA Global
Shell (OGFS). SA Provisioning provides an extensive library of scripts that perform many of the most
common Build Plan tasks. In addition, you can create your own scripts by copying and modifying the
scripts that HP provides or by creating new scripts.

The following are some of the script types SA provides:

table 1 Build Plan Scripts

Script Type Description

OGFS scripts Execute on the SA Core in the SA Global Shell. All
other script steps run on the target server.

Note: Most of the OGFS scripts shipped with SA are
not meant to be modified in any way. They provide
vital functionality like booting target servers and
monitoring tasks.

Python scripts Execute on the target server. This is the only script
step that can be run against any target server
leveraging the platform independence of Python.

Standard UNIX/Linux shell scripts Execute on the target server. These scripts make
use of any interpreter that is installed on the
server.

Standard Windows batch scripts Execute on the target server.

Standard Windows Visual Basic scripts Execute on the target server.

PowerShell A script step is not currently supported. As a

workaround you can create a Windows batch script
that calls the PowerShell interpreter.

OGFS scripts are started at the following location:
/opsw/ .Server.Id/<<target server ID>>

From the Global Shell you can use the UAPI as the user under which the Build Plan runs. For more
information about the UAPI and the Global Shell see the User Guide: Server Automation, “SA Global
Shell”. Server scripts can also access the UAPI but will do so using the credentials of the target server, thus
limiting operations to that server.

Install Zip Step

The Install Zip step transfers a zip file from the SA library to a target server and uncompresses it to a
specified location. You can also specify pre-installation and post-installation scripts with the package
which can execute before or after file extraction.
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Capture and Deploy Configuration File Steps

Configuration text files are stored in the SA Client Library and are used for text-based data such as
unattended installation files or hardware configuration files. The Deploy Configuration Filestep
takes the specified configuration file and writes it to a user-specified location on the target server. Such
steps are often followed by a run script step that makes use of the configuration file. HP provides many
sample configurations. You can use these configurations or create your own.

The Capture Configuration Files step captures a configuration text file from the target server and
uploads it to the SA Client Library so that it can later be used as part of a Deploy Configuration File
step.

See Add to Device Group Step on page 74 and Attach Software or Patch Policy Steps on page 74.

Add to Device Group Step

This script causes a server to join a static device group. This script is typically used to configure custom
attributes on the device group and have them inherited by the server so they can be used during the
provisioning process. Custom attributes defined on the device group will be accessible after the Add to
Device Group step executes.

Attach Software or Patch Policy Steps

The Attach Software PolicyandAttach Patch Policy steps attach policies to the server,
allowing integration with SA Patching and Software Management. These steps can only be executed
against a server running a production SA Agent, so if the Build Plan also provisions an 0S, these steps
must be executed after the production 0S is running.

Remediate Server Step

Starts and waits for a remediation job to complete against the server according to the attached policies.
Note that the policies will not take effect if this step is not run.

Managing a Server's State

This section describes managing a server’s state which may be required before running Build Plans
against the server.

Asserting the state of the server

When creating or modifying Build Plans, you must account for the server’ state when certain steps are
executed. To do this, you use the Wwait for HP SA Agent script (runbythewait for Agent step).
The script has parameters that are used to assert the state of the server:

¢ Using the --maintenance parameter asserts that the target server is in Maintenance mode (running
a service 0S)

e Using the --production parameter asserts that the target is in production mode (running a
production 0S) and has an SA Agent installed with full capabilities.
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If the target server is not in the asserted state or if an SA Agent does not report at all, this step fails. This
assures that any step after a Wait step can make assumptions about the state of the server. For this
reason, it is good practice to start Build Plans with a wait step to assert early that the server is in the right
state before executing anything else. The next section describes how to force the desired state of the
server.

Changing the State of a Server

You may often find the need to have a server reboot from the service 0S to the production OS or the other
way around. To do this, you can use the Boot and Reboot scripts as Run Script steps.

The Boot step boots the server into a specific service 0S. It can make use of all available means to do so.
The most generic way to do so requires an SA Agent to be functional on the target server to be able to
reboot the server. The Boot step configures network booting for this specific server and reboots it to the
desired Service 0S. Note that this only works if network booting occurs before booting from disk in the
server's boot order.

If the target server is an HP ProLiant with a registered iLO, see iLO Support on page 29, the step does not
require an SA Agent to be present in order to reboot the server, and also is able to configure one-time boot
order on the server, so the server's boot order settings are irrelevant.

Using Scripts as Building Blocks

The Build Plan steps can be used as building blocks for developing new Build Plans and HP encourages you
to use them as building blocks, as you gain knowledge of how Build Plan steps work and interact and
become more aware of fixes in newer releases and their impact.

For more information about the included scripts including the Wait, Boot and Reboot scripts, see the
descriptions in the SA Client Library.

Running Build Plans on a Managed Server

While running Build Plans is supported on SA managed servers, most scripts that are installed with SA are
designed to work in a Service 0S and might not work against a managed server.

The most common reason to run a Build Plan on a managed server is to reboot it into a service 0S or
perform network personalization.

Should | Use Server Scripts or OGFS Scripts?

When creating new scripts, you must choose between a Server Script or an OGFS Script. OGFS scripts can
manipulate files and run commands on the target server. This overlapping functionality can make it
difficult to decide which to use.

Typically, server scripts are preferable since distributing work across target servers, rather than doing the
work from the SA Core, results in scalable and fast Build Plans since the resources of the target server are
used and network round trips are minimized.
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Since OGFS scripts run on the SA Core, the load on the SA Core increases as the number of target servers
increases and you would need to scale the SA infrastructure in order to scale with OGFS scripts. For
example, if you find that you need more access to the UAPI than is allowed from a target server, you will

need to use an OGFS Script.
table 2 Script Types
Script Type Run Location Scalability UAPI Access
OGFS Script SA Core Scales with SA Full: permissions inherited from
infrastructure the user that runs the Build Plan.
Server Script Local Server Scales with target Limited: basic operations on the
servers target server
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5 SA Provisioning Troubleshooting

SA Provisioning works right out-of-the-box however, you may have specific enterprise requirements that
you would need to configure for SA Provisioning.

The SA Provisioning Components

SA installs several components, when you choose to install the provisioning feature, that enable
provisioning.

The SA Agent

During SA Provisioning, the SA Agent provides multiple services:

* Asan SA Agent that runs on the production 0S. This SA Agent continues to run on the managed server
after it is provisioned.

*  The SA Agent in Maintenance Mode runs in the service 0S.

*  The SA Agent that provides monitoring. Similar to the SA Agent used in the service 0S, this instance of
the SA Agent is configured to run while an 0S is installed, monitors progress and allows build plan
steps to be run after the systemis installed (but before the first time the system is booted). Special
care is taken so that the SA Agent does not interfere with the 0S install.

» Note: Not all platforms have a monitoring SA Agent.

The Build Plan Content

Build Plan content, which is installed by default during a fresh installation or upgrade, includes a number
of baseline Build Plans that can, by default, perform many common provisioning tasks. This content also
includes program and web extensions as well as scripts which are used to implement Build Plans. This
content can be viewed in the SA Client Library.

AlL SA content is updated during the SA Core upgrade. Mixed version content is not supported, and will
likely not work if present. Build Plans that fail with import errors or errors suggesting incorrect or non
existing method calls are usually a sign that there is a version mismatch.

The Boot Server

Provides a set of tools that are pre-installed with the SA Core to support a wide set of network booting
capabilities. The Boot Sever requires no administration. The SA Core installation process handles all the
complexities of installing and configuring the boot server.

» Note: For a high level summary of all SA Core Components, see the SA Overview and Architecture guide.
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Troubleshooting Checklist

This section provides useful troubleshooting information.

Server Doesn't Enter Maintenance Mode

°  Symptoms
— Server doesn't show up in SA.
— Wait for HP SA Agent step fails with a time out error.
¢ What to check for
— Check the server console.
— Check that DHCP is working and the server is on the right network.
— Check that the SA Agent was able to register.

Gen8 ProLiant Servers Do Not Enter Maintenance Mode

°  Symptoms

— The "Boot" step fails.

— The "Wait" step fails after a successful boot step.
*  What to check for

— Check that DHCP is working and the server is on the correct network or that the network
information is correct.

— Check the error messages from the wai t step, they will contain additional information. Failure to
download the SA Agent is usually a sign that the network is not configured properly.

— Consider upgrading "Intelligent Provisioning" on the server and try again.
— Consider upgrading the iLO firmware on the server and try again.

— Login to theiLO interface of the server and complete an iLO reset.

Failures Before the 0S Install Starts

°  Symptoms

— Failuresin Set Media Source, Create Stub Partition or other scripts before the
Reboot script

*  What to check for
— Ensure that the input parameters, like the media path are correct.
— Ensure that the server has a hard disk and that the hard disk is recognized by the service 0S.
— Ensure that the Media Server is online and functional.

— Ensure that the network and DHCP is configured properly. For instance check that DNS is
configured properly and working if the Media Server is specified by host name.
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Failures of the 0S Installer

°  Symptoms

— Monitoringor Run setup scripts failure.

— Check for other failures that occur before rebooting into the installed 0S.
*  What to check for

— Ensure that the 0S media is correct and complete and that it matches the 0S, version and
architecture of the Build Plan. For example, do not use a Build Plan that installs a 64-bit 0S with
32-bit media.

— If you customized the installation profile, ensure that it is correct and valid.

— Check the server console and/or the output of the Build Plan to get more information about the
failure. Check with the 0S vendor for more troubleshooting tips.

Failures when waiting for the production SA Agent

°  Symptoms
— the wait step for the production SA Agent fails.
*  What to check for

— Check the server console to verify that the 0S was able to boot. Some installation failures are
only detected on first boot. If the 0S failed to boot, ensure that the installation profile was
correct. Check that any additional driver that was added during provisioning matches the server.
Check with the 0S vendor for more troubleshooting tips.

— Ensure that the server has correct network drivers and that the server can reach the SA Core.

— Ensure that a firewall setting is not preventing communication between the SA Agent and SA
Core.
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0S Sequence-based Provisioning
Requirements, Setup and Usage

A Deprecation Netice: For certain managed server platforms, 0S Sequences are deprecated in SA 10.10 and
later and have been replaced by the new and more powerful provisioning Build Plans. See the SA Support
and Compatibility Matrix for the platforms that support Build Plans. It is strongly recommended that you
migrate any existing 0S Sequences to Build Plans on these platforms. Any new SA provisioning templates
you need to create on these platforms should use Build Plans.

The 0S Sequence Provisioning Process

Using SA 0S Sequences requires of certain preparatory tasks including:

Installing and configuring the required 0S Provisioning components including the following:

— Media server repository preparation including creating Media Resource Locators (MRLs) for use
with 0S Sequences.

— Uploading licensed 0S media to the Media Server
— DHCP server management using the /opt/opsware/dhcpd/sbin/dhcpdtool .

Creating OS Installation Profiles for the operating systems to be provisioned. The Installation Profiles
specify which operating systemis to be installed and how it is to be configured and where the
operating system media is located on the Media Server (using an MRL).

Associated with the Installation Profile are:

— Operating system-specific installation configuration files such as Kickstart (Linux), Jumpstart
(Solaris/SPARC 10), Automated Installer (Solaris/SPARC 11) and unattend. txt or.xml
(Windows).

— Build Customization Scripts that allow you to manage each operating system installation from
the network connection to SA Agent installation.
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Custom Attributes that allow you to define server-specific custom attributes that set specified

parameters and named data values. You can write scripts that use these parameters and data
values to control network and server configuration, notifications, and CRON script configuration.

figure 1

Create 0S Installation Profile

Installation Profile

—— MRL
ﬂ Media Server
SA Client Installation Profile Wizard
Customization Hardware Configuration
Script Signature File:
Jumpstart,
Kickstart, etc.

*  Creating 0S Sequences that specify the 0S Installation Profile to use, device groups, and remediation
policies. You must use 0S Sequences in conjunction with 0S Installation Profiles.

figure 2 Create 0S Sequence
Installation -~
Prdfile Patch Policy
|
Zip Package
SA Client Create OS Sequence ~1
OGFS5 Script
1
Device
Group

After you have created your 0S Provisioning configuration files, the process for provisioning new servers
typically includes tasks similar to the following:

1 Preparation

Physically prepare the server for operation and connect it to a network that can communicate
with SA.

b Insome cases, you must prepare the server hardware for OS Provisioning.

a

¢ 0SInstallation Profile(s) defined and available.
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2 Booting the server to be provisioned
Power on and boot the server to be provisioned using one of the following boot methods:

a Use abootable image provided by SA.

>» A bootable CD or DVD is not required for Intel-based servers that support PXE/WinPE or Unix servers as
these servers can be remotely booted over a network.

b Forservers that can be booted over the network, powering on the server causes the server to
initiate its network boot process.

For more information about booting servers remotely, see [NEEDS UPDATE when content
ready]

3 After the server boots successfully and the SA Build Agent has been installed, the server appears in
the SA Client in the Unprovisioned Server list and is ready for operating system installation.

4  Install the Operating System (Provision)

Select a server that has been booted with an OS Build Agent and select an appropriate 0S Sequence for
the operating system and configuration you want to install.

5  Start the 0S Provisioning job.

SA 0S Provisioning Components

SA Provisioning is an optional feature that can must be installed for each SA Core where operating system
provisioning is to be performed. For information about installing the required 0S Provisioning
components, see the SA Installation Guide.

SA 0S Sequence Provisioning uses the following components and features.
*  The 0S Build Agent

*  The Build Manager

e The Media Server

*  The Boot Server

The 0S Build Agent

Used with OS Sequences, the Build Agent is Similar to the SA Agent, the 0S Build Agent is a simplified
agent whose function is to run commands as instructed by the Build Manager. Newly registered servers
with installed OS Build Agents appear in the SA Client Unprovisioned Server list.

Booting a new server with an SA-supplied image for the first time loads an 0S Build Agent on the server;
however, the server does not have the target operating system installed and might not have access to disk
resources. SA can still communicate with the server and perform commands on it remotely because the 0S
Build Agent is running a limited operating system that is loaded into memory.

The 0S Build Agent performs the following functions:
*  Registers the server with SA when the 0S Build Agent starts.
* Listens for command requests from SA and performs them.

¢ Performs commands even though a target operating system is not installed.
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The Build Manager

The build manager performs several functions:

*  Manages newly registered 0S Build Agents.

*  Coordinates scripts that gather hardware inventory from 0S Build Agents.

*  Coordinates the scripts that perform the operating system installation with the 0S Build Agent.

*  Communicates with the 0S Build Agents using a simple protocol.

The Media Server

The Media Server is installed as part of a typical SA Core installation when you specify that you want to
install the OS Provisioning components. In order to provision operating systems, you must first upload a
valid copy of the operating system’s installation media to the Media Server. During 0OS Provisioning, SA will
use the copy of the operating system installation media on the Media Server to do the provisioning.

SA provides file servers that can share operating system media using NFS and Samba if you do not have
existing NFS/Samba servers that you want to use or are not familiar with configuring these servers.

The Boot Server

The Boot Server listens for broadcast requests from new servers in the server pool and responds using
DHCP. Network booting requires DHCP/BOOTP, TFTP, and PXE (x86).

Build Customization Scripts

0S Provisioning build customization scripts provide hooks into the build process that allow you to modify
operating system installations at specific points. These hooks call a single build customization script at
the appropriate time in the operating system installation process.

Because each build customization script is specific to the operating system it installs, build customization
and installation vary by operating system. Before you can use a build customization script as part of an
operating system installation profile, you need to create the build customization script and import it into
the SA Client.
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How the 0S Build Agent Locates the Build Manager

How the 0S Build Agent locates the Build Manager depends on the boot method.

WinPE

*  SA retrieves DHCP options containing the agent gateway IP address and Build Manager port, or
*  The Build Manager is located by loading the configuration file:
/opt/opsware/boot/tftpboot/DHCPOptions.ini
which contains the 0S Provisioning settings specified during SA installation.

*  If the processes above fail, SA defaults to the hostname buildmgr on port 8017.

Linux:

Linux x86 locates the Build Manager using kernel arguments supplied at PXE boot time. These are
configured during the SA installation and stored in the file

/opt/opsware/boot/tftpboot/pxelinux.cfg/default

Linux 1A64:

Linux 1A64 locates the Build Manager using kernel arguments supplied at PXE boot time. These are
configured during the SA installer and stored in the file

/opt/opsware/boot/tftpboot/elilo.conf

Oracle Solaris/Sun SPARC 10 and 11

For Oracle Solaris/Sun SPARC 10 and 11 OS Provisioning, the JumpStart build script (Solaris/SPARC 10) or
Automated Installer (Solaris/SPARC 11) runs the 0S Build Agent, which contacts the Build Manager (via the
Agent Gateway in the core). The Solaris begin script attempts to locate the Build Manager in the following
ways:

* By usinginformation that the SA DHCP server provided
* By looking for the host name buildmgr in DNS as configured by the DHCP server

You can override the way that the 0S Build Agent contacts the Build Manager by specifying a boot
argument at the prompt when you boot a new Solaris server, for example:

ok boot net:dhcp - install buildmgr=buildmgr.example.com:8017
ok boot net:dhcp - install buildmgr=192.168.1.15:8017

Non-DHCP Environments
In both Windows and Red Hat non-DHCP environments, SA locates the Build Manager using the network

configuration specifications you provide. See Booting a Red Hat Enterprise Linux Server in a Non-DHCP
Environment on page 151 and Booting a Windows Server in a Non-DHCP Environment on page 155.
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Provisioning Setup for 0S Sequences

To prepare for 0OS Provisioning, authorized staff should determine and record the standard configuration
of each operating system to be provisioned as well as the required utilities, drivers, and agents. System
administrators can then use 0S Provisioning to install the operating systems, configure networking, and
install other software.

Before using SA 0S Provisioning you must complete a number of preparatory tasks including:

Confirming that required permissions are specified for users who will perform 0S Sequence
management and execution.

Confirming that the network is configured as required for SA Provisioning.

Preparing hardware to be provisioned as required.

Configuring the SA Media Server for the operating systems you will provision.

Uploading licensed operating system media to the SA Media Server.

Creating Media Resource Locators (MRLs) that identify the location of the media during provisioning.
Configuring optional HP RAID configuration capture.

Creating optional Build Customization scripts for the operating systems you will provision.

Creating optional Custom Attributes for the operating systems you will provision.

Creating OS Sequences that specify the order of provisioning tasks and can include optional
configuration information such as Software Policies, Windows Patch policies, Static Device Groups.

Creating Installation Profiles for the operating systems you will provision. You can also optionally add
custom attributes and build customization scripts to the Installation Profiles.

The following section summarizes those tasks and provides pointers to detailed instructions for
completing the tasks.

0S Provisioning Setup Task Summary

The required 0S Provisioning setup tasks, typically performed by an 0S Provisioning or SA Administrator,
include:

1

Installing the OS Provisioning Components. This task should have been completed when SA was
installed. If not, contact your SA or System Administrator. See the SA Installation Guide.

Configure the SA Boot/DHCP server using the /opt /opsware/dhcpd/sbin/dhcpdtool script.
This script is installed with the SA Boot server component.

Installing the Media Server. This task should have been completed when SA was installed. If not,
contact your SA or System Administrator. See the SA Installation Guide.

Ensuring that you have the correct permissions for 0S Sequence management and execution. To
obtain these permissions, contact your SA/System Administrator. For more information about which
permissions are required, see the Permissions Reference appendix in the SA Administration Guide.

Setting up the Media Server:

a  Copying your licensed operating system media or images to the Media Server NFS/Samba share.
After the media orimages are copied to these shares, ensure that at minimum Read permission is
given to these shares.
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b Using the import_media script tool to create the Media Resource Locators (MRLs) for the

operating system media. The import_media script is installed with SA's Software Repository
component. This step is required to create 0S Installation Profiles and 0S Sequences.

6  [Optional] Setting up HP RAID capture, which enables provisioning RAID configured servers.

7  Creating Build Customization scripts that allow you to modify operating system installations at
specific points.

8 [Optional] Creating Custom Attributes that allow you to set certain parameters and named data value.

For OS Sequence-based provisioning, custom attributes can be added to OS Installation Profiles.

9 Creating 0S Sequences, which allow you to specify provisioning tasks, the Installation Profile to use,
reboots, etc. While this task can be done by the Provisioning Administrator, it can also be delegated to
users who perform provisioning.

10 Creating 0S Installation Profiles in which you specify:

figure 3

The location of resources (MRLs), configuration files (Jumpstart, KickStart, YAST2, and Windows
unattended install files)

The 0S Sequence

How provisioning is to be performed (Build Customization scripts and Custom Attributes)
Software packages to be provisioned with the operating system

Hardware signature files

Creating an 0S Provisioning Installation Profile

Installation Profile

——MRL

ﬂ Media Server

SA Client Installation Profile Wizard

S R s

Customization Hardware Configuration
Script Signature File:
Jumpstart,
Kickstart, etc.

The following sections contain instructions to set up SA 0S Provisioning for supported platforms.

Setting Up the Media Server

The Media Server is the repository for the operating system media (images) that SA uses during SA
Provisioning. You must prepare the Media Server by uploading your images to the Media Server.
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For OS Sequence-based provisioning, after the media is uploaded to the Media Server shares, you must
create Media Resource Locators (MRLs) by running a script tool called import_media. This tells SA where
to find the images on the Media server for 0S Sequence-based provisioning. For more information about
the import_media script, see Creating Media Resource Locators (MRLs) on page 88. During
provisioning, the MRL is used to locate a specified image and install the new operating system on an
unprovisioned server.

The Media Server provides access to images over a network using NFS for Linux, VMware ESXi, and Solaris
systems and SMB/CIFS for Windows systems.

A single copy of the operating system media on the Media Server can be used to provision multiple servers
as long as you have valid licenses and/or license keys.

Creating Media Resource Locators (MRLs)

You must perform several steps to create the Media Resource Locators (MRLs). The import_media toolis
first used to import your operating system media.

Import Media Tool Prerequisites

Before you run the Import Media tool, the operating system media that you want to import must be
available through the network to the Media Server. You will need to know the hostname of the server
containing the image(s) you want to upload and the hostname of the Media Server.

Windows, Solaris, Linux, and VMware ESX operating system images on the Media Server must be
available through nfs/cifs/smb.

You must log in as an SA user (username and password) that has the required permissions to use the
Import Media tool. If you do not specify a username/password in the import_media argument, you
are prompted for a valid user name and password when you execute the command.

Import Media Tool Syntax and Options

The following section provides the syntax and command line options for the Import Media tool.

To start the tool, log onto the Software Repository server (Slice Component bundle host) and enter:

import_media [options] <network path>

The following networks paths are valid:

NFS:

nfs://<NFS server>/<exported path>

Windows media hosted on an SA SMB server share:

smb://<SMB Server>/0SMEDIA/<path>@@MediaServer@/0S Media

The username/password must be preceded by “@@” and ended by “@”. For example:
smb://userd312.example.com\thsu_usr:smithl23!@@MediaServer@/0S Media
Window media in CIFS server share:

cifs://<CIFS Server>/<share>/<path>

If the path contains spaces or shell metacharacters, it must be placed in quotes so that the shell
passes it to import_media as a single argument.
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IPv6 Deployment Syntax

All OS deployments over IPv6 require an AAAA DNS record or IPv6 address for the media server if you
have specified the hostname in the media path. In the following example, the “hostname” argument
must be changed:

smb: //<hostname>/<path>/0S Media

Table 3 lists the command line options available for the import media command.

table 3 Import Media Tool Command Line Options

Import Media Tool Option Description
--help Display this help.
--folder Override Folder location. Default is:

“/Package Repository/0S Media/<Platform Name>*“.

--medianame=<displayname> Override automatically-generated display name. Note: Use
'_'to escape spaces in the name.

-hpsa-username Username for authenticating to SA.

If you do not supply ~hpsa-username on the command
line, you are prompted to enter it. If you do not have a valid
SA user name and password, contact your SA administrator.

-hpsa-password Password for the SA username. Warning: This option is not
recommended, since passing passwords as command line
options is insecure. When this option is omitted, the user is
prompted for the password securely.

--mrl=<mrl> Override automatic 0OS Media path generation.
--mrl=//MEDIA/PUB/WINNT/SERVER/I386

--mrl=nfs://media/export/media/redhat/7.2

--smbuser=<user> User for SMB access. Default is “root”.

--smbpasswd=<password> Use this password for SMB access. Note: This appears in
cleartext on the command line. Warning: This option is not
recommended, since passing passwords as command line
options is insecure. When this option is omitted, the user is
prompted for the password securely.

--logfile=<logfile> Override log file location. Default is:

/var/log/opsware/mm_wordbot/import_media.log

--wimimage The path supplied refers to a (WIM) image. Be sure to also
supply --platform=<platform>, since the target
platform cannot be autodetected.

--platform=<platform> Override automatic platform detection. Must match an
existing SA platform defined in the Model Repository.
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table 3 Import Media Tool Command Line Options (cont’d)

Import Media Tool Option Description

--progress=[yes] Toggle display of progress (default is yes). For example:

--progress=no

--resolve-symlinks=[yes] Toggle resolution of symlinks (default is yes).

--upload = [yes] Uploads all packages to the Software Repository so that 0S
Provisioning can install them after initial provisioning
(default is no).

Configuring the Media Server for Microsoft Windows 0S Media/lmage

Perform the following tasks:

1 Onthe Media Server host, create the directory structure for the versions of the operating system that
you plan to use for server provisioning. Ensure that you use the path names specified for the Media
Server during SA installation.

Create the directory structure based on the root directories specified for the operating system media
during SA installation. If necessary, contact your SA administrator for the locations of the operating
system media root directories.

2 Ensure that the media for each operating system that you want to provision is available on the Media
Server.

3 Copy the operating system media files to the location on the Media Server specified during the SA
installation.

Importing Windows Media from Linux Host
When you launch the import_media tool from a server running a Red Hat Linux 5 kernel or higher, you
must use the Import Media tool Windows CIFS syntax to import Windows media.

You can use either SMB or CIFS to import Windows media for all other Linux kernel versions.

Importing Windows Media from a Solaris Host

When you launch the import_media utility from a Solaris server, you must use SMB to import Windows
media.

Configuring the Media Server for Windows Server 2003 (x86/x86_64), 2008, 2008 R2 x64
and 2012 0S media

Perform the following tasks:

1 Onthe Media Server host, create the directory structure for the versions of the operating system that
you plan to use for server provisioning. Ensure that you use the path names specified for the Media
Server during SA installation.

Create the directory structure based on the root directories specified for the operating system media
during SA installation. If necessary, contact your SA administrator for the locations of the operating
system media root directories.

2 Ensure that the media for each operating system that you want to provision is available on the Media
Server.
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3 Copy the operating system media files to the location on the Media Server specified during the SA
installation using the Import Media tool.

Windows Media: Preparing Network Driver Directories
To ensure that the server you want to provision has the appropriate network card drivers for Windows
Server 2003, 2008 and 2008 R2 x64, you must create directories for those drivers on the Media Server.
To create these directories on the Media Server, perform the following tasks:
1 Log on to Media Server as root.
2 Navigate toWwindows_media_share/1386 and create the following directory:
SOEMS/S$1/Drivers/nic

3 Create asubdirectory to which downloaded driver files will be saved. Name the subdirectories in a way
that will identify the drivers they contain. For example:

SC1425
4 Grant at least 755 permissions to the newly created directory and subdirectories.
5  Copy the driver files to the newly created directory suing the Import Media tool.

6 If you need to specify OEM drivers, add a line similar to the following in the [Unattended] section
of the unattend. txt file and reference the directory win which you are storing the drivers. For
example:

OEMPnPDriversPath = "Drivers\NIC;Drivers\NIC\SC1425"

For more information about drivers, refer to http://support.microsoft.com.

Windows Media: Hosting Windows Media on a Windows 2K Server using a Share
You want to host your Windows media on a Windows 2K (2003, 2008, 2008 R2 x64) server using a share
and have access to the share is available to a local user on the server. For example:

Server / Share:
\\servername\IOP

user: username password: userpasswordis used to mount the share. SA Windows build script
directories have the user hard coded to guest with no password. Many security policies do not allow for
an enabled guest account, read-only share.

Perform the following tasks to set up the share:
Edit the file:
/opt/opsware/buildscripts/windows/buildserver.py

and replace these lines:

system_ini["network"] ["username"] = self.mrl_username
system_ini["network"] ["logondomain"] = self.mrl_domain
system_ini["network"] ["workgroup"] = self.mrl_domain

with your share credentials. Also edit the following lines specifying the correct username/password:

# formulate net logon command line
logonCmd = []
logonCmd. append ("1h %$ramdrv%\\mslanman\\net")
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logonCmd. append (" logon")
logonCmd. append (self.mrl_username)
logonCmd. append (self .mrl_password)

Configuring the Media Server for Red Hat Linux or VMware ESXi 0S media

1 Download the Red Hat Enterprise Linux 5 images to the Core.

2 Connect to the Core as root using ssh (you will need to run mount commands).
3 Create atemporary folder for loop mounting the images.
4

Create a directory under the media server's Linux media path. The Linux media path is a NFS share
configured during the core install.

5 Mount the first image read only:
mount -o loop,ro rhel-5-server-i386-discl.iso <tmp_mount_dir>
6 Change to the temporary directory
cd <tmp_mount_dir>
7 Issue the command
tar cf - . |(cd /media/opsware/linux/RHEL5-Server/ && tar xfps -)
8 cdout of the temporary directory.
9 Unmount the temporary directory:
umount <tmp_mount_dir>
10 Repeat steps from 5 to 9 for the remaining 4 images.

11 You can now import the media using the Import Media tool.

Configuring the Media Server for SUSE Linux or SUSE Enterprise Linux 0S media

SUSE Linux 9
a Create the following directory structure:

sles9
sles9/suse
sles9/suse/CDl
sles9/core
sles9/core/CD1
sles9/core/CD2
sles9/core/CD3
sles9/core/CD4
sles9/core/CD5
yast

b Copy the contents of the first SUSE Linux 9 CD1 to the s1es9/suse/CD1 directory.

The directory numbering does not match the CD numbering which can be confusing, so be sure you are
copying the contents of the CDs into the correct directories.

¢ Copy the contents of the second SUSE Linux 9 CD2 to the s1les9/core/CD1 directory.

d  Copy the contents of the third SUSE Linux 9 CD3 to the s1es9/core/CD2 directory. Continue
this sequence until all the CDs have been copied to their respective directories.
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e Inthesles9 directory create the following symbolic links:

1In -s sles9/suse/CDl/boot boot

In -s sles9/suse/CDl/media.l media.l

In -s sles9/suse/CDl/content content

In -s sles9/suse/CDl/control.xml control.xml

f  Using an editor, create the instorder filein the yast directory. It should contain the following
information:

/suse/CD1l
/core/CD1l

g Using an editor, create the order file in the yast directory. It should contain the following
information:

/suse/CD1l /suse/CD1
/core/CD1l /core/CD1

SUSE Linux 9 with Support Pack

You will need all nine SUSE CDs, three contain the Support Pack and six FCS CDs. Follow the standard
installation steps above first then complete the following tasks:

a Add the following directories:

sles9/sp3/CD1
sles9/sp3/CD2
sles9/sp3/CD3

b Copy the contents from the SP3 CD1, CD2, and (D3 to s1es9/CD1, sles9/CD2,and sles9/
CD3, respectively.

¢ Modify the instorder and order files to include the sp3 directory you added in the preceding
step at the top of each file.

instorder
/sp3/CD1
/suse/CD1
/core/CD1

order
/sp3/CD1 /sp3/CD1
/suse/CD1 /suse/CD1
/core/CD1 /core/CD1

d Logon as root to the repository server and create the following additional symbolic links:

In -s sp3/CDl/driverupdate driverupdate
In -s sp3/CDl/linux linux

SUSE Linux Enterprise Server 10

As of SUSE Linux Enterprise Server 10 it is no longer necessary to use the above procedures.
You can install everything into a single directory.

SUSE Linux Enterprise Server 11

You can install everything into a single directory, however, it is important that you copy the
contents of the second SUSE Linux Enterprise Server 11 DVD into the directory first, then
copy the contents of the first SUSE DVD into the same directory.

— More SUSE Linux information

For more information on SUSE linux installations, see:
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http://www.suse.com/~ug/
http://www.suse.com/~ug/autoyast_doc/index.html

For more information on AutoYaST Module development, see:
http://www.suse.com/~ug/autoyast_doc/devel/index.html

For more information about development and documentation links for AutoYaST for SUSE Linux
Enterprise Server 9, 10 and 11 see:

http://developer.novell.com/wiki/index.php/YaST

For AutoYaST Documentation from OpenSUSE, see:
http://en.opensuse.org/YaST_Autoinstallation

If required, for information on how to deal with multiple sources, see

http://www.suse.com/~ug/autoyast_doc/index.html

Configuring the Media Server for Oracle Sun Solaris 10

A WN

10
n

Download the Solaris 10 images to the core.
Connect to the core as root using ssh (you will need to run mount commands).
Create a temporary folder for loop mounting the images.

Create a directory under the media server’s Linux media path. The Linux media path is a NFS share
configured during the core install.

Mount the first image read only:

mount -o loop,ro sol-10-ud-ga-x86-vl.iso <tmp_mount_dir>
Change to the temporary directory:

cd <tmp_mount_dir>

Issue the command:

tar cf - . | (cd /media/opsware/sunos/Solarisl0/ && tar xfps -)
cd out of the temporary directory.

Unmount the temporary directory:

umount <tmp_mount_dir>

Repeat steps from 5 to 9 for the remaining 4 images.

You can now import the media using the Import Media tool.

Configuring the Media Server for Oracle Sun Solaris 11

1

On the Media Server, create the directory
/media/opsware/sunos/Solarisll

Download the Solaris 11 images to the directory above.
There are two IS0 images:

+  PartA, x86(3.3GB)

+  PartB, x86 (3.1 GB)

Follow the instructions on the download page to concatenate the two images into a single full image.
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4 Create a symlink (symbolic link) to the repository on the Media Server. This symlink is required when
provisioning Solaris 11 x86 and Solaris 11 SPARC on the same core because both operating systems
are contained in the same image and a Media Resource Locator (MRL) cannot be created using the
same path for two operating systems.

For example:

# cd /media/opsware/sunos/

# 1s -1lsa

8 drwxr-xr-x 3 root root 4096 Mar 26 14:33 solarisll_repo

#1ln -s solarisll_repo solarisll_link

# 1s -1lsa

4 lrwxrwxrwx 1 root root 15 Mar 26 14:39 solarisll_link -> solarisll_repo/
8 drwxr-xr-x 3 root root 4096 Mar 26 14:33 solarisll_repo

Oracle Solaris Automated Installer

The Oracle Solaris Automated Installer uses two response files:

* ai.xml:for the Automated Installer to specify partitioning, locales, source repository and packages
to beinstalled

* sc.xml: for System Configuration to specify host name, user passwords and specific configurations,
services configurations, and network configurations.

> Oracle documentation about creating ai . xml and sc . xm1 files can be found at:

http://docs.oracle.com/cd/E23824_01/html/E21798/

Since SA can handle only one response file per operating system and the Solaris Automated Installer
requires two files for provisioning Solaris 11, SA provides a script, join_ai_sc.py, locatedin /opt/
opsware/buildscripts/solaris/tools, onaSlice component bundle server, that canjoin ai .xml
and sc.xml into a single file. The output file this script creates is then used as the response file for Oracle
Solaris 11 provisioning.

Choosing Between Solaris 10 SPARC and Solaris 11 SPARC

Because Oracle Sun SPARC provisioning uses the bootp protocol, there is no clear way to choose between
Solaris 10 SPARC and Solaris 11 SPARC provisioning. Therefore, you must use the /opt/opsware/boot /
jumpstart/tools/switch solaris_sparc_miniroot command to tell SA which version of Solaris
to choose. This tool can be found on the core server on which the 0S Provisioning component bundle is
installed.

Enabling Oracle Solaris 11 x86 with the Manage Boot Client (MB()

By default, the Manage Boot Client (MBC) utility can only automatically provision Solaris 10 X86. To enable
Oracle Solaris 11 X86 in MBC, run the tool /opt /opsware/boot/js-x86/tools/
switch_solaris_x86_default_pxe and choose the desired default option from the Solaris Preboot
Execution Environment (PXE) menu. Once Solaris 11 is set as the default, all machines that boot into the
Server Pool will boot the Solaris 11 X86 miniroot. Also all MBC jobs will use the Solaris 11 X86 miniroot,
causing MBC jobs for Solaris 10 X86 to fail. This tool is found on the core server on which the 0S
Provisioning component bundle is installed.
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Steps to Create MRLs

Perform the following steps to create an MRL using the Import Media tool:

1
2

Log into the Software Repository (Slice Component bundle) host as root.
Change to the following directory:
/opt/opsware/mm _wordbot/util

Ensure that you have the correct path to the directory where you uploaded the operating system
media on the 0S Media Server.

Run the following import_media script:
./import_media [options] <network path>

For example, to import Windows Server 2003 operating system media from an SMB share named
OSMEDIA on the server mediasrv, enter:

import_media smb://mediasrv/OSMEDIA/WINNT/SERVER/I386

For example, to import Windows Server 2008 R2 x64 operating system media from and SMB share
named OSMEDIA on the server mediasrv, enter:

mkdir <tmp_dir>

mount -t udf -o loop,ro w2k8r2spl.iso <tmp_dir>

cd <tmp_dir> && tar cf - . | (cd /media/opsware/windows/w2k8spl.r2 && tar xvf -)
import_media smb://mediasrv/OSMEDIA/w2k8spl.r2

umount <tmp_dir>; rmdir <tmp_dir>

To import Linux (or VMware ESX) media from an NFS server named mediaserver . company . com,
enter:

import_media nfs://mediaserver.company.com/export/media/redhat/7.2
To import Solaris media from an NFS server named mediaserver . company . com, enter:

import_media nfs://mediaserver.company.com/export/media/solaris/
sol-10-u8-sparc

To import Solaris 11 SPARC media from a NFS server:

import_media nfs://mediaserver.company.com/export/media/solaris/solarisll_repo/repo

To import Solaris 11 x86 media from a NFS server:

The Solaris 11 repository is detected by default as Solaris 11 SPARC media. Therefore, to use this
repository to provision a Solaris 11 X86 server, you must run import_media with
--platform="Sun0OS 5.11 X86" parameter.

import_media --platform="SunOS 5.11 X86" nfs://mediaserver.company.com/export/media/
solaris/solarisll_link/repo

Unless otherwise specified, the default folder location for uploaded software packages is in the form
/Package Repository/0S Media/<Platform Name>, where <Platform Name> is the (full)
SA name for the platform detected in the media being imported. If the folder does not exist, then it is
created. To manually specify a folder location, use the --folder option.

Running the Import Media tool writes progress to the log file import_media.log. The log file is
located on the server where you are running the Import Media tool script in the directory from which
you invoke the script.

For information on the command line options for the Import Media tool, see Import Media Tool
Syntax and Options on page 88.
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Media Resource Locator (MRL) Administration

Editing MRLs

Perform the following steps to edit an MRL:
1 Loginto the SAS Web Client. The SAS Web Client home page appears.

2 From the Navigation pane, click Software > Operating Systems. The Operating Systems page
appears.

3 Select the 0S Media tab. A list of Media Resource Locators (MRLs) appears.
Each MRL represents media available for installation. See Figure 4.

figure 4 0S Media Page in the SAS Web Client

1 Total | Windows NT 4.0 v
Mame ~* Path 05 Yersion Size  Modified

]

] @5’ Windawes NT 4.0 Wthesneardimedisiwinntdis56 Windawes NT 4.0 g9.07 MB  04-22-2005

Fath DH&E Media Serner to the 05 Media

4 Click the display name for the MRL that you want to edit. The Edit 0S Media page appears, as Figure 5
shows.

figure 5 Edit 0OS Media Page in the SAS Web Client

Name: Red HatEnterprise Linux AS 3

Description: Red Hat Enterprise Linux AS 3 Media

0S8 Version: Red Hat Enterprise Linux AS 3
Path: nfs://mediaserver.c76.dev.opsware.com/mediajof
Size: 153 GB

Last Modified: Mon Feb 12 10:48:13 2007
ID: 38360076

| save || cancel |

5 You can modify the name, description, or path of the MRL.
6 Click Save.

Deleting MRLs

You cannot delete an MRL with the SAS Web Client when the MRL has been previously specified in an 0S
Installation Profile. To delete an MRL specified in an OS Installation Profile, you must first delete the 0S
Installation Profile or specify another MRL in the OS Installation Profile.

See Defining and Managing OS Installation Profiles on page 109 for more information.
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Perform the following steps to delete an MRL:
1 Loginto the SAS Web Client. The SAS Web Client home page appears.

2 From the Navigation pane, click Software > Operating Systems. The Operating Systems page
appears.

3 Select the 0S Media tab. The list of media available for installation appears.
4 Select the operating system Media that you want to delete.

5  Click Delete. (If the MRL is specified in an 0S Installation Profile, a warning message appears.) The list
of Media Resource Locators re-appears.

Advanced Import Media Tool Information

“Importing operating system media” means that the Import Media tool creates an
automatically-generated string called a Media Resource Locator (MRL) for each operating system media
that you want to provision that points to the operating system media’s location on the Media Server. The
MRL is used by the Software Repository to identify the location of the operating system media on the
Media Server. Import media also uploads software packages related to the operating system media to the
Software Repository.

An MRL is a network path (in URI format) to the installation media for an operating system on the Media
Server. When a server is being provisioned with an operating system, the server mounts the network path
for the operating system media by using NFS (for Linux and Solaris), or SMB (for Windows). The MRL is
registered with SA. An MRL should resolve to the Media Server in the local facility where SA is installed.

When you run the Import Media tool to create an MRL, the tool:
*  Mounts the media at the specified network path by using NFS, SMB, or CIFS.
*  Detects the operating system (Solaris, Linux, VMware ESX, or Windows) and version of the media.

*  Creates that MRL in SA based on the server name and path that you specify, so that you can use it in
0S Installation Profiles.

* Uploads all packages to the Software Repository so that 0S Provisioning can install them after initial
provisioning. You can specify --upload = vyes if you want to upload all packages to the Software
Repository. The default is --upload = no.

The --folder option allows you to specify the full path to upload the operating system media
packages. This path corresponds to a folder inside the Library in the SA Client. These packages can be
added to a software policy in the SA Client. The software policies can be associated with an 0S
Sequence. After provisioning completes, the policies will be attached to the server and remediated. If
you do not use the --folder option, then the packages will by default be uploaded to /Package
Repository/0S Media/<Platform Name>.

Re-running the Import Media tool with the same server and path as an existing MRL updates the MRL, but
does not re-upload duplicate Linux, Solaris, or VMware ESX packages.

From SA 7.80 on, the import_media utility no longer modifies the media during new Linux/Windows
media import.
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Multipath SAN Support for 0S Provisioning

SA provides multipath SAN support for the topics listed in this section.

0S Sequences

Red Hat 6 automatically identifies multipathing and enables kernel modules, but Red Hat 5 does not.

For Red Hat 5, before you run a Red Hat Enterprise Linux (RHEL) 5 OS Sequence, use the following steps to
pass MPATH as a kernel argument for the server:

1 Define a custom attribute kernel_arguments for the server, and set its value to mpath. See
Custom Attributes for Linux or VMware ESX on page 138.

2 Create the 0S Installation Profile.
3 Add a custom attribute to the Installation profile, and set its value to mpath.
4 Set the value of the installation profile to mpath.

If you are performing multipath installation, it is also recommended that you add mpath as the kernel
argument in the Red Hat 5 kickstart file. You can do this by creating a copy of the Configure Default Red
Hat 5 ks . c£g and modifying the file.

SUSE Linux Enterprise Server 11

SUSE Linux Enterprise Server 11 does not identify multipathing by default. Use the procedures in this
section to install SUSE Linux Enterprise Server on multipath LUNs.

Updating Multipath Drivers

You must copy the drivers into the media to enable multipathing. More information about the driver
update disk (DUD) and the process of updating the media is available here:

http://www.novell.com/support/viewContent.do?externalld=7009981 &sliceld=1
To configure SA, you must perform the following tasks:

1 Download the driver update disk (DUD) from the above link.

2 Extract the contents of the DUD to the SUSE Linux Enterprise Server 11 media.

3 Upload the SUSE Linux Enterprise Server 11 media to the SA Media Server using the import_media
command.

4 If you already have the media uploaded into the SA Media Server, extract the contents of the DUD as
directed by the SUSE support document.

> Note: After you complete these steps, multipathing will be enabled for all subsequent installations. To
perform non-multipathed installations, create a separate SUSE media within SA Media Server.

Defining Kernel Arguments

To enable multipath installation, pass mpath as a value for the custom attribute kernel_argument by
doing one of the following:

*  When creating the 0S Installation Profile, define the custom attribute kernel_argument and set its
value to mpath.

*  Before running the SUSE Linux Enterprise Server 11 0S sequence, define a custom attribute
kernel_argument on the server to be provisioned, and set its value to mpath.
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Partitioning Section in AutoYaST

SUSE Linux Enterprise Server 11 requires that devices be specified in Mapper format during multipath
environment installations. SA 0S Provisioning verifies the AutoYaST profile and modifies it to suit the
multipathing environments, based on the following rules:

table 4

Case

SA Solution

1 AutoYaST does not have the partitioning
section.

SA adds the partitioning section with the drive and
device.

2 AutoYaST has a single drive section, but does
not have a device section.

SA inserts the boot drive expressed in Mapper
format.

3 AutoYaST has multiple drive sections, but does
not have device sections. Has multiple drive
sections but no <device> in <drive>
section.

SA does not make any changes to AutoYaST. It
prints a warning and continues with the
installations.

This type of configuration can cause installation
failure. To ensure a successful installation,
complete each of the drive sections with devices in
Mapper formats.

4 AutoYaST has devices in the configuration
Single _OR_ multiple drive sections and a
<device> specified for the <drive>.

SA checks if the drive attributes in AutoYaST are in
the correct Mapper format. If they are not, SA
prints a warning and makes no further checks for
correctness.

If the drive attributes are not in the correct format,
the installation fails. To ensure a successful
installation, complete each of the drive sections
with devices in Mapper formats.

Friendly Device Name

/dev/mapper devices should only be used during installation. The SUSE Linux Enterprise Server Storage
Administration Guide states that, in the running system, the multipath devices should be accessed

through /dev/disk/by-id/.

SA sets up the scripts to convert the devices from /dev/mapper to /dev/disk/by-idwhenyou define
the custom attribute friendly mpath_device to true.

Windows 2008/ Windows 2008 R2

Windows supports installations in multipath environments. Install multipath Device Specific Modules
(DSMs) to further improve the capabilities of the target server. Import these DSMs into the SA Software
Repository and install them using software policies attached to 0S sequences.

You can modify the SAN Policy for the Windows Service 0S (Winpe32, winpe64, winpe32-ogfs,
winpe64-ogfs) shipped with SA. For more information about available options, see:

http://technet.microsoft.com/en-us/library/cc749466(v=ws.10).aspx

The default SAN Policy registry value in the SA-provided Windows pre-installation environment (WinPE)

boot imageiis 1.
VMWare ESX/ESXi

VMWare ESX and ESXi support multipathing - no additional steps are required.
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Configuring RAID on HP ProLiant Servers Before 0S
Provisioning

You can configure disk mirroring and striping as part of the initial setup of an HP ProLiant server prior to
provisioning an operating system.

HP ProLiant RAID configuration requires having an HP ProLiant server configured with a baseline RAID
configuration that is captured to a software policy. The captured RAID configuration is then applied to a
server using the methods described in this section.

Supported Hardware

*  HP ProLiant Servers

Supported Operating Systems

Baseline HP ProLiant RAID Configuration Capture

HP ProLiant RAID configuration capture is supported by the following SA-provided boot images:
* Red Hat Enterprise Linux 5

*  Red Hat Enterprise Linux 6

Solaris (SPARC, x86) is not supported.

HP ProLiant RAID Provisioning

*  Linux 0S Sequences: HP ProLiant RAID provisioning can be performed on any SA-supported Linux
operating system that can be installed on HP ProLiant servers.

*  Windows 0S Sequences: HP ProLiant RAID provision can be performed on any SA-supported Windows
version that can be installed on HP ProLiant servers.

> The Red Hat Enterprise Linux 5/ Linux 6 boot images (Red Hat enterprise Linux 5.6 and 6.0 base) use a
newer version of the Array Configuration Utility (ACU) tool. Therefore, HP ProLiant RAID configurations
captured using the Red Hat Enterprise Linux 5 boot image can be successfully deployed only on
unprovisioned servers that registered with the SA Core using the 1inux5/1inux6 boot images.
Deployment of an HP ProLiant RAID configuration captured with the 1inux5 (Red Hat Enterprise Linux 5
base) boot image to an unprovisioned server that registered with the SA Core using a different boot image
will fail due to differing ACU tool versions

HP also occasionally updates the ACU tool which, in rare cases, can cause RAID configurations captured by
an older version of the tool to be invalid. In these cases, you should rerun the RAID capture as described
below in order to update the RAID capture.

Capture a Baseline HP ProLiant RAID Configuration

In order to configure RAID for an HP ProLiant server, you must first capture a baseline HP ProLiant RAID
configuration that is saved into a RAID software policy that will be applied when provisioning new servers.
SA uses the HP SmartStart Array Configuration Utility to perform the capture. The utility is installed by the
SAinstallation.

To capture the RAID configuration, you must specify the custom attribute, raid. capture=1inthe server
record for the baseline HP RAID server which causes the server’s RAID configuration to be captured into
the software policy when it is booted into the SA Unprovisioned Server Pool.
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You can do this in either of two ways:

a Use the Manage Boot Client (MBC) utility to create a server record for that server with the custom
attribute raid. capture=1 specified. See The Manage Boot Clients (MBC) Option on
page 145 for information on creating or modifying a server record with MBC.

b Reset the baseline HP RAID server to an SA Unprovisioned Server Pool to create the server record,
edit the server record in the SA Client to specify the custom attribute raid. capture=1, then
power the server off.

After the server record is created with the raid. capture=1 custom attribute, boot the server into the SA
Unprovisioned Server Pool so that the HP server's RAID configuration is captured in a software policy.
Before SA creates the RAID software policy, it first creates a containing folder which is automatically
named using the model number of the server for which the policy is to be created.

If the RAID configuration is captured successfully, you see a message similar to Figure 6 in the console.log
file:

figure 6 RAID Configuration Capture Message
B

File Edit Wiew Settings ‘Windomw Help

N

Captured RAID array configuration from 00:16:35:36:DC.57 %
RAID Policy ID/Mame: 14150001,/00:16:35:36:DC:57 RAID Capture
Opsware Library Path: RAID Paolicies/HP-ProLiant DL360 G4

0S Build Agent registered successfully. MAC: 00:16:35:3B:DC:37

IP: 172.20.250.152 Server |D: 110001

Lastupdated: 19:19:52 | |

By default, the software policy is given a name that consists of the server’s MAC address appended with
the words RAID Capture,suchas 00:16:35:3B:DC:97 RAID Capture. You can rename the file in
the SA Client. After the RAID configuration is captured, the value of the custom attribute raid. capture
is automatically set to “0”. This is to prevent unintended RAID captures from occurring for subsequent
booting of the server to the unprovisioned servers pool.

The value of a custom attribute, raid.version, is also set to one of the following values: 1inux,
linux4, 1inux5, or winpe. During an 0S Sequence job, if the raid.policy_idis set, SA compares the
raid.version value with the current server's version. If the values do not match, or the policy does not
have the raid.version custom attribute, a warning is logged to the log file indicating the versions
mismatch and that RAID deployment may fail. However, SA will attempt to continue the job.
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The software policy appears in the SA Client RAID Policies Library:
figure 7 RAID Policies Library in the SA Client

i o man P Lm0z
- ile] - C— —

a 1 Lot ks By Crmmimd Crmsted By -]
3 Fi Tum bapr 17 LR0IS 300 Dusey -~
Foina 20 1 % 09 200 tnregp
PP 30 LR08 0 3000

At this point, to provision RAID servers, you must add a server record custom attribute,

raid.policy id=<value> for the unprovisioned server, specifying the RAID software policy Object ID
as the value. The captured baseline RAID configuration specified in the policy is then applied during
provisioning.

The RAID policy you specify for an 0S Sequence RAID deployment must be saved in the
/RAID Policies/Model Name folder. If the RAID policies are saved or moved to a different folder,
attempting an 0S Sequence RAID deployment will fail with a Software Policy not found error.

> The method described above is the only way to apply RAID policies. RAID policies must not be attached to
any objects, including unprovisioned servers, device groups, 0S Sequences, and so on.
> If SA fails to configure an HP RAID controller during a "Run 0S Sequence” job, a subsequent attempt to

capture the HP RAID controller configuration may fail with the following message:

RAID configuration deployment failed: Failed to deploy RAID configuration: An
error occurred while clearing current array configuration. Exit status: 1280
Error message from ACU: ERROR: (2821) No controllers detected.

This is due to a known issue in the HP ACU controller. In this case, you must manually configure the HP
RAID controller with a logical volume at server boot time.

Creating an HP ProLiant RAID Dynamic Server Group

After you have captured a baseline HP ProLiant RAID software policy, you can add a custom attribute,
raid.policy id=<value> (specifying the RAID software policy Object ID as the value) to a Dynamic
Device Group. Any unprovisioned server subsequently attached to that Device Group will have the HP
ProLiant RAID configuration applied when it is provisioned.

> Due to the way server records are inserted into Dynamic Server Groups, RAID capture may be skipped
when the server is inheriting the RAID configuration. In this case, you should manually specify the RAID
configuration policy in the server record. If the server is not yet in the SA Server Pool, you must reboot the
server.
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Manually Specifying an HP ProLiant RAID Configuration

You can write your own HP ProLiant RAID configuration file to be applied when a server is provisioned. To
do so, specify the raid.hpacu. script custom attribute in the server record. You can specify a
pre-written file for the script to use for configuration or open the editor in the server record and enter the
RAID configuration manually.

Defining Installation Profiles and 0S Sequences

0S Sequence provisioning requires that you use certain configuration files that define how SA is to
perform provisioning:

* Installation Profiles
*  Creating OS Sequences

This chapter describes how to define and administer these files.

0S Installation Profile Requirements

This section discusses the following topics:

e Overview on page 104

+ Specifying Software for OS Provisioning on page 105

+  Configuration Files on page 105

Oracle Solaris/Sun SPARC 10 Installation Profile Requirements on page 106
Red Hat Linux Installation Profile Requirements on page 106

*  VMware ESX Installation Profile Requirements on page 107

SUSE Linux Installation Profile Requirements on page 107

*  Microsoft Windows Installation Profile Requirements on page 107

Overview

You use 0S Installation Profiles in conjunction with 0S Sequences. Installation profiles specify which
operating system is to be installed and how it is to be configured. You should create your installation
profiles before creating 0S Sequences since each sequence must be associated with an Installation Profile.

Before you create your Operating System Installation Profiles, you should have already set up 0S
Provisioning as described in the SA Installation Guide and in Creating Media Resource Locators (MRLs)
on page 88 and have created MRLs pointing to the operating system media using the Import Media tool as
described in Setting Up the Media Server on page 87.

You create 0S Installation Profiles by using the Prepare Operating System Wizardin the SAS Web Client.
The process of creating an Operating System Installation Profile includes:

1 Specifying properties for the operating system.
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2 Specifying the location of the operating system media from which to perform an installation by

selecting an MRL. (See Editing MRLs on page 97 for more information on editing MRLs.)

3 Uploading the following installation resources used during unattended installation:

*  Astandard configuration file for the operating system. (See Configuration Files on page 105 for
more information.)

e Abuild customization script, which can modify the installation process at certain points. (See
Creating Build Customization Scripts on page 124 for more information.)

*  Microsoft Windows Only: a Hardware Signature, which contains hardware specific information.

Table 5 compares the installation resources across operating systems.

table5 Installation Resources for 0S Installation Profiles
Installation Windows Server | Windows Server | Solaris/SPARC | Solaris/SPARC | Linux or
Resource SUSE 2003 2008/2012 10 1 VMware ESX
Configuration File | YAST profile unattend.txt unattend.xml Jumpstart Automated Kickstart/
autoinst.xml profile Installer Weasel profile
Build Optional Optional Optional Optional Optional Optional
Customization executable file: | executable file: | executable file: | executable file: | executable file: | Executable file:
Script bes.tgz WinPE: WinPE: bes.tar.Z bes.tar.Z ::jocnstal'zizg
L - ini
containing bcs.zip bcs.zip fontfm"_]g fOntflnll‘.lg srun” script
“run” script containing containing run” script run® script

"runphase.bat"
script

"runphase.bat"
script

Hardware
Signature File

Not required

Optional
filename.txt

Optional
filename.txt

Not required

Not required

Not required

The configuration file that you upload for each operating system can have any file name. However, when
the file is uploaded, OS Provisioning renames the file so that it has the correct name for that operating

system.

You can edit an 0S Installation Profile later to add support for new hardware or to change the way the
operating system is installed. See Modifying Existing OS Installation Profiles on page 115 in this chapter
for more information.

Specifying Software for 0S Provisioning

You can specify the packages to install during OS Provisioning in the following ways:

* By uploading a configuration file that specifies to the vendor installation program the software
packages to install.

* By specifying SA Software Policies that add the desired packages in an 0S Sequence.

Configuration Files

For 0S Sequence-based provisioning, depending on the operating system being provisioned, the following
configuration file must be specified in an 0S Installation Profile:

e Oracle Solaris/Sun SPARC 10

JumpStart profile
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Oracle Solaris/Sun SPARC 11

Automated Installation

Red Hat Linux

Anaconda (Kickstart configuration file)

VMware ESX

ESX 3.5: Anaconda (Kickstart configuration file)
ESX 4: Weasel (Kickstart configuration file)
SUSE Linux

YaST2 configuration file

Windows

unattend. txt or unattend.xml

> If your configuration file enables a firewall, you must ensure that all necessary ports and protocols for
communication between the SA core and the 0S Build Agent and the SA Agent are allowed. Refer to the SA
Installation Guide for details. To help isolate firewall related issues, you should leave firewalls disabled
while configuring OS Provisioning for the first time and reenable them once the system is correctly
configured. For Red Hat Enterprise Linux 5 and 6, the following line in your ks . c£g profile enables the
firewall and allows the SA Agent to function correctly:

firewall --enabled --port 1002:tcp,1002:udp

For VMware ESX prior to 4.1 provisioning, the SA Agent installer may temporarily bypass any 0S-based
firewall configured in the ks . cfg.

Oracle Solaris/Sun SPARC 10 Installation Profile Requirements

When preparing a Solaris/SPARC 0S Installation Profile, OS Provisioning requires that you upload a
JumpStart profile.

The Solaris/SPARC Jumpstart file must:
Be a valid profile that you can use with a JumpStart server.
Specify that the installation type is an initial installation and not an upgrade.
Specify a package-based installation by listing the clusters and packages to install.

Specify disk partitioning information.

Red Hat Linux Installation Profile Requirements

The Red Hat Linux Kickstart file specifies the packages to install, how to partition the drive, and how to
configure the runtime network post-installation.

When preparing a Red Hat Linux OS Installation Profile, SA validates the Kickstart configuration file. When
the configuration file is uploaded, 0S Provisioning parses the file in order to extract the package list.

The Red Hat Linux Kickstart file must:
Be a valid configuration file that you can use with a Kickstart server.

Specify the RPM packages to install.



Include the reboot option.

VMware ESX Installation Profile Requirements

VMware ESX provisioning uses a kickstart configuration file. This file consists of several VMware ESX
Server installation parameters. You can configure this file to instruct the Kickstart server to install
packages, to partition the drive, to configure the runtime network post-installation, and so on.

The VMware ESX Kickstart file must:
Be a valid configuration file that you can use with a Kickstart server.
Specify the RPM packages to install.
Include the reboot option.

The VMware ESX Server provides a Web-based wizard (VI Web Access). Its web wizard interviews you for
configuration information and then generates a configuration file.

For VMware ESX-specific commands that must appear in the configuration file and information about the
configuration file wizard, see the VMware Installation and Upgrade Guide: “Remote and Scripted
Installations”. You can find this guide at

http://www.vmware.com.

SUSE Linux Installation Profile Requirements

The SUSE Linux configuration file specifies to YaST2 which packages to install, how to partition the drive,
and the operating system configuration.

When preparing a SUSE Linux OS Installation Profile, SA validates the YaST2 configuration file. When the
configuration file is uploaded, OS Provisioning parses the file and extracts the package list.

The SUSE Linux YaST?2 file must:
Be a valid YaST2 configuration file.
Include the Reboot option and have the Confirm Properties option in the mode resource set to FALSE.

For SUSE Linux, see http://www.suse.com/~ug/ for more information on installation.

Microsoft Windows Installation Profile Requirements

If you are creating a Windows 0S Installation Profile, the configuration file must be an unattended
installation response file that conforms to the following:

The OemPreInstall key must be set to YES. If this key is not set, OS Provisioning will set it
automatically.

A network configuration must be specified so that when the operating system boots for the first time,
it will get a valid IP address.

Any dialog boxes that may appear during the Text and GUI mode portions of Windows setup must be
set so that they do not appear during the 0S Provisioning process.

When uploading an unattend. txt file, SA validates the response file and rejects incomplete response
files.

See Sample Response File for Windows Server 2003 below for an example of a valid Windows response
file.



Sample Response File for Windows Server 2003

The following sample response file shows typical valid responses for a Windows Server 2003 installation.
This sample response file contains the required settings for Windows Server 2003 provisioning with SA
Provisioning.

[Datal
AutoPartition=0
MsDosInitiated=0
UnattendedInstall=Yes

[GuiUnattended]
AdminPassword=3mbree0
OEMSkipRegional=1
OEMSkipWelcome=1
;004 Pacific Standard Time (GMT-08:00) Pacific Time (US and Canada); Tijuana
;See http://unattended.sourceforge.net/timezones.php
TimeZone=004

[Identification]
JoinWorkgroup=WORKGROUP

[LicenseFilePrintDatal]
AutoMode = PerSeat

[Networking]

[Unattended]
ExtendOemPartition=1
FileSystem=ConvertNTFS
OemPnPDriversPath=drivers\nic\intel
OemPreinstall=Yes
OemSkipEula=Yes
UnattendMode=FullUnattended

[UserDatal
ComputerName=*
FullName="Windows Server 2003"
ProductKey=XXXXX-XXXXX-XXXXX-XXXXX-XXXXX
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Defining and Managing 0S Installation Profiles

This section discusses the following topics:

 Defining an OS Installation Profile — Linux/Unix on page 109

Defining an OS Installation Profile — Windows on page 111

* Modifying Existing OS Installation Profiles on page 115

«  Changing the OS Installation Profile Properties on page 116

*  Modifying How an OS s Installed on a Server — Linux/Unix on page 116
*  Modifying the OS Installation Profile Packages on page 118

Viewing Change History for an OS Installation Profile on page 119

+  Deleting an OS Installation Profile on page 119

Defining an 0S Installation Profile — Linux/Unix

To use the Prepare Operating System Wizard to define a Linux/Unix OS Installation Profile, perform the
following steps:

1 Access the Prepare Operating System wizard from the SA Client or the SAS Web Client:

*  SA Client. from the Navigation pane, select Library > 0S Installation Profiles. Select an
operating system, then from the Actions menu, select Create New.

*  SAS Web Client Home Page: click Prepare 0S in the Tasks panel or, from the Navigation pane,
click Software > Operating Systems. The Operating Systems page appears. Click Prepare 0S.

The Describe 0S page appears, as Figure 8 shows.

figure 8 Describe 0S Page in the Prepare Operating System Wizard

%'repam Operating System

() bewrite | Describe OS
Enter the following infermation to describe the operating system.

Hame:

Description:

Customer: Customer independent

05 Verslon:  Centos 3 -

Cancal

2 Describe the operating system by specifying the following information:
*  Name: (Required) Specify the display name for the Linux/Unix operating system.

*  Description: (Optional) Provide a text description to identify the platform and hardware support.
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*  Customer: (Required) Associate the Linux/Unix operating system with a specific customer; to set
up the operating system for use by all customers, select “Customer Independent”.

e 0S Version: (Required) Specify the version of the Linux/Unix operating system (select from a
pre-defined list of operating systems that SA supports).

3 Click Next. The Define Installation page is displayed, as Figure 9 shows.
figure 9 Define Installation Page in the Prepare Operating System Wizard

hilps:/192.168.201.99 - Prepare Operating Syslem - Mozilla Firelox

Prepare Operating System

@ozete | Define Installation

Specify the installation media, response file and optional pre-installation options.

_-;I Define
- Installation | 1,00 l1ation Media

OS Media: | SuSF Linus Friepise Ser 10 3

Build Customization

Mor: | et | | Detede

vast? Configuration

Corm 192, 166,301,995

4 Define the installation by providing the following information:

* Installation Media: (Required) Specify the MRL for the Linux/Unix operating system (select one
MRL from the pre-defined drop-down list of available MRLs).

See Creating Media Resource Locators (MRLs) on page 88 for more information on this topic.

*  Build Customization Script: (Optional) Click Select to choose a script to use for this installation
profile from the popup window that appears. (Customization scripts that you have created
appears in the popup window after you upload them through the SAS Web Client, see Using Build
Customization Scripts on page 124.)

The way you can customize the build process is specific to each build script. You must follow the
requirements for build customization scripts to use this feature.

*  Configuration File: (Required) Specify a JumpStart profile, Kickstart configuration file, or YaST2
autoinst.xml file to upload for use by OS Provisioning.

The file that you upload can have any file name, however, 0S Provisioning renames the file during
upload with the file name required by the vendor installation program.

5  Click Upload.

SA creates the Linux/Unix OS Installation Profile and uploads the configuration file (and parses
packages for Oracle Solaris/Sun SPARC, Red Hat, SUSE Linux, and VMware ESX). A progress bar shows
the progress of the operating system preparation process.

6 Click Close when the upload is completed.
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Defining an 0S Installation Profile — Windows

To use the Prepare Operating System Wizard to define a Windows 0S Installation Profile, perform the
following steps:

1 Access the Prepare Operating System wizard from the SA Client or the SAS Web Client:

*  SAClient: from the Navigation pane, select Library > 0S Installation Profiles. Right click on an
operating system and select New.

*  SAS Web Client Home Page: click the Prepare 0S link in the Tasks panel. Or, from the Navigation
pane, click Software > Operating Systems. The Operating Systems page appears. Click Prepare
0s.

The Describe 0S page appears, see Figure 10.

figure 10  Prepare 0S Wizard: Describe 0S

() Boserive | Describe OS
. Enter the following information to describe the cperating system.

Name:

Desenpton:

CUSIGMER:  Custare Indegeedent

05 Version: Cancos ¢

GCancel

2 Describe the operating system by specifying the following information:
*  Name: (Required) Specify the display name for the Windows operating system.
*  Description: (Optional) Provide a text description to identify the platform and hardware support.

*  Customer: (Required) Associate the Windows operating system with a specific customer; to set
up the operating system for use by all customers, select “Customer Independent”.

e 0S Version: (Required) Specify the version of the Windows operating system (selected from the
pre-defined list of the operating systems that SA supports).
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3 Click Next. The Define Installation page appears, see Figure .

Prepare 0S Wizard: Define Installation

https:fi192.168.201.3 - Propare Oparating System - Mozilla Firefox

Prepare Operating System

Doscribe
o 08

Done.

oy Define
L Installation

Define Installation

Spetify the installation media, response file and optional pre-installation options.

Installation Media a

0% Media: | windows 2003 w

Installation Oplions

Select Installation Type: & pos O winpe

Build Customization

Hone [Seiect | | Delete

Response Flle

Cancel| « Previous

152.160.200.3

4 Define the installation by providing the following information:

For Wind

0S Media: (Required) Specify the MRL for the Windows operating system (select one MRL from
the pre-defined drop-down list of available MRLs that you have already defined). See Creating
Media Resource Locators (MRLs) on page 88 for more information on this topic.

Installation Options: (Required) Choose the type of pre-installation environment to use when
you install the Windows operating system.

Your selection determines which customization script options you can use.

ows Server 2008/2012 provisioning, you must use WinPE.

When a server is booted with the WinPE pre-installation environment, it appears in the Server
Pool in the SAS Web Client and in the Unprovisioned Servers list in the SA Client. If you select
WINPE, you can set the following parameters:

Custom Disk Partitioning: The script you provide is passed to the Microsoft diskpart.exe
utility and is used during operating system installation. Refer to the Microsoft Windows product
documentation for more information.

Custom Disk Formatting: This script is executed directly onto the hard drive during operating
system installation.

Install Drive: Indicates the drive letter on which to install the Windows operating system.
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If you do not enter any settings in these fields, the default values used are shown in Figure 11.

figure11  Default Values used for WinPE Installation Options in 0S Installation Profile

Installation Options

Select Installation Type: O pos & WINPE

rescan
gelect disk O

clean

Ckeate partition primary
active

assign letter=C

Custom Disk Partitioning:

format.com C: SFR:NTF3 /0 /¥ /W
Custom Disk Formatting:

Install Drive: [C

*  Build Customization: (Optional) Select a build script to customize the way the build process
operates for the Windows operating system.

You can customize the build process specifically for each pre-installation environment. You must
follow the requirements for build customization scripts to use this feature. Scripts appear in the
popup window for your selection after you upload them through the SAS Web Client.

Click Select to choose a file from the popup window.
See Creating Build Customization Scripts on page 124 for more information.

* Response File: (Required) Select a Windows response file to upload into the OS Installation
Profile. This can be an unattend. txt for unattended Windows installations or a sysprep.inf
type file for image type Windows installations.

The file that you upload can have any file name, however, 0S Provisioning renames the file during
upload with the valid file name required by the vendor installation program.

*  Hardware Signatures: (Optional) Define the list of hardware that the operating system supports.

Click Add to open the Add Hardware Signature Setting window. The Applies To field is
pre-populated with the hardware makes and models that have been built, so that they appear in
the Managed Server list.

You can add multiple Hardware Signature files to a Windows 0S Installation Profile.
5 Click Upload.

SA creates the 0S Installation Profile and uploads the configuration file (and examines any packages).
A progress bar shows the progress of the operating system preparation process.

6 Click Close when the process is complete.

Hardware Signature Files for Windows

A Windows setup response File (unattend. txt) typically contains a mix of generic operating system
configuration settings and hardware-specific driver configuration settings. This mixture of generic and
hardware-specific configuration settings can make it difficult to manage a single 0S Installation Profile
that must be used by many different hardware models.

SA includes a mechanism called Hardware Profiles that allow you to keep the generic configuration
settingsinunattend. txt separate from the hardware-specific driver configuration settings.
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During 0S Provisioning, SA will examine the server being provisioned and, if a matching Hardware Profile
is available for the server model, will automatically add in the appropriate hardware-specific driver
configuration settings fromunattend. txt.

Based on the hardware you expect to provision, you can upload hardware-specific files for each Windows
0S Installation Profile. You can then map a signature for that hardware to the correct hardware-specific
profile. 0S Provisioning selects the correct Hardware Signature file at build time based on the hardware
signature of the server that is to be provisioned.

Utilities referenced by the Hardware Signature file must be accessible through the network during build
time.

Example Hardware Signature File

The following is an example of a Hardware Signature file that would be used for installing Windows XP on
a VMware ESX guest with an LSI Logic SCSI controller:

;Windows Setup Answer File

;Validated for use with HP

;Goal with this file is to leave things unspecified as much as ;possible,
therefore taking all the defaults

;Only including the absolutely essential directives for full ;unattended
operation

A Windows setup response File (unattend. txt) typically contains a mix of generic operating system
configuration settings and hardware-specific driver configuration settings. This mixture of generic and
hardware-specific configuration settings can make it difficult to manage a single 0S Installation Profile
that must be used by many different hardware models.

SA includes a mechanism called Hardware Profiles that allow you to keep the generic configuration
settings inunattend. txt separate from the hardware-specific driver configuration settings.

During 0S Provisioning, SA will examine the server being provisioned and, if a matching Hardware Profile
is available for the server model, will automatically add in the appropriate hardware-specific driver
configuration settings fromunattend. txt.

Based on the hardware you expect to provision, you can upload hardware-specific files for each Windows
0S Installation Profile. You can then map a signature for that hardware to the correct hardware-specific
profile. 0S Provisioning selects the correct Hardware Signature file at build time based on the hardware
signature of the server that is to be provisioned.

Utilities referenced by the Hardware Signature file must be accessible through the network during build
time.

Example Hardware Signature File

The following is an example of a Hardware Signature file that would be used for installing Windows XP on
a VMware ESX guest with an LSI Logic SCSI controller:

;Windows Setup Answer File

;Validated for use with HP

;Goal with this file is to leave things unspecified as much as ;possible,
therefore taking all the defaults

;Only including the absolutely essential directives for full ;unattended
operation

;Windows XP Pro SP2 media
;VMware ESX 3.0.1 guest configured for Windows XP
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;with a LSI Logic SCSI controller
; (Nota Bene BusLogic is the default in the ESX guest setup ;wizard)
;512 MB RAM, 1 NIC, 2 CPU

[GuiUnattended]
AdminPassword=hp
OEMSkipRegional=1
OEMSkipWelcome=1
;004 Pacific Standard Time (GMT-08:00) Pacific Time (US and
;Canada); Tijuana
;See http://unattended.sourceforge.net/timezones.php

TimeZone=004

[Identification]
JoinWorkgroup=WORKGROUP

[LicenseFilePrintDatal]
AutoMode = PerSeat

[Networking]

[Unattended]
DriverSigningPolicy=Ignore
ExtendOemPartition=1
FileSystem=ConvertNTFS
OemPnPDriversPath=Drivers\NIC
OemPreinstall=Yes
OemSkipEula=Yes
TargetPath=*
UnattendMode=FullUnattended

[UserDatal
ComputerName=*
; Ful1lName=<org_ name>
; OrgName=<org_name>
;You can/should also set this as a custom attribute
; "ProductKey"
;on the OS Installation Profile
ProductKey=<product_key>

The use of Hardware Signatures files is not required for Oracle Solaris/Sun SPARC or Red Hat Linux
operating systems because Solaris/SPARC and Linux distributions do not need to be specifically tailored
for particular hardware models.

Modifying Existing 0S Installation Profiles

You can edit an 0S Installation Profile by:

¢ (Changing the properties for the operating system, for example which customer(s) can use the 0S
Installation Profile to provision servers.

*  Modifying the way that the operating systemis installed on servers by changing the configuration file
or customizing the way the build process works for that 0S Installation Profile.
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Adding custom attributes to the 0S Installation Profile to override default values in the build process.
You can add custom attributes from the SAS Web Client or from the SA Client. (See Defining Custom
Attributes on page 136. For information on how to set custom attributes for software policies, see
Adding Custom Attributes to OS Installation Profile (SAS Web Client) on page 142.

Specifying custom disk partitioning and custom drive formatting (For Windows servers booted with
WinPE).

Changing the 0S Installation Profile Properties

To change the properties for an 0S Installation Profile:

1

From the Navigation pane, click Software > Operating Systems. The Operating Systems page
appears.

Click the name of the operating system that you want to edit. The Edit Operating System page
appears.

Select the Properties tab. You can modify the following settings:

* Name: Sets the display name for the operating system.

* Description: Provides a text description of the operating system.

*  Customer: Associates the operating system with a specific customer.

If you have 0S Sequence client permissions, you can change the Name and Description of 0S
Installation Profile in the SA Client.

Note that, you cannot change the customer association for an 0S Installation Profile.
Click Save.

Modifying How an 0S Is Installed on a Server — Linux/Unix

To modify the way an operating system is installed on Linux/Unix servers:

1

From the Navigation pane in the SAS Web Client, click Software > Operating Systems. The
Operating Systems page appears.

Click the name of the Linux/Unix operating system that you want to edit. The Edit Operating System
page appears.

Select the Installation tab.
Modify the following settings:

« Installation Media: (Required) Modify the MRL for the Linux/Unix operating system (select one
MRL from the pre-populated drop-down list).

See Creating Media Resource Locators (MRLs) on page 88 for more information on this topic.

*  Build Customization Script: (Optional) Customize the way the build process operates for that
Linux/Unix operating system (select a file from the popup window).

The way you can customize the build process is specific to each build script. You must follow the
requirements for build customization scripts to use this feature. Scripts appear in the popup
window after you upload them through the SAS Web Client.

See Creating Build Customization Scripts on page 124 for more information.
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Configuration File: (Required) Specify a JumpStart profile, Kickstart configuration file, or YaST2
autoinst.xml file to upload for use by OS Provisioning.

The file that you upload can have any file name, however, 0S Provisioning renames the file during
upload with a valid file name required by the vendor installation program.

Click Save.

Modifying How an Operating System Is Installed on a Server — Windows

Perform the following steps to modify the way an operating system is installed on Windows servers:

From the Navigation pane in the SAS Web Client, click Software > Operating Systems. The
Operating Systems page appears.

Click the name of the operating system that you want to edit. The Edit Operating System page
appears.

Select the Installation tab. The installation resources defined for the 0S Installation Profile appear.
You can modify the following settings:

Installation Media: Modify the MRL for the Windows operating system. Click Select and select an
operating system media from the list in the popup window.

Installation Options: If you selected WINPE when you created the Windows installation profile,
you can modify the following custom disk partitioning parameters:

Custom Disk Partitioning: The script you provide is passed to the Microsoft diskpart.exe
utility and is used during operating system installation. Refer to the Microsoft Windows
product documentation for more information.

If you leave this section blank, the following default values will be used:
rescan

select disk 0

clean
create partition primary
active
assign letter=C

Custom Disk Formatting: This script is executed directly onto the hard drive during
operating system installation. If you leave this section blank, the default values used are:

format.com C: /FS:NTFS /Q /Y /V:

Install Drive: Indicate which drive letter to install the Windows operating system on. The
default drive letter used is C.

Build Customization Script: Customizes the way the build process operates for that operating
system. Click Select and select a build customization package from the list in the popup window.

Scripts appear in the popup window after you upload them through the SAS Web Client.

Configuration File: Indicates the Windows response file to upload for use by 0S Provisioning.
Click Upload and enter the file name or browse to the file.

The file that you upload can have any file name. However, OS Provisioning renames the file with
the correct file name for use by the vendor installation program.



Hardware Signatures for Windows only: Defines the list of hardware that the operating system
supports. Click Add and select the hardware signature that you want to include in the 0S
Installation Profile.

Hardware signatures appear in the list box after a server with that selected make and model are
successfully built, so that it appears in the Managed Server list.

Click Save.

Modifying the 0S Installation Profile Packages

With the release of SA 10.0, you should add packages to an 0S Installation Profile using software policies
attached to 0S Sequences. This is because SAS 6.1 and later no longer attempts to automatically calculate
the list of packages to attach to the OS Installation Profile.

If you have upgraded from earlier releases, your existing 0S Installation Profiles for Solaris/SPARC and/or
Linux already have a list of packages attached. However, if you need to upload a new configuration file
(kickstart or jumpstart profile) with a different set of packages, you must create a new profile using the
Prepare 0S Wizard.

Note also, that when you provision 0S Sequences that you migrated from SA 5.x via the Run 0S Sequence
wizard, the 0S Installation Profile packages are no longer remediated. If you have manually attached
packages additional to the package list that was automatically generated when the profile was uploaded
to the OS Installation Profile, provisioning servers with an 0S Sequence referencing that 0S Installation
Profile do not install these extra packages. To insure that these packages are installed during provisioning,
you must add them to a Software Policy, attach that policy to the 0S Sequence, and enable remediation.

See Defining and Managing OS Installation Profiles on page 109 and Creating OS Sequences on
page 143 for more information.

The method described in this section is provided for those using versions of SA prior to 6.1
Perform the following steps to modify the packages that an 0S Installation Profile installs:

From the Navigation pane, click Software > Operating Systems. The Operating Systems page
appears.

Click the display name of the operating system that you want to edit. The Edit Operating System
page appears.

Select the Packages tab. The list of packages that the 0S Installation Profile installs appears.
Click Edit Packages. The Software Directly Attached page appears.

To add a package for installation, click Add Software and specify or search for the package that you
want to add to the list.

To remove packages, select them in the list and click Remove Software. The packages are deleted
from the list in the page but are not actually removed from the 0S Installation Profile until you click
Save Edits.

To change the order in which the packages are installed on servers, select the package that you want
installed in a different order and click the up or down arrows.

Click Save Edits.



Viewing Change History for an 0S Installation Profile

By default, OS Provisioning maintains information about the changes to 0S Installation Profiles for 180
days.

The following actions create an entry in the History of an OS Installation Profile:

*  The customer association is changed for the 0S Installation Profile.

* Aserver uses the 0S Installation Profile to install an operating system.

*  Packages are added to or removed from the Package List in the OS Installation Profile.

You can view the history of changes to an 0S Installation profile in the SAS Web Client and in the SA Client.

To view the history of changes to an 0S Installation Profile in the SAS Web Client, perform the following
steps:

1 From the Navigation pane, click Software > Operating Systems. The Operating Systems page
appears.

2 Click on the name of the operating system to review the history of its changes. The Edit Operating
System window appears.

3 Select the History tab. The list of events and changes appears.
To view the history of changes to an 0S Installation Profile in the SA Client, perform the following steps:
1 Launch the SA Client using one of the following methods:
*  From the Power Tools section of the SAS Web Client home page
*  From Start > All Programs > SA Client
2 From the Navigation pane, select Library > 0S Installation Profiles.
3 Browse an 0S Installation Profile and openit. The 0S Installation Profile window opens.

4 From the Navigation pane, select History. The Content pane shows the history of changes to the 0S
Installation Profile.

Deleting an 0S Installation Profile

If a server is currently using an 0S Installation Profile or an 0S Installation Profile is included in a template,
you cannot delete it.

To delete an 0OS Installation Profile, perform the following steps:

1 From the Navigation pane, click Software > Operating Systems. The Operating Systems page
appears.

2 Select the operating system that you want to delete.

3 Click Delete. (If a server has used the 0S Installation Profile or the OS Installation Profile is included in
a template, a warning message appears.)

The list of OS Installation Profiles re-appears.
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Configuring RAID on HP ProLiant Servers Before SA
Provisioning

You can configure disk mirroring and striping as part of the initial setup of an HP ProLiant server prior to
provisioning an operating system.

HP ProLiant RAID configuration requires having an HP ProLiant server configured with a baseline RAID
configuration that is captured to a software policy. The captured RAID configuration is then applied to a
server using the methods described in this section.

Supported Hardware

*  HP ProLiant Servers

Supported Operating Systems

Baseline HP ProLiant RAID Configuration Capture

HP ProLiant RAID configuration capture is supported by the following SA-provided boot images:
* Red Hat Enterprise Linux 5

*  Red Hat Enterprise Linux 6

¢ Red Hat Enterprise Linux 6 - 0GFS-based (for additional information about capturing HP ProLiant
RAID configuration using an 0S Build Plan, see the readme file provided with the baseline Red Hat
Enterprise Linux 6-based HP ProLiant RAID capture OS Build Plan)

¢ Microsoft Windows WinPE32, WinPE64, Winpe32-ogfs and Winpe64-ogfs (for additional information
about capturing HP ProLiant RAID configurations using an 0S Build Plan, see the readme file provided
with the baseline Windows WinPE32 or WinPE64 HP ProLiant RAID capture 0S Build Plans)

> Solaris (SPARC, x86) is not supported.

HP ProLiant RAID Provisioning

*  Linux 0S Sequences: HP ProLiant RAID provisioning can be performed on any SA-supported Linux
operating system that can be installed on HP ProLiant servers.

*  Windows 0S Sequences: HP ProLiant RAID provision can be performed on any SA-supported Windows
version that can be installed on HP ProLiant servers.

*  Linux 0S Build Plans: HP ProLiant RAID provisioning is supported for:
— Red Hat Enterprise 5
— Red Hat Enterprise 5 x64
— Red Hat Enterprise 6
— Red Hat Enterprise 6 x64

For additional information about provisioning HP ProLiant RAID configurations using OS Build Plans,
see the readme file provided with the baseline Red Hat Enterprise Linux 6-based HP ProLiant RAID
capture 0S Build Plans. The README is also available in the SA online help for OS Provisioning.

*  Windows 0S Build Plans: HP ProLiant RAID provisioning is supported for
— Windows Server 2003
— Windows Server 2003 x64
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— Windows Server 2008
— Windows Server 2008 x64
— Windows Server 2008 R2 x64

For additional information about provisioning HP ProLiant RAID configurations using OS Build Plans,
see the readme file provided with the baseline Windows WinPE32 or WinPE64 HP ProLiant RAID
capture 0S Build Plans.

> The Red Hat Enterprise Linux 5/ Linux 6 boot images (Red Hat enterprise Linux 5.6 and 6.0 base) use a
newer version of the Array Configuration Utility (ACU) tool. Therefore, HP ProLiant RAID configurations
captured using the Red Hat Enterprise Linux 5 boot image can be successfully deployed only on
unprovisioned servers that registered with the SA Core using the 1inux5/1inux6 boot images.
Deployment of an HP ProLiant RAID configuration captured with the 1inux5 (Red Hat Enterprise Linux 5
base) boot image to an unprovisioned server that registered with the SA Core using a different boot image
will fail due to differing ACU tool versions

HP also occasionally updates the ACU tool which, in rare cases, can cause RAID configurations captured by
an older version of the tool to be invalid. In these cases, you should rerun the RAID capture as described
below in order to update the RAID capture.

Capture a Baseline HP ProLiant RAID Configuration

In order to configure RAID for an HP ProLiant server, you must first capture a baseline HP ProLiant RAID
configuration that is saved into a RAID software policy that will be applied when provisioning new servers.
SA uses the HP SmartStart Array Configuration Utility to perform the capture. The utility is installed by the
SA installation.

To capture the RAID configuration, you must specify the custom attribute, raid.capture=1inthe server
record for the baseline HP RAID server which causes the server’s RAID configuration to be captured into
the software policy when it is booted into the SA Unprovisioned Server Pool.

You can do this in either of two ways:

a Use the Manage Boot Client (MBC) utility to create a server record for that server with the custom
attribute raid. capture=1 specified. See Managed Boot Clients on page 25 for information
on creating or modifying a server record with MBC.

b Reset the baseline HP RAID server to an SA Unprovisioned Server Pool to create the server record,
edit the server record in the SA Client to specify the custom attribute raid. capture=1, then
power the server off.

After the server record is created with the raid. capture=1 custom attribute, boot the server into the SA
Unprovisioned Server Pool so that the HP server's RAID configuration is captured in a software policy.
Before SA creates the RAID software policy, it first creates a containing folder which is automatically
named using the model number of the server for which the policy is to be created.
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If the RAID configuration is captured successfully, you see a message similar to Figure 12 in the
console.log file:

figure12  RAID Configuration Capture Message
B

File Edit Wiew Settings ‘Windomw Help

N

Captured RAID array configuration from 00:16:35:36:DC.57 %
RAID Policy ID/Mame: 14150001,/00:16:35:36:DC:57 RAID Capture
Opsware Library Path: RAID Paolicies/HP-ProLiant DL360 G4

0S Build Agent registered successfully. MAC: 00:16:35:3B:DC:37

IP: 172.20.250.152 Server |D: 110001

Lastupdated: 19:19:52 | |

By default, the software policy is given a name that consists of the server’s MAC address appended with
the words RAID Capture,suchas 00:16:35:3B:DC:97 RAID Capture. You can rename the file in
the SA Client. After the RAID configuration is captured, the value of the custom attribute raid. capture
is automatically set to “0”. This is to prevent unintended RAID captures from occurring for subsequent
booting of the server to the unprovisioned servers pool.

The value of a custom attribute, raid.version, is also set to one of the following values: 1inux,
linux4, 1inux5, or winpe. During an 0S Sequence job, if the raid.policy_idis set, SA compares the
raid.version value with the current server's version. If the values do not match, or the policy does not
have the raid.version custom attribute, a warning is logged to the log file indicating the versions
mismatch and that RAID deployment may fail. However, SA will attempt to continue the job.
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The software policy appears in the SA Client RAID Policies Library:
figure 13  RAID Policies Library in the SA Client
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At this point, to provision RAID servers, you must add a server record custom attribute,

raid.policy id=<value> for the unprovisioned server, specifying the RAID software policy Object ID
as the value. The captured baseline RAID configuration specified in the policy is then applied during
provisioning.

The RAID policy you specify for an 0S Sequence RAID deployment must be saved in the
/RAID Policies/Model Name folder. If the RAID policies are saved or moved to a different folder,
attempting an 0S Sequence RAID deployment will fail with a Software Policy not found error.

> The method described above is the only way to apply RAID policies. RAID policies must not be attached to
any objects, including unprovisioned servers, device groups, 0S Sequences, and so on.
> If SA fails to configure an HP RAID controller during a "Run 0S Sequence” job, a subsequent attempt to

capture the HP RAID controller configuration may fail with the following message:

RAID configuration deployment failed: Failed to deploy RAID configuration: An
error occurred while clearing current array configuration. Exit status: 1280
Error message from ACU: ERROR: (2821) No controllers detected.

This is due to a known issue in the HP ACU controller. In this case, you must manually configure the HP
RAID controller with a logical volume at server boot time.

Creating an HP ProLiant RAID Dynamic Server Group

After you have captured a baseline HP ProLiant RAID software policy, you can add a custom attribute,
raid.policy id=<value> (specifying the RAID software policy Object ID as the value) to a Dynamic
Device Group. Any unprovisioned server subsequently attached to that Device Group will have the HP
ProLiant RAID configuration applied when it is provisioned.

> Due to the way server records are inserted into Dynamic Server Groups, RAID capture may be skipped
when the server is inheriting the RAID configuration. In this case, you should manually specify the RAID
configuration policy in the server record. If the server is not yet in the SA Server Pool, you must reboot the
server.
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Manually Specifying an HP ProLiant RAID Configuration

You can write your own HP ProLiant RAID configuration file to be applied when a server is provisioned. To
do so, specify the raid.hpacu. script custom attribute in the server record. You can specify a
pre-written file for the script to use for configuration or open the editor in the server record and enter the
RAID configuration manually.

» The Windows SA Provisioning custom attribute argstringis not supported with 0S Build Plans.

Creating Build Customization Scripts

This section discusses the following topics:

+ Using Build Customization Scripts on page 124
+ Solaris Build Customization Scripts on page 125
+  Linux Build Customization Scripts on page 129

* Windows Build Customization Scripts on page 133

Using Build Customization Scripts

You can use operating system-specific build scripts to control the way each operating system is
provisioned. Build scripts allow you to manage each operating system installation from the network
connection to SA Agent installation.

0S Provisioning build scripts provide hooks into the build process that allow you to modify operating
system installations at specific points. These hooks call a single build customization script at the
appropriate time in the operating system installation process.

Because each build script is specific to the operating system it installs, build customization and
installation vary by operating system. Before you can use a build customization script as part of an 0S
Installation Profile, you need to create the build customization script and import it into the SA Client.

To import a build customization script into the SA Client, perform these tasks:

1 From the Navigation pane, select Library > Packages and By Folder view and then select an
operating system.

2 From the Actions menu, select Import 0S Utilities.

3 Inthe Import OS Utilities window, click Browse to select the build customization script. Note that,
dependent on the operating system, the customization script filename is expected to follow certain
conventions (for example, the Solaris/SPARC script must be a Bourne shell script and must be named
run). See the section for your operating system below for information about these conventions.

4 From the Customer list, select a customer to associate with the build customization script.

5 From the Platforms list, select an operating system platform to associate with the build
customization script.

6  Click Import.
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Later, when you are preparing an 0S Installation Profile you will have the opportunity to select a build
customization script to associate with the profile. Build customization scripts that you have imported as
described above appear in a list when you click Select.

See Defining an OS Installation Profile — Linux/Unix on page 109 or Defining an OS Installation Profile
— Windows on page 111 for more information.

Solaris Build Customization Scripts

This section describes creating build customization scripts for Sun Solaris.

The Sun Solaris Build Process

Itisimportant to understand the Solaris build process before you include a build customization script for a
Solaris installation profile. Table 6 details the exact steps that occur when you provision an installation
client with Solaris.

A user initiates the build process with Steps 1 and 5. The rest of the build process steps occur
automatically in OS Provisioning.

table 6 Sun Solaris Build Process

Phase Build Process Steps

Pre-installation 1 Auser boots the installation client over the network by entering the
following command in a console attached to the server:

boot net:dhcp - install

2 Theinstallation client boots from the network by using a Solaris 10
JumpStart miniroot (included as part of OS Provisioning), eventually
running a JumpStart begin script. The begin script is used to start the 0S
Build Agent.

3 The 0S Build Agent registers with the 0S Build Manager.

4 The Solaris build script probes the hardware configuration of the
installation client and registers it with SA. The installation client then
appears in the Server Pool list in the SAS Web Client.
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table 6 Sun Solaris Build Process (cont’d)

Phase Build Process Steps

Phase One 5 Inthe SAS Web Client, a user chooses to install an operating system on
an available installation client.

6 The Solaris build script mounts the Solaris installation media indicated by
the MRL in the 0S Installation Profile that the user selected.

7  The Solaris build script retrieves the profile associated with the selected
0S Installation Profile and copies it to $SI_PROFILE, the standard
JumpStart location for dynamic JumpStart profiles.

8 The Solaris build script executes the build customization script:
/sbin/sh run Pre-JumpStart

9  The Solaris build script validates the profile by using the JumpStart
installer (pfinstall) in test mode.

10 The Solaris build script causes the 0S Build Agent to run in the
background, allowing the JumpStart begin script to complete.

11 The JumpStartinstaller pfinstall command is invoked by the
JumpStart installer script and Solaris is installed. Concurrently, the 0S
Build Agent monitors the installation process. Feedback is displayed in
the SA Client.

12 The JumpStart installer pfinstall completes and runs the JumpStart
finish script, which indicates to 0S Provisioning that the operating
system installation is complete.

13 The build script executes the build customization script a second time:
/sbin/sh run Post-JumpStart

14 The installation client reboots.

Phase Two 15 On entering multiuser mode, the 0S Build Agent is invoked and it
contacts the OS Build Manager.

16 The Solaris build script executes the build customization script:
/sbin/sh run Pre-Agent

17 The Solaris build script installs the SA Agent.

18 The Solaris build script executes the build customization script:
/sbin/sh run Post-Agent

19 The Solaris build script exits and Phase Two finishes.

20 0S Provisioning takes over, causing a remediation of the selected
software to be installed onto the installation client.

See the SA User Guide: Audit and Compliance for more information on how remediation installs
software on servers.
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Requirements for Solaris Build Customization Scripts

Build customization script for Solaris must meet the following requirements:

You must create the script as a Bourne shell script and name it run.

You must include the run script in an archive file in tar .z format and include the script at the top
level of the archive. During OS Provisioning, the tar .z archive is unpacked on the installation client
and the script is processed by /sbin/sh.

You must be sure that the run script is unpacked in its own directory with the other files in the
archive. This directory serves as the current working directory when the run script is invoked. Based
on this fact, correctly refer to the other files in the archive. For example, unpacking and invoking the
run script follows this general process:

mkdir /var/tmp/inst_hook
cd /var/tmp/inst_hook

zcat hook.tar.Z | tar xf -
/sbin/sh run <stage>

You must create a script that cannot cause the installation client to drop its network connection (for
example, do not use the script to reboot the installation client or reconfigure the active network
interface). If the installation client drops its network connection, the 0S Provisioning process will fail.

You must create the run script so that it exits normally. If the script exits with a non-zero value, the
0S Provisioning process will end. However, the JumpStart process will continue when a
pre-installation hook fails (exits with a non-zero value). When creating the run script, you should
ensure that the JumpStart process does not continue when a pre-installation hook fails.

The run script should not take an exceptionally long time to complete, otherwise the 0S Provisioning
process might time out.

Solaris Provisioning from a Boot Server on a Red Hat/SLES 10 Linux Server

If you must provision a Solaris server and the Boot Server is hosted on a Red Hat Enterprise Linux or Suse
Linux Enterprise 10 server, you must disable NFS v3 on the Boot Server. If the Boot Server is on a Solaris
server, do not perform this action.

Disabling NFS v3 or NFS v4

To disable NFS v3, perform the following steps:

1

On the Boot Server host, create the following file:
/etc/sysconfig/nfs

In the newly created nfs file, add the following line:
MOUNTD_NFS_V3=no

Restart NFS:

/etc/init.d/nfs stop
/etc/init.d/nfs start

To disable NFS v4 on a Red Hat Linux Boot Server host, perform the following steps:

1

On the Boot Server host, create the following file:

/etc/sysconfig/nfs
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In the newly created nfs file, add the following lines:

MOUNTD_NFS_V3=no
MOUNTD_NFS_V2=yes
RPCNFSDARGS="'--no-nfs-version 4'

Restart NFS:

/etc/init.d/nfs stop
/etc/init.d/nfs start

To disable NFS v4 on an SLES 10 Boot Server host:

1

On the Boot Server host, create the following file:
/etc/sysconfig/nfs

In the newly created nfs file, add the following line:
NFS4_SUPPORT="no"

Restart NFS:

/etc/init.d/nfsserver stop
/etc/init.d/nfsserver start

Creating a Solaris Build Customization Script

You can customize a Solaris installation at multiple points using a build customization script. The
following list shows these points:

Pre-JumpStart: A pre-installation hook for the first stage.

During Phase One, the build customization script runs in the JumpStart environment. The script can
use all the standard JumpStart environment variables, such as

SI_PROFILE. All the environment variables associated with the standard JumpStart probe keywords
and values are set (for example, ST_DISKLIST, SI_HOSTADDRESS, and SI_MEMSIZE).

When the run script is invoked at the Pre-JumpStart point, it can perform any actions that a
JumpStart begin script would perform. For example, the script could modify the downloaded profile
before the operating system installation begins. At this point, the Solaris profile is downloaded from
0S Provisioning, but the profile has not been passed to the JumpStart server.

For the complete list of the environment variables, see the Solaris 9 Installation Guide.
Post-JumpStart: A post-installation hook for the first stage.

When the run script is invoked at the Post-JumpStart point, it can perform any actions that a
JumpStart £inish script would perform. One example would be to set custom eeprom settings. The
installation client’s file systems are available for modification at this point and are mounted on the /a
partition for the £inish script environment.

Pre-Agent: A pre-installation hook for the second stage.
Post-Agent: A post-installation hook for the second stage.

During Phase Two, the run script is executed after the installation client has rebooted. This is the
point when the system is up and running in multi-user mode with most services started.

The last 4K of output produced by the build customization script (stdout and stderr) appears in the
SAS Web Client output details for the operating system.
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Sample Solaris Build Customization Script

#!/sbin/sh
pre_jumpstart () {
#
# strip any partitioning information out of profile, and
# replace it with keywords to use default partitioning, but
# to size swap equal to the amount of physical RAM
#
cat $SI_PROFILE | grep -v partitioning | grep -v filesys > /tmp/profile.s$$
echo "partitioning default" >> /tmp/profile.$S
echo "filesys any $SI_MEMSIZE swap" >> /tmp/profile.$$
cp /tmp/profile.$$ $SI_PROFILE
rm -f /tmp/profile.s$S
}
post_jumpstart () {
#
# set local-mac-address eeprom setting
#
eeprom 'local-mac-address?=true'
}
pre_agent () {
# do nothing
}
post_agent () {
# do nothing
}
case "$1" in
Pre-JumpStart) pre_jumpstart ;;
Post-JumpStart) post_jumpstart ;;
Pre-Agent) pre_agent ;;
Post-Agent) post_agent ;;
esac

Linux Build Customization Scripts

A Linux build script runs a single installation hook that gives you the ability to customize the Linux build
process before Anaconda loads.

The installation hook is run in a RAM disk right before the installation program runs, but after the network
has been brought up.

Linux/Itanium Build Process

It is important to understand the Linux/Itanium build process before you include a build customization
script in a Linux/Itanium OS Installation Profile. Table 7 describes the exact steps that occur when you
provision an installation client with Red Hat Linux, Red Hat Linux Itanium or SUSE Linux.

A user initiates the build process with Steps 1 and 6 and the rest of the build process steps happen
automatically in OS Provisioning.
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Sample Solaris Build Customization Script

#!/sbin/sh
pre_jumpstart () {
#
# strip any partitioning information out of profile, and
# replace it with keywords to use default partitioning, but
# to size swap equal to the amount of physical RAM
#
cat $SI_PROFILE | grep -v partitioning | grep -v filesys > /tmp/profile.s$$
echo "partitioning default" >> /tmp/profile.$S
echo "filesys any $SI_MEMSIZE swap" >> /tmp/profile.$$
cp /tmp/profile.$$ $SI_PROFILE
rm -f /tmp/profile.s$S
}
post_jumpstart () {
#
# set local-mac-address eeprom setting
#
eeprom 'local-mac-address?=true'
}
pre_agent () {
# do nothing
}
post_agent () {
# do nothing
}
case "$1" in
Pre-JumpStart) pre_jumpstart ;;
Post-JumpStart) post_jumpstart ;;
Pre-Agent) pre_agent ;;
Post-Agent) post_agent ;;
esac

Linux Build Customization Scripts

A Linux build script runs a single installation hook that gives you the ability to customize the Linux build
process before Anaconda loads.

The installation hook is run in a RAM disk right before the installation program runs, but after the network
has been brought up.

Linux/Itanium Build Process

It is important to understand the Linux/Itanium build process before you include a build customization
script in a Linux/Itanium OS Installation Profile. Table 7 describes the exact steps that occur when you
provision an installation client with Red Hat Linux, Red Hat Linux Itanium or SUSE Linux.

A user initiates the build process with Steps 1 and 6 and the rest of the build process steps happen
automatically in OS Provisioning.
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The build process for Red Hat Linux Itanium and VMware ESX follows the same process as the Linux build

process.
table?7 Linux Build Process
Phase Build Process Steps

Pre-installation

1
2

A user boots the installation client from PXE or the Linux Boot CD ROM.

The installation client loads a standard Red Hat boot image and mounts
the second stage image specified by the kernel parameters.

Note: During a PXE boot, the Build Agent is called from the kickstart file.
When a CD install is specified, Anaconda is replaced by a custom SA script
that is used to invoke the 0S Build Agent.

The 0S Build Agent registers with the Build Manager.

The Linux build script probes the hardware configuration of the
installation client and registers it with SA, causing the installation client
to appear in the Server Pool list in the SAS Web Client.

Phase One

10

In the SAS Web Client, a user selects the target version of Linux to install
on the installation client.

The Linux build script creates a small partition at the beginning of the
disk and copies the target boot image from the Boot Server to this
partition.

The Linux build script copies GRUB or ELILO onto the partition and installs
itinto the MBR.

The Linux build script configures GRUB or ELILO to boot this partition, and
kernel arguments are set to do an NFS installation on the location
indicated by the MRL.

If the Custom Attribute kernel_arguments is set for the 0S
Installation Profile, these kernel arguments are appended.

The 0S Build Agent exits and the server reboots.

Phase Two

n
12

13

14
15

16

17

The target boot image loads and runs the 0S Build Agent.

The Linux build script verifies that the media indicated by the MRL is the
same version as the boot image under which it is running.

The Linux build script writes the configuration file defined by the MRL to
the disk.

If it exists, the Linux build script runs the build customization script.

The Linux build script runs in the background. The 0S Build Agent and
Anaconda starts. The Linux installation starts normally by using the
configuration file written to the disk. Concurrently, the 0S Build Agent
monitors the installation process providing feedback, which is displayed
in the SA Client.

After all packages have been installed, the 0S Build Agent copies the SA
Agent Installer and the 0S Build Agent to the server and setsupan init
script to start the 0S Build Agent after the reboot.

When the operating system installation completes, Anaconda reboots
the installation client, which boots from the newly installed operating
system.
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table 7 Linux Build Process (cont’d)

Phase Build Process Steps
Phase Three 18  On entering multi-user mode, the 0S Build Agent is invoked and contacts
the 0S Build Manager.

19 The Linux build script installs the SA Agent.
20 The Linux build script exits.

The operating system installation section of provisioning is complete.

Requirements for Linux Build Customization Scripts

To use a build customization script for Linux, you must meet the following requirements:
*  You must create an executable script and name it run.

*  You must include the run script in an archive file in tar. gz format and include the script at the top
level of the archive. During OS Provisioning, the tar . gz archive is unpacked on the installation client
and the script is executed.

*  You must unpack the run script in its own directory with the other files in the archive. This directory
serves as the current working directory when the run script is invoked. Based on this fact, correctly
refer to the other files in the archive. For example, unpacking and invoking the run script follows this
general process:

mkdir /tmp/installhook
cd /tmp/installhook
tar -xzf hook.tgz
./run 2>&1

*  You must ensure that the run script does not take an exceptionally long time to complete, otherwise
the 0S Provisioning process might time out.

*  You must ensure that the run script exits normally. If the script exits with a non-zero value, the 0S
Provisioning process ends.

*  You must ensure that the run script has execute permissions to function properly.

VMware ESX Build Process

The VMware ESX build process follows the same general steps as the Linux build process.

The main difference between the VMware ESX and Linux is that VMware ESX ships by default with an
iptables firewall that will block communication between the core and the mini-agent and agent. In
order for the mini-agent to work correctly, build scripts add firewall rules and these rules allow the traffic
needed for the mini-agent to function. The agent for VMware ESX is also enhanced to manage the
necessary allow rules, which enables the flow of communication between the SA Agent and core.

The rest of the VMware ESX build process follows the same process as the Linux build process. For more
information, see Linux/ltanium Build Process on page 129.

VMware ESX Build Customization Scripts

The VMware ESX build script runs a single installation hook that gives you the ability to customize the
VMware ESX build process before Anaconda loads.

The installation hook is run in a RAM disk right before the installation program runs, but after the network
has been brought up.
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Windows Build Customization Scripts

This section describes creating build customization scripts for Microsoft Windows.

Windows Build Process (WinPE Boot Image)

> In order to perform PXE booting of a VMware ESX Windows Server 2003 x86 or x86_64 VM using WinPE,
the minimum required RAM is 512MB (higher than the VMware recommended RAM minimum).

Table 8 details the steps that occur when you provision an installation client with Windows WinPE.

A user initiates the build process with Steps 1 and 6. The rest of the build process steps happen
automatically in OS Provisioning.

table 8 Microsoft Windows Build Process (WinPE)

Phase

Build Process Steps

Pre-installation

1

A user boots an installation client over the network by using a PXE
network bootstrap program or by using the WinPE.

2 The user can install either WinPE x86 32 bit or WinPE x64 64 bit
pre-installation environment.

3 PXE boots the Windows 0S Build Agent over the network.
When using the WinPE pre-installation environment, you will not be
prompted to create a disk partition.

4 The 0S Build Agent collects pertinent hardware information and registers
the information with SA.
The server is ready to be provisioned and is available for selection from
the Server Pool in the SAS Web Client.

Phase One 5 Theuser selects a Windows server from the Server Pool list in the SAS
Web Client and assigns a Windows 0S Installation Profile or a Windows
template to the server.

6  The Windows build script mounts the Windows installation media as
indicated by the Media Resource Location (MRL).

7  The Windows build script initiates a Windows unattended setup.

8  The Windows build script waits for a Windows unattended setup to
complete and Windows to boot for the first time.

Phase Two 9  Windows boots for the first time.

10 If a build customization script was specified in the 0S Installation Profile,

1

it is executed by the Windows build script.
The Windows build script installs the Agent.

The Windows build script exits and Phase Two is complete.
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Legacy Build Customization Script run.bat

In previous releases of SA, 0S Provisioning supported a single hook script named run.bat. If you choose
to use this legacy script, it will still work, but it will only call the Pre-Agent hook.

For example, if the cabinet file does NOT contain a runphase.bat script at the root level, but it DOES
contain a run.bat script at the top level, it will be treated as a legacy single-hook script. It will NOT be run
at the “Pre-Copy” phase. It is run only at the Pre-Agent phase with no command line arguments.

If the cabinet file contains both runphase.bat and run.bat, it will still be treated as multi-phase and
run.bat will be ignored.

Creating a Windows Build Customization Script (WinPE)

Windows WinPE customization scripts support the following installation hooks:

Pre-Partition
Pre-ShareConnect
Pre-Copy
Post-Copy
Pre-Reboot
Pre-Agent
Post-Agent

The following conventions also apply:

WinPE Windows build customizations must be in the form of a zip file.

There must be a run . cmd script in the root of the zip file. See the example run . cmd below.
Hooks are unpacked in $systemdrive$\opswba\hook (for example, x : \opswba\hook).
— Hooks are unpacked recursively and will overwrite existing files.

— Hooks are transferred and unpacked only once during the initial phase. Subsequent runs do not
require unpacking. Hooks will be transferred and unpacked again after reboots (for example,
before Pre-Agent), at which point they are unpacked in $systemdrive%\opswba\hook
(typically ¢ : \opswba\hook).

— When hooks are executed, the current directory will be the root directory of the unpacked zip file.

In order to identify which phase of the build customization is being run, the build scripts pass a single
command line argument to the run . cmd script, matching the name of the hook phase (Pre-Copy,
Post-Copy, etc.). See the example run . cmd below.

The build interprets a non-zero return code from a customization (hook) phase as a fatal error.
Therefore, ensure that the appropriate code is returned. In the event of a fatal error, the directory in
which the build customization was unpacked will be left as is (to aid in debugging). This type of error is
one of the few errors during the early phases of the provisioning process from which auto-recovery is
not possible.

Any output from the build customization (hook) phase will be recorded in the build log. Therefore, it is
important to ensure that no inappropriately sensitive information is contained in the output.

Upon completion of the last build customization hook (Post-Agent), the hook directory will be forcibly
deleted along with all it's contents.
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After running each hook, buildscripts look for a file called $temp %\ skipnextstep. If this file
exists, it will be deleted and the next step of the provisioning will be bypassed. The following is what
is bypassed for each build customization phase if the skipnextstep file exists:

Pre-Partition

- skips partitioning and formatting

Pre-ShareConnect

-~ skips connecting Z: to the media server share
Pre-Copy

- skips launching the build and monitoring it altogether
Post-Copy

- skips copying the Agent and installing the boot agent (not recommended)
Pre-Reboot

- skips the reboot (not recommended)

Pre-Agent

- skips the agent install

Post-Agent

- skipnextstep has no effect (the file will be deleted)

Sample run.cmd File

This section shows a sample, minimal run.cmd. This sample simply echoes to the console for each hook
phase. To manually test this hook from a command shell, execute it using:

cmd /c run.cmd

which mimics the build agent environment as closely as possible (and prevents an “exit” in the script from
causing an exit from your command shell).

@echo off
if x%1

== xPre-Partition (
call :PrePartition

) else if x%1 == xPre-ShareConnect (
call :PreShareConnect
) else if x%1 == xPre-Copy (
call :PreCopy
) else if x%1 == xPost-Copy (
call :PostCopy
) else if x%1 == xPre-Reboot (
call :PreReboot
) else if x%1 == xPre-Agent (
call :PreAgent
) else if x%1 == xPost-Agent (
call :PostAgent
)
goto :end
:PrePartition
echo We are in the Pre-Partition hook phase
exit 0
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: PreShareConnect
echo We are in the Pre-ShareConnect hook phase
exit 0

:PreCopy
echo We are in the Pre-Copy hook phase
exit 0

:PostCopy
echo We are in the Post-Copy hook phase
exit 0

: PreReboot
echo We are in the Pre-Reboot hook phase
exit 0

:PreAgent
echo We are in the Pre-Agent hook phase
exit 0

:PostAgent
echo We are in the Post-Agent hook phase

exit 0

:end

Defining Custom Attributes

This section discusses the following topics:

«  Custom Attributes for Sun Solaris 10 and 11 on page 137

«  Custom Attributes for Linux or VMware ESX on page 138

«  Custom Attributes for Microsoft Windows on page 141

« Adding Custom Attributes to OS Installation Profile (SAS Web Client) on page 142

« Adding Custom Attributes to OS Installation Profile (SA Client) on page 142

In addition to the customization provided by using build customization scripts, each build script uses
custom attributes.

The SAS Web Client and SA Client provide a data management function by allowing users to set custom
attributes for servers. These custom attributes include setting miscellaneous parameters and named data
values. Users can write scripts that use these parameters and data values when performing a variety of
functions, including network and server configuration, notifications, and CRON script configuration.

See Adding Custom Attributes to OS Installation Profile (SAS Web Client) on page 142.

For OS Provisioning, SA uses custom attributes to pass specific information to each build script to
configure the installation process.

You can edit an 0S Installation Profile to override the default values used by the build process. You
override these default values by setting custom attributes for the 0S Installation Profile.
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See Adding Custom Attributes to OS Installation Profile (SAS Web Client) and Adding Custom
Attributes to OS Installation Profile (SA Client) on page 142 for specific steps required to set custom
attributes for an 0S Installation Profile.

Custom Attributes for Sun Solaris 10 and 11

The build script for Solaris 0S Provisioning uses a number of custom attributes. Several of these custom
attributes correlate with an equivalent setting that would be defined normally by a Solaris sysidcfg

file.

You cannot modify the sysidcfgfile that OS Provisioning uses. However, you can override specific values
specified in the default sysidcfgfile. You can set custom attributes for a Solaris 0S Installation Profile in

the SAS Web Client.

The custom attributes correspond to the equivalent keywords in the sysidcfg file. See Table 9.

table 9 Sun Solaris 10 and 11 Custom Attributes

Keyword

Description

archive_location

NFS path to a Flash Archive (f1ar) to use instead of operating system media.

Example Value: nfs: //mediaserver.company.com
/flars/sunos5.10_basic.flar

boot_options

Solaris kernel parameters. These can be found in
/boot/grub/menu. lst on X86, as EEPROM values on SPARC machine
systems, or bootenv.rc.

Example Value: Values will vary, see your Solaris documentation.

reboot_command

The command the 0S Build Agent uses to issue a reboot during Solaris SPARC
reprovisioning. The custom attribute value is not the entire command, rather
it is the next boot command for the Open Boot PROM. The full command is
/usr/sbin/reboot -1 -- 'met:dhcp - install,
onlynet:dhcp - install isreplaced by the reboot_command value.

Example Value: net2:dhcp - install

root_password

Sets the encrypted value for the password on an installation client. One way
to obtain an encrypted value is by using
Jetc/shadow.

If a value is not set, the system will not have a root password.

Example Value: Field 2 from the /et c/shadow file

timezone

Sets the time zone for the configuration of the installation client (sets TZ in /
etc/default/init). The directories and files in the directory /usr/share/lib/
zoneinfo provide the valid time zone values.

By default, the time zone value is UTC.

For example, the time zone value for Pacific Standard Time in the United
States is US/Pacific. You can also specify any valid Olson time zone.

Example Value: Any value in the
/usr/share/lib/zoneinfo directory on a solaris server.
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table9 Sun Solaris 10 and 11 Custom Attributes (cont’d)

Keyword

Description

system_locale

Sets the language for the configuration of the installation client (sets LANG in
[etc/default/init). Valid locale values are installed in /usr/lib/locale. If you set
this attribute, you should also use the locale keyword in the operating system
profile so that the appropriate locale is installed.

By default, the value for this keyword is system_local=C.

Example Value: "C", "en_US.UTF-8","ja_JP.UTF-8".

See http://developers.sun.com/dev/gadc/faq/locale.html

required_patches

No longer supported.

nfsv4d domain

Sets the system’s default NFS version 4 domain name. This value is
substituted into /etc/default/nfs next to
"NFSMAPID_DOMAIN=.

If this value is not set, 0S Provisioning suppresses the prompt to confirm the
NFS version 4 domain name when the server starts the first time.

Example Value: company . com

mrl (Solaris 11) The MRL created by the import_media script. This is useful
when you want to use an external repository.
http_proxy (Solaris 11) Specify when you use HTTP repositories.

enable root_user

(Solaris 11) Solaris 11 allows root to be defined as arole in the sc.xm1 file.

Presence of this custom attribute will trigger the user creation, even if 'no'
value is set.

hostname

Specifies the hostname of the machine.

Custom Attributes for Linux or VMware ESX

You can use custom attributes to specify additional arguments to the kernel where the installation is

running.

Setting a custom attribute for the 0S Installation Profile requires that you edit the 0S Installation Profile
and select the Custom Attributes tab. The custom attribute must have the name, kernel_arguments.

The kernel arguments are separated by spaces (like they are when you type them after the boot prompt
for the CD-ROM or DVD). For example:

name=value jones=barbi

To have the kernel arguments persist after the base operating systemis installed, you must set them in
the uploaded configuration file. Setting kernel arguments by using custom attributes only allows you to
create a completely automated installation (as if you were installing the operating system from CD-ROM

or DVD).
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Although custom attributes are provided with a default value, you must ensure that the values are valid
for your system before proceeding.

table 10 Linux or VMware ESX Custom Attributes

Keyword Description

boot_disk Values: A raw device name without "/dev/" such as "sda", "hdc",
"cciss/c0dl”

boot_kernel Values: "rhel30", "rhel40", "rhel50", "rehl60", "rhel3ia",

"rheldia", "rhelbia"

Note: This custom attribute is used only for reprovisioning. The value of this
custom attribute specifies the type of kernel the server boots to during
reprovisioning.

hpsa_netconfig Created after using non-DHCP to boot the target server into the
Unprovisioned Servers list.

kernel_arguments Values: "noapci", "root=LABEL=/", "quiet", "splash"

ksdevice Values: MAC address of the NIC

(Linux pxe boot) Note: This custom attribute is used in the Media Boot Client (MBC) to create a

server record. The Server Browser of this device has the following custom

attribute:
kernel_arguments =ksdevice=mac address
ksdevice mac address

When powering on and PXE booting a device, you do not need to specify the
kickstart device.

ksdevice Values: bootif
(1inuxs5, linux6) Default:
ksdevice=bootif

Use for all Linux PXE types (including 1inux5, 1inux6) to prevent prompting
for the Kickstart device when booting a multiple NIC server into the
Unprovisioned Server pool.

nfs_opts Use --opts to specify NFS options in the ks . cfg. (when provisioning Red
Hat Enterprise Linux 5 or later).

For example:

nfs --server <Server IP> --dir <media dirctor> --opts
<nfs options>

For example, to contain a comma delimited set of values the same as the NFS
values allowed in /etc/fstab, create a custom attribute nfs_opts with
thevalue "rsize=32768,wsize=32768".

timeout Values: the number of minutes to wait for Linux provisioning to complete
before timing out.

Default: 30 minutes

If Linux provisioning fails because the job takes too long to complete, you can
specify a longer timeout period.
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Using the boot_disk Custom Attribute to Specify the Boot Drive

For certain servers you may need to specify the correct boot disk using the boot_disk custom attribute.
Table 10 describes the usage for the boot_disk custom attribute.

SA uses the values specified with the boot_disk custom attribute to determine which disk to partition,
format, and install the Assisted Installer image on.

» The device you select must be configured as the first internal boot device in the BIOS.
If the value of the boot_disk custom attribute is not found to exist on the hardware, SA logs a message
and reverts to the original disk selection logic.

Sample ks.cfg File

The boot_disk custom attribute requires certain modifications to your Kickstart file in order to function
properly. The following is a sample ks . cfg file for use with Red Hat Linux AS 4:

#Red Hat Kickstart Answer File
#Validated for use with Opsware
#This file supports a non-default boot_disk

#VERSION: 1.1 20080804

auth

bootloader --driveorder=@.boot_disk@

clearpart --drives=@.boot_disk@ --initlabel

part / --ondrive=@.boot_disk@ --asprimary --size=500 --grow
part swap --asprimary --size=250 --ondrive=@.boot_disk@
keyboard us

lang en US.UTF-8

langsupport --default en_ US.UTF-8 en_ US.UTF-8

reboot #require by OPSW

rootpw password

text

timezone --utc UTC

#Required for opsware

firewall --disabled

$packages

@base

Spre

#OK, the purpose of this is to initialize all partition tables

#If anaconda finds a completely new raw disk or any disk with an #invalid
partition table, it goes interactive. This makes sure

#anaconda continues unattended

for D in ‘sfdisk -1 2>/dev/null | grep "unrecognized partition" | cut -d : -f
1| tr -4 " "|xargs’
do

echo "Found an uninitialized partition table on ${D} according to sfdisk.
Adding a new empty partition table"

printf ";\n;\n;\n;\ny\n" | sfdisk --DOS --force "${D}" > /dev/null 2>&l
done
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Custom Attributes for Microsoft Windows

For a Windows OS Installation Profile, you can set various Windows operating system custom attributes
that allow you to replace or insert values inside the unattend. txt file during the operating system
installation process. At install-time, the resolved value of the custom attribute is inserted into
unattend. txt.

For example, if you do not have AdminPassword=Foo in your unattend. txt file, but you do have it
added as a custom attribute, 0S Provisioning will automatically add AdminPassword=CustAttrvalue
atinstall time.

For more information on how to add custom attributes, see Adding Custom Attributes to OS Installation
Profile (SAS Web Client) on page 142 or Adding Custom Attributes to OS Installation Profile (SA Client)
on page 142.

Refer to Microsoft documentation for syntax and valid values. Unless otherwise noted in the table, there
are no default values for these attributes if they are not set.

table 11 Windows Custom Attributes for 0S Provisioning

Corresponding
Keyword unattendtxt Attribute | Description

AdminPassword [GuiUnattended]/ This option sets the Administrator password
AdminPassword for the Admin account.

AGENT_INSTALL_DELAY Allows you to introduce a delay after
provisioning a system that allows the build
scripts to wait before starting to install the
agent.

Default: 30 seconds

argstring None String value that is used to compose the
command line arguments for the Agent
installer.

auto_partition Used by consoleless to indicate that instead of
requiring interactive user confirmation before
partitioning the disk, partition the disk
automatically.

ComputerName [UserDatal/ This value is not validated by SA. This custom
ComputerName attribute should only be set on the Server, but
SA does not prevent you from setting the
attribute anywhere. The default value is an
SA-generated random string.

hpsa_netconfig None Created after using non-DHCP to boot the
target server into the Unprovisioned Servers
list.

imageexec None Command to apply legacy image-based
provisioning image. This supports traditional
imaging tools such as Symantec Ghost™.
However, using the built in support for WIM
images is strongly encouraged.
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table 11 Windows Custom Attributes for 0S Provisioning (cont’d)

Corresponding
Keyword unattendtxt Attribute | Description

imagefile None Path to a server image file. This supports
traditional imaging tools such as Symantec
Ghost™. However, using the built in support for
WIM images is strongly encouraged.

imageshare None Share with image file to install. This supports
traditional imaging tools such as Symantec
Ghost™. However, using the built in support for
WIM images is strongly encouraged.

ProductKey [UserDatal/ProductKey | This value is not validated by SA.

timeout None An integer value in minutes that the Windows
Setup will timeout. Default is 120 minutes. If
Windows setup does not complete in the
specified amount of time, the operating system
installation fails with a timeout error.

Adding Custom Attributes to 0S Installation Profile (SAS Web Client)

Perform the following steps to add custom attributes to an 0S Installation Profile in the SAS Web Client:

1 From the Navigation pane inside the SAS Web Client, click Software > Operating Systems. The
Operating Systems page appears.

2 Click the name of the operating system that you want to edit. The Edit Operating System page
appears.

3 Select the Custom Attributes tab. The list of custom attributes specified for the 0S Installation Profile
appearsl.

If the OS Installation Profile contains custom attributes, the Edit Custom Attributes button appears on
the page. Click Edit Custom Attributes to add new attributes and edit existing ones.

4 Click Add Custom Attribute.
5  Enter a name and a value for the custom attribute.

6  Click Save. The list of custom attributes set for the 0S Installation Profile reappears. The new custom
attribute is added to the list.

Adding Custom Attributes to 0S Installation Profile (SA Client)

To add custom attributes to an 0S Installation Profile in the SA Client, perform the following steps:
1 Launch the SA Client using one of the following methods:

— SAS Web Client home page: From the Power Tools section

— SAS Web Client Menu: From Start > All Programs > SA Client

2 Frominside the SAS Web Client, from the Navigation pane, select Library >
0S Installation Profiles. Ensure that you have selected the By Type tab.

3 Browse to an 0S Installation Profile and open it. The 0S Installation Profile window opens.
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In the 0S Installation Profile window, select Custom Attributes from the Views pane.
In the Content pane, click Add to add a custom attribute.

In the Name column, double-click a cell in the table and type a custom attribute name.

N o0 o b

In the Value column, double-click a cell in the table and type a custom attribute value. If you would

like to enter a longer value, click [: to open a window that allows you to enter a longer value.

8 To delete a custom attribute, select it and click Delete.

Creating 0S Sequences

An 0S Sequence defines what to install on a server, such as operating system configuration information
taken from an OS Installation Profile that you specify, software and patch policies, and the target servers
on which to install the operating system.

> When you create an 0S Sequence, it is saved into the Folder list in the Library. You must have permissions
to the folder where you want to save the 0S Sequence. For more information on how folder permissions
work, see “User and Group Setup and Security” in the
SA Administration Guide.

0S Sequence Contents

You can specify the following in an 0S Sequence:

*  Properties: Allows you to name the 0S Sequence and choose a location to saveit in a library folder.
You must have permissions to write to the folder where you save the 0S Sequence, otherwise you will
be unable to save it in the selected location in the library.

* Install 0S: Allows you to choose an 0S Installation Profile. If the 0S Installation Profile already has a
customer associated with it, you will be unable to select a customer for the 0S Sequence. If it does not
have a customer associated with it, then you can select one here. Once you choose a customer, then
all servers on which you install the operating system using this 0S Sequence will be associated with
that customer.

Attach Patch Policies is available for Windows and Solaris 0S Sequences.
For more sbout information Patch Management, see the SA User Guide: Server Patching.

*  Attach Device Group: Allows you to select a device group (group of servers) for a the server once the
0S Sequence has been run. You can select any public static group to attach to the 0S Sequence.

A group of servers can also have software and patch policies associated with it. If you enable
remediation in the 0S Sequence (in Remediate Policies), then all software and patches associated
with the group of servers will also be installed on the server when you run the 0S Sequence. If you
disable remediation, then none of the software or patches in the policies attached to the group of
servers will be installed on the server.

For information on device groups, see Server Management in the User’s Guide: Server Automation.

*  Remediate Polices: Allows you to choose to enable or disable remediation when the server is
provisioned with the 0S Sequence. The Default is Disabled.

When remediation is disabled, running an 0S Sequence installs the operating system however no
policies in the 0S Sequence are remediated —that is, no software or patches in any of the policies
attached to the 0S Sequence are installed when the sequence is run.
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If you enable remediation, then all software and patches in all policies attached to the server will be
installed when the 0S Sequence is run. This is also true for any policies attached to the group of
servers selected for the 0S Sequence. You can also set reboot and pre and post installation script
options.

>» In order to perform OS Provisioning with remediation, you must have at minimum read access to all server
module policies.

Defining an 0S Sequence

To create an 0S Sequence, perform the following steps:
In the SA Client, from the Navigation pane, select Library and then select 0S Sequences.
Choose an 0S folder.
From the Actions menu, select New...

In the Views pane of the 0S Sequence window, select Properties and enter a name for the 0S
Sequence.

Click Change in the Content pane to choose a location in the folder library to save the 0S Sequence.
You must have permissions to write to the folder where you save the 0S Sequence.

From the Views pane, click Tasks then Install 0S to choose an 0S Installation Profile.

If the OS Installation Profile does not have a customer associated with it, then select a customer from
the Assign Customer drop-down list. If the OS Installation Profile already has a customer associated
with it, you will be unable to select a customer for the 0S Sequence. All servers provisioned with this
0S Installation Profile will be associated with the specified customer (if a customer has been
assigned).

From the Views pane, select Attach Software Policy.

At the bottom of the Content pane, click Add and select a software policy to add to the 0S Sequence.
From the Views pane, select Attach Patch Policies.

At the bottom of the Content pane, click Add and select a patch policy to add to the 0S Sequence.
From the Views pane, select Attach Device Group.

At the bottom of the Content pane, click Add. Select a device group to place the server into, after the
0S Sequence has been run. You can only select a public static group for this option.

From the Views pane, select Remediate Polices.

In the Content pane, choose to enable or disable remediation when the server is provisioned with the
0S Sequence. If you select Disable Remediation, then when you run the 0S Sequence, the operating
system will be installed but no policies in the 0S Sequence will be remediated — this means that no
software in any of the policies attached to the 0S Sequence will be installed when the sequence is run.

If you select Enable Remediation, then you will need to configure the Rebooting and Scripts
parameters. For the rebooting options, you can select one of the following:

Reboot servers as dictated by properties on each installed item: Selecting this option will allow
any reboot settings to run that might be set in any software or patch policies attached to the 0S
Sequence.

Hold all server reboots until after all items are installed: This option will override any
pre-install reboot options that might be set in any software or patch policies attached to the 0S
Sequence. If any post-install reboots have been set, then they will execute after the operating
system has been installed.
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* Suppress all server reboots: This option will override reboot options set in any software or patch
policies attached to the 0S Sequence.

Next, in the Scripts section, select either a Pre-Install/Post-Install Script. These tabs allow you to set a
pre- or post-install script to be executed before the 0S Sequence has been run and after the operating
system has been installed. Click Enable Script to enable a the script parameters.

From the Select drop-down list, select either Saved Script or Ad Hoc Script. Each script type has its
own settings:

Saved Script
* Command: Add any commands or arguments to be executed here.

*  Script Timeout: Enter a numerical value for the number of minutes to pass until the script will
timeout.

* User: Enter a user name and password, or choose to run the script as Local System. (If using Unix,
choose root as the user.)

* Error: Select if you want the 0S Sequence job to stop if the script returns an error.
Ad Hoc Script
*  Type: Choose UNIX shell for Unix systems, or for Windows, select BAT or VBSCRIPT.

*  Script: Enter the text of the script. An Ad-Hoc script runs only for this operation and is not saved
in SA. In the Script box, enter the contents of the script.

¢ Command: If the script requires command-line flags, enter the flags here.

*  Script Timeout: Enter a numerical value for the number of minutes to pass until the script will
timeout.

»  User: Enter a user name and password, or choose to run the script as Local System account. (If
using Unix, choose root as the user.)

* Error: Select if you want the 0S Sequence job to stop if the script returns an error.

When you have finished making your selections, from the File menu, select Save to save the 0S
Sequence.

The Manage Boot Clients (MBC) Option

The Manage Boot Clients (MBC) option provides several services. You can:

Remotely boot a server. You do not need console access to the server.
Pre-create server records.

Create custom attributes that set server configuration during OS Provisioning.
Reconfigure services like DHCP when new servers are provisioned.

Initiate OS Provisioning with either an 0S Build Plan or an 0S Sequence from a portal or an automated
script where, typically, the user will not be available for interactive responses.

For example, you can change the default PXE image that a server uses to boot, change whether a server is
assigned a DHCP lease, or specify the DHCP IP that is assigned to the server. You can also change a server’s
behavior when it enters the server pool, such as automatically invoking an 0S Sequence when it enters the
pool.
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If the server is an HP ProLiant server withiLO2, 3 or 4 enabled, and you know its iLO information, MBC can
also remotely power on the server.

Any user, such as a system administrator who performs 0S Provisioning and who is responsible for the
base operating system, system utilities, patching, and the hand off of servers to internal business units,
will find MBC quite useful.

You can access MBC functionality:
From the SA Client
From the Global File System command line
From a script

From a browser/portal form

Requirements

The 0S Provisioning infrastructure relies on SA Boot Server services for the MBC extensions.
The 0S Provisioning boot images must be served by the TFTP server that is shipped with SA.
In order to take advantage of the DHCP reconfiguration feature, you must use the SA DHCP server.

On a newly installed SA Core, a new user prior to running the MBC Web APX must first be granted
Launch Global Shell permissions and must log in to the OGSH at least once in order to initialize the
user environment (so that MBC can write temporary files to the user’s home directories during use).

Required Permissions

In order to execute MBC, a user must have the Allow Execute OS Build Plan or Allow Execute 0S Sequence,
Managed Server and Groups, Manage Customers, Server Pool, Read & Write permission to customer Not
Assigned and Allow Configuration of Network Booting permissions, write access to all pre-existing servers
they will act on, and permissions to run the MBC APXs (thus, they need execute access on the /Opsware/
Tools/0OS Provisioning/Manage Boot Clients folder).

ForiLOZ2, 3 or 4 integration, the user must have Manage iLo and Execute iLo operations permissions.

Installation

The SA Installer creates the MBC APXs during the SA Core installation. The installer creates a folder
containing the MBC APXs in the SAS Web Client Library, and adds an MBC Configuration Software Policy as
part of the baseline data.

The following four APXs are installed for MBC:
Program APX
Web APX
Integration Hook APX
DHCP Cleanup Web APX



Using the Manage Boot Clients (MBC) Option

When MBC runs, it creates new server record(s) in the SA database in the Planned lifecycle. These records
are displayed with a blueprinticon and can optionally have custom attributes assigned to them. Some of
these custom attributes change how SA handles a server or configuration of an operating system
installation (for example, you can set the ComputerName for a Windows unattended installation).

Executing MBC typically changes the default PXE menu choice when the server PXE boots, so that you are
not required to choose a PXE image from the console of the server that is booting up. MBC also allows you
to associate an 0S Build Plan or an 0S Sequence with the server record so that, when the server registers
as an unprovisioned server with SA, a provisioning job starts automatically.

Running an MBC APX

You can launch MBC Web APXs in three ways:
From the SA Client
* Select Library > Extensions > Web > Manage Boot Clients Web APX.

e or, from the Unprovisioned Servers list, right click in the server list pane (not directly on a server) and
select Manage Boot Clients.

From a Browser

You can also use a browser and navigate to:
https://occ.example.com/webapp/osprov.manage_boot_clients_web/

where occ. example. comis the local hostname or IP address for your SA Core.

The browser interface allows you to chose whether to use a form to input data for a singular host, or
whether to input a CSV to set up multiple server records. After clicking the Submit button, it is grayed out
to prevent double-submissions and a combined Progress/Results page is displayed.

The MBC Form-Based Method (Web-based)

The Web form-based interface provides a set of four pages that guide you through setting up an MBC job.
You provide the information necessary to boot and provision a server on the first three pages/forms. The
final page displays the progress/results of the job. You can act only on a single server when using the
form-based method. For multiple server setup, you must use the CSV method.

Using the CSV Method from the Web Interface

The CSV input method can be accessed by clicking the Multiple Client Form... button on the first page of
the MBC Web Ul. The CSV input form allows acting on multiple server records at once, where each line in
the CSV represents a server record.

The MBC APX Command-Line Interface

MBC also provides a Program APX, which is available to users as an executable in the Global Shell (0GSH).
This can be useful for programmatic access to MBC while integrating with other systems.

Usage:
Users who have the appropriate permissions can run MBC from OGSH with this command:

/opsw/apx/bin/osprov/manage _boot_clients_script
Running MBC from the command line with no arguments will provide a usage statement.
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This is an example command line entry that executes MBC and uses an existing CSV file:

/opsw/apx/bin/osprov/manage boot_clients_script -m import
<full path to CSV file with boot clients>

Special Attributes for the CLI and CSV Input Form

There are several special attributes which are not stored as custom attributes (except sequence_id)
when entered, but instead are dealt with in distinct ways. Table 12 lists these special attributes and how

they are dealt with.

table 12 MBC Special Attributes for the CLI and CSV Input Form

Parameter

Description

buildplan_id

If specified, will invoke an 0S Build Plan installation as the user using MBC as
soon as the server is added to the Server Pool.

Note: buildplan_idis stored as a custom attribute on the server. This
custom attribute is removed from the server record when a Build Plan is
started on the server.

pxe_image

Specifies a PXE configuration files for the server. The value should be set to
one of the options seen in the default PXE menu (such as winpe32,
winpe64, 1inux6 or 1inux6-x64 when using an 0S Build Plan, or
winpe32, winpe64, 1inux5 or 1inux6 when using an 0S Sequence.). This
copies the configuration file

/opt/opsware/boot/tftpboot /pxelinux.cfgto the MAC address file.

sequence_id

If specified, will invoke an 0S Sequence installation (as detuser) as soon as
the server is added to the Server Pool.

Note: sequence_idis stored as a custom attribute on the server. This
custom attribute is removed from the server record before the first reboot of
the server.

customer Sets the customer association for the server.

use Sets the use field for the server. The value specified should be all caps (for
example, PRODUCTION)

stage Sets the stage field for the server. The value specified should be all caps (for
example, IN DEPLOYMENT)

facility Sets the facility ID association for the server. This is necessary when you run
an MBC APX from a facility other than the one that the target server is
associated with (necessary when you have a satellite that defines its own
facility).

ilo.* See ilO Integration on page 150.
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table 12 MBC Special Attributes for the CLI and CSV Input Form (cont’d)

Parameter Description

dhcpcleanup Retrieves the DHCP configuration or deletes a DHCP entry by MAC address.
Options are:
* - help (-h):Displays online help
* - action(-a): Options are:

— get: Retrieves the DHCP configuration

— delete: Deletes a DHCP server(s) from the configuration. You must
also specify either the:

—  The MAC addresses or

- —-facility (-f)=FACILITYNAME: specify which facility's
DHCP servers to operate on.

- --macs (-m)=MACS: a comma-separated list of MAC addresses
to remove from the DHCP configuration.

- —-outputdir (-0)=OUTPUTDIR: when specified, MBC saves
progress and results information in the specified directory.

Additional non-MBC-specific custom attributes are available for the installation of Windows, Solaris, and
Linux operating systems such as hostname, ComputerName, etc.

CSV Input Files

MBC'’s ability to accept CSV input files allows you to move servers into the Managed Server Pool and
provision them with an operating system without the use of a console and an interactive session.

For example:

00:0c:29:el1:28:2e,hostname=testvml, pxe_image=1inux6,
buildplan_id=2110061

00:0c:29:£9:12:f3,hostname=testvm2, pxe_image=winpe32
00:0c:29:0d:ab:b4d, pxe_image=winpe64, buildplan_ id=2110061

These CSV entries would cause MBC to create three Planned Server records and set them up to boot to the
linux6, winpe32, and winpe64 PXE images, respectively. The servers processed by the first and third
CSV entries will also have an 0S Build Plan applied when they register with SA. The first two entries would
have specific display names shown in SA (hostname=), while the third would have an auto-generated
hostname that would be similar to dhcp-client-00:0c:29:0d:ab:b4.

Example CSV Entries

00:13:E8:9A:93:BA, pxe_image=winpe32,dhcp.ip=10.2.3.11,
dhcp.hostname=m0011, customer=Weal thManagement,
sequence_1d=2030001,dns_server=10.6.4.2,

kernel_arguments=noacpi, root_password=wealth

00:13:E8:9A:93:BC, pxe_image=winpe32,dhcp.ip=10.2.3.12,dhcp.hostname=m0012,
customer=Weal thManagement, sequence_id=2030001,
dns_server=10.6.4.2,kernel_arguments=noacpi,

root_password=wealth

00-13-E8-9A-93-99, pxe_image=1inux
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00:13:E8:9A:93:AA, pxe_image=windows, custattrl=vall,
custattr2=val2

00:13:E8:9A:93:BB, pxe_image=windows, customer=0Opsware

00:0c:29:23:al:7f,pxe_image=1linux, sequence_id=310005,
testca=testval

00:0c:29:af:46:6b, pxe_image=1linux, sequence_id=310005,
testca=testval

00:0c:29:be:96:6e,pxe_image=winpe3?2, sequence_1d=320005

00-13-21-DD-DD-24, pxe_image=1linux, sequence_id=310001,
dhcp . hostname=danube, ilo.hostname=10.128.32.102,
ilo.username=Administrator, ilo.password=adminpass,
ilo.reboot_if on=1

The first item on each line of CSV must be a MAC address followed by a list of arbitrary, comma-separated
name/value pairs, where the names and values are separated by equal signs. Each of these name/value
pairs is stored as a custom attribute on the server record which allows the user to set up many custom
attributes simultaneously.

Special Attributes for DHCP Reconfiguration

MBC has the ability to add host definitions to SA DHCP configuration files. This is useful in environments
where SA DHCP is used, but configured to deny unknown clients (that is, it will only provide DHCP leases to
approved MAC addresses). When you specify a DHCP hostname’s MAC address on the General Form, MBC
adds this MAC address to DHCP configuration. You can also specify DHCP IP address if required.

Table 13 lists the DHCP reconfiguration special attributes you can use in the CSV:

table 13 DHCP Reconfiguration Special Attributes

Attribute Description
dhcp .hostname Specifies the MAC address for hostname(s) that are authorized for DHCP
leases.
dhcp.ip Specifies the IP address(es) of hosts that are authorized for DHCP leases.
iLO Integration

MBC includes integration with the HP Integrated Lights-Out 2, 3 and 4 (iL0O2, iLO3, iLO4) Standards. This
increases the level of control that SA has over servers, down to the level where the users no longer have to
even power on the servers. When the user provides aniLO IP and credentials, MBC will connect to the iLO
APl and automatically power on the server. iLO also provides more thorough hardware discovery.
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Table 14 show the special attributes used for iLO Integration:

table 14 iLO Special Attributes

Special Attribute Description

ilo.hostname Hostname or IP address for the iLO. This must be accessible from the hub
server. This value is stored as a custom attribute by MBC.

ilo.username Username to use to authenticate to the iLO. This value is stored as a custom
attribute by MBC.

ilo.password Password used to authenticate to theiLO. This value is not stored as a custom
attribute by MBC.

ilo.reboot_if_ on Default: power the server on only if it is currently off. If you specify this
argument with a non-null value, MBC reboots the server, even if it's already
on. This value is not stored as a custom attribute by MBC.

The first page of the Web APX has form inputs for the iLO parameters.
The following is an example CSV that will cause MBC to boot/reboot the server:

00-13-21-DD-DD-24, pxe_image=1inux, sequence_id=310001,
dhcp . hostname=danube, ilo.hostname=10.128.32.102,
ilo.username=Administrator, ilo.password=adminpass,
ilo.reboot_if_ on=1

Booting a Red Hat Enterprise Linux Server in a Non-DHCP Environment

If you plan to use SA Provisioning in an environment without a DHCP server, you must assign static IP
information for the managed server and manually configure that server to resolve the SA Core.

There are several reasons you might need to manually specify the network information for a sever being
provisioned:

*  You don't use DHCP and must manually specify the static IP address and the Agent’s IP and Port
*  You must provision a server but DHCP is inactive.
*  You must provision a server but DHCP is blocked by firewall rules.

CD boot images for Linux SA Provisioning in non-DHCP environments can be exported by selecting Library
> By Folder > Opsware > Tools > 0S Provisioning.

The images are named using the following format:
HPSA linux boot_cd.iso

This section provides details for provisioning in a non-DHCP environment.
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When you boot an unmanaged server in a non-DHCP environment, you will see a boot screen similar to
that shown in Figure 14:

fefanlt after 18 seconds)

boot

After you select the boot method, you see a dialog that allows you to choose whether you want to boot
your machine using DHCP or enter the static network configuration.

If you choose DHCP, SA uses your DHCP server for configuration. If you choose static, you will see a
Network Configuration dialogue that allows you to enter a static IP address for the server, the subnet
mask, The host gateway IP address, and the IP address and default port for the SA Agent Gateway,
Figure 15:

IP Configuration details

* Interface:

IF Address
Hetwork Mask 55.255.255.0
Default gateway: nter Necwork Router degails

DNS Server:
DNS Search Path:

Mandatory fields

You can manually configure the following fields:
Interface: the NIC to be used
IP Address: static IP address for the server being provisioned
Netmask: netmask for the server being provisioned

Default gateway: Gateway IP address the server being provisioned should use (network level IP
router)



*  DNS Server: the IP address the server being provisioned should use
DNS Search Path: the fully qualified DNS suffix the server being provisioned should use
*  SAServer IP: IP address of the SA Core host

After the information in these fields is entered and applied, the server is able to register with the SA Core.
You can now start the normal SA Provisioning process.

DHCP Custom Attribute
Servers that have been registered with the SA Core using a static IP specification will display the
hpsa_netconfig custom attribute in the server record, as shown in Figure 16:

figure16  hpsa_netconfig Custom Attribute in Server Record
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Booting a Red Hat Enterprise Linux Itanium 64-bit Serverina
Non-DHCP Environment Using Elilo Boot

If you plan to use SA Provisioning in an environment without a DHCP server, you must assign static IP
information for the managed server and manually configure that server to resolve the SA Core.

There are several reasons you might need to manually specify the network information for a sever being
provisioned:

*  You don't use DHCP and must manually specify the static IP address the Agent’s IP and Port
*  You must provision a server but DHCP is inactive.
*  You must provision a server but DHCP is blocked by firewall rules.

You can export the Linux Itanium image by logging in to the SA Client and selecting
Library > By Folder > Opsware > Tools > 0S Provisioning.

The images are named using the following format:
HPSA_ linux boot_cd_TIA64.iso

The following section provides details for provisioning in a non-DHCP environment.
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When you boot an unmanaged server in a non-DHCP environment, you will see a boot screen similar to
that shown below::

HP SA Linux Boot CD (<version) :
Enter the appropriate Linux service 0OS
at the ‘Elilo boot:’ prompt.

linux5 - RHEL 5.7 based Linux service 0OS
linux5-txt - RHEL 5.7 based Linux service 0OS for serial consoles

ELTILO boot:

After you select the boot method, you will see a Network Configuration dialogue that allows you to enter a
static IP address for the server, the subnet mask, The host gateway IP address, and the IP address and
default port for the SA Agent Gateway, Figure 17:

SANetGui NMetwork Settings

Interface:

IP Address:

Netmask:

Gateway:

DNS Serwver:

DNS Search Path:

Agent Gateway IP:
Agent Gateway Port: §

{Tab>s<Alt-Tab> between elements i <Space’> selects i <«F1Z> next scree
> If th_e operating system you are pr_ovisioning is Red Hat Enterprise Linux 3 1A64, you_ must aftld the custom

attribute kernel_arguments with the value console=ttyS1 to the 0S Installation Profile.
You can manually configure the following fields:

Interface: the NIC to be used

IP Address: static IP address for the server being provisioned

Netmask: netmask for the server being provisioned

Gateway: Gateway IP address the server being provisioned should use (network level IP

DNS Suffix: the fully qualified DNS suffix the server being provisioned should use

Agent Gateway IP: the default SA Agent Gateway hostname or IP address

Agent Gateway Port: the port used for the SA Agent Gateway

After the information in these fields is entered and applied, the server is able to register with the SA Core.
You can now start the normal SA Provisioning process.



DHCP Custom Attribute
After provisioning, servers that have been registered with the SA Core using a static IP specification will
display the hpsa_netconfig custom attribute in the server record, as shown inFigure 18:

figure 18  hpsa_netconfig Custom Attribute in Server Record
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Booting a Windows Server in a Non-DHCP Environment

If you plan to use SA Provisioning in an environment without a DHCP server, you must assign static IP
information for the managed server and manually configure that server to resolve the SA Core.

There are several reasons you might need to manually specify the network information for a sever being
provisioned:

*  You don't use DHCP and must manually specify the static IP address and the Build Manager’s IP and
Port

*  You must provision a server but DHCP is inactive.
*  You must provision a server but DHCP is blocked by firewall rules.

When provisioning a server using WinPE, by default, WinPE looks for a DHCP server. If a DHCP server is not
found, you are prompted to enter the IP address, Subnet mask, Gateway and Name server of the host, and
the Port and Hostname/IP of the SA Core.

This section provides details for provisioning in a non-DHCP environment.
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Booting an Unmanaged Windows Server in a Non-DHCP Environment
When you boot an unmanaged server into a non-DHCP environment, by default WinPE looks for an

available DHCP server. If WinPE does not find a DHCP server, you see a display similar to Figure 19.

[Fa] X=\windows \system32\cmd.exe - startnet.cmd

Initializing WinPE. Please be patient....

Hindows IP Configuration

Ethernet adapter Local Area Connection:

Connection—specific DNS Suffix
Default Gateway

ERROR?

WINPE DETECTED A CONNECTED NETWORK ADAPTER. BUT COULD NOT OBTAIN A DHCP IP.
PLEASE CHECK YOUR DHCP SERUER CONFIGURATION AND MAKE SURE YOU ARE
CONNECTED TOQ THE CORRECT NETUWORK.
¥OU MIGHT ALSO BE OUT OF LEASES IN YOUR DHCP POOL.

TRYING AGAIN IN 38 SECONDS.

COULD NOT GET AN IP ADRESS UIA DHCP.
TRYING AGAIN IN 3@ SECONDS.

At this point, you will see a Network Configuration dialogue that allows you to enter the SA Agent Gateway
IP or enter a static IP address for the server, the subnet mask, The host gateway IP address, and the IP
address and default port for the Build Manager. See Figure 20:

=i
Interface™ |Intel(R) PROJ1000 MT Network Connectio ~ |

MAC Address: 00:0C:29:D3:72:DE
" StaticIP = DHCP

IP Address:
Netmask: @EHI'
Gateway: EDEHI'
DNS Server: :ll:“:”:l

DNS Suffix: |

Server Automation Agent Gateway

Hostname { IP: | |

0K Cancel |

Select the correct Interface and specify the Static IP.
You can manually configure the following fields:
IP Address: static IP address for the server being provisioned
Subnet: Subnet mask for the server being provisioned
Gateway: Gateway IP address the server being provisioned should use (network level IP router)
DNS Server: the IP address the server being provisioned should use

DNS Suffix: the fully qualified DNS suffix the server being provisioned should use



* Agent Gateway: SA Agent Gateway hostname or IP address

*  Port: The port used for the Build Manager

After the information in these fields is entered and applied, the server being provisioned will be able to
register with the SA Core.

DHCP Custom Attribute

Servers that have been registered with the SA Core using a static IP specification will display the
hpsa_netconfig custom attribute in the server record, as shown inFigure 21:

figure21  hpsa_netconfig Custom Attribute in Server Record
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B HP-UX Provisioning

HP-UX Provisioning installs HP-UX on bare metal systems using custom configurations. The HP-UX
Provisioning process requires the following tasks:

e Setting up an Ignite environment on SA cores/satellites

*  Creating custom configurations using the Custom Configuration Editor APX on the SA core
*  Booting the target to the Network boot prompt

*  Provisioning targets using the HP-UX Provisioning APX on the SA Core

The following sections discuss these tasks.

Prerequisites
You must insure that the following prerequisites are met before you can provision HP-UX servers.

Ignite Setup on the SA Core

To provision HP-UX servers, you must set up Ignite Configurations. This includes:
* updating the configuration file

* updating the Index file

* copying the golden image archives on each SA core

For detailed information on Ignite-LUX software on a server running Linux, see

http://www.hp.com/go/ignite-ux-docs

The following tasks are required to set up the 11.31 golden archive-based configuration on the SA Core:

*  Copy over the sample golden image to the following location:
/var/opt/ignite/archives/B.11.31/

*  Copy over the corresponding . c£g file to following location:
/var/opt/ignite/data/Rel_B.11.31/B.11.31_archive IA.cfg

e Addan entry in /var/opt/ignite/INDEX for the configuration as follows:

cfg "HP-UX B.11.31 Opsware Archive" {
description "This selection supplies the sample golden archive
created by the IUX team"

"/opt/ignite/data/Rel_B.11.31/config"
"/opt/ignite/data/Rel_B.11.31/hw_patches_cfg"
"/var/opt/ignite/data/Rel_B.11.31/B.11.31_archive_ IA.cfg"
"/var/opt/ignite/data/config.local"

}
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If you use HPUX 0OS Provisioning, the following steps are required on the SA Core with Ignite installed:
Edit the /etc/exports file
Change the line the following line:
/var/opt/ignite/clients * (ro,no_root_squash,async)
to
/var/opt/ignite/clients * (rw,no_root_squash, async)

Run "exportfs -a"

APXs

SA installs the HP-UX Provisioning APX (Automation Platform Extensions) and Custom Configuration
Editor APX which perform parts of the provisioning process. These APXs appear in the SA Client APX
Library.

You can access APXs either through the SA Client or through an SA supported browser. HP
recommends running the Custom Configuration Editor APX with Internet Explorer.

Adobe Flash Player Version 10.0 or above must be installed on all machines on which you plan to run
HP-UX Provisioning APXs.

Customer Configuration Subfolders

SA Administrators for HP-UX Provisioning or any user who has privileges to the following folder must
create a sample configuration for every customer for whom users want to create configurations:

Library > By Folder > Opsware > Tools > 0S Provisioning > HP-UX Provisioning

The sample configuration is the same as the configuration that is created when you use the Custom
Configuration Editor APX. It is called the sample configuration because it is the first configuration created
for each new customer. When the first configuration is created, a subfolder is created for that new
customer. If the SA Administrator wants to assign restricted access to a user/group based on
configurations belonging to a specific customer, they must grant permission to that customer subfolder.

The SA Administrator can see subfolders created with the customer name only after creating the sample
configuration.

When you create the sample configuration, make sure that you select the new customer so that the
subfolder with the customer name is created immediately within the configuration folder. The SA
Administrator can assign read/write access to the user/group to access configurations. For example, say
that PROV_USR needs access to HP-UX Provisioning and should have access only to configurations
belonging to CustA and CustB customers:

Open the Custom Configuration Editor APX using Internet Explorer.

Log on as SA Administrator or as any user who has access to Library > By Folder > Opsware > Tools
> 0S Provisioning > HP-UX Provisioning

Create a sample configuration for CustA and CustB using the Custom Configuration Editor APX.

Log on to the SA client as SA Administrator for HP-UX Provisioning. Create subfolders named CustA
and CustB at the following location:

Library > By Folder > Opsware > Tools > 0S Provisioning >
HP-UX Provisioning/CustA

Library > By Folder > Opsware > Tools > 0S Provisioning >
HP-UX Provisioning/CustB



Permissions

This section discusses the minimum permissions required to use the HP-UX Provisioning feature. Your SA
Administrators for HP-UX Provisioning can optionally provide additional permissions that enable more
features.

User/Group Permissions
SA Administrators for HP-UX Provisioning must grant the following permissions to the user/group:

Facilities — You must have read/write access to any facility where the Integrity servers are provisioned
with the configurations created by the Custom Configuration Editor APX.

Customers — You must have read/write access to any Not Assigned customer to run the provisioning
job successfully.

You must also have read/write access to any customer on whose behalf the HP-UX configurations are
created.

Features — You must have Managed Server and Groups permission so that you can actually see the
server in SA after you provision it.

Folder Permissions

SA Administrators for HP-UX Provisioning must also grant folder permissions to list APXs, software
policies, and configurations.

APXs — You must have List Contents Of Folder and Execute Objects Within Folder permissions to the
following folder to access HP-UX Provisioning and Custom Configuration Editor APXs:

Library > By Folder > Opsware > Tools > 0S Provisioning > HP-UX

Software Policies — You must have List contents of Folder, Read Objects Within Folder, and Execute
Objects Within Folder permissions to the folders where HP-UX software policies used to define the
configurations are placed.

Configurations — You must have Read Objects Within Folder and Write Objects Within Folder
permissions to the following folder because it contains the HP-UX configurations:

Library > By Folder > Opsware > Tools > 0S Provisioning >
HP-UX Provisioning/<customer_name>

Installing an Operating System on HP-UX Servers

HP-UX Provisioning installs HP-UX on bare metal systems using custom configurations. The HP-UX
Provisioning process requires the following tasks:

Setting up an Ignite environment on SA cores/satellites

Creating custom configurations using the Custom Configuration Editor APX on the SA core
Booting the target to the Network boot prompt

Provisioning targets using the HP-UX Provisioning APX on the SA Core

The following sections discuss these tasks.

You must have set up Ignite before continuing. For more information, see Ignite Setup on the SA Core on
>» g p
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Creating a Custom Configuration

You can specify customized configurations to be applied to an Integrity server. You can specify Ignite
attributes that are applied on the server during HP-UX installation on top of the standard golden image
configurations. You can also select additional software policies to be remediated as part of the HP-UX
installation.

You can build customer-specific configurations by specifying the platform, base configuration, Ignite
attributes, and related software policies. You can customize the installation to meet your specific needs.

To provision the server in a customized way, you must first create a custom configuration.
HP-UX Custom Configuration Editor APX
To access the HP-UX Custom Configuration Editor APX, perform these tasks:
1 Inthe SAS Web Client: Open Internet Explorer and specify the URL:
https://<your core>/webapp/<APX Unique Name>
The unique name for the APX is displayed in the SAS Web Client.

2 Inthe SA Client: Click the Library tab and select Extensions > Web > HPUX Custom Config Editor.
The unique name for the APX is displayed when you select the APX.

In this instance, the Custom Configuration Editor APX name is com. hp . osprov. hpuxconfig.

figure22 HP-UX Custom Configuration Editor APX
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All existing custom configurations are listed with Name, Customer, HP-UX Platform, Ignite Server, and
Base Config details. The Refresh, Create, and Delete buttons also appear.

figure23  HP-UX Custom Configuration Editor APX - List Existing Configurations
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When you select any existing configuration from the list, you will see additional details such as Custom
Configurations and Software policies.

The Configuration listings are based on permissions assigned to you. You are able to list configurations
belonging to the customers for which you have been granted permission. The configuration can be
customer dependent or customer independent.

A customer independent configuration is accessible to all users. A customer dependant configuration is
accessible to only those users who have appropriate permissions assigned. You can make the
configuration dependant or independent by selecting the customer when you create the configuration.

The HP-UX Custom Configuration Editor APX enables you to:
*  (Create Custom Configurations

*  Delete Custom Configurations

Creating a Custom Configuration

To create a custom configuration, follow these steps:

1 Open the HP-UX Custom Configuration Editor APX using Internet Explorer.
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2 Click the Create button and specify the required details to create a new custom configuration.

figure24  HP-UX Custom Configuration Editor — Create Custom Config
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3 You must specify the following required details to define the HP-UX custom configuration:

— Config Name: This is a mandatory field. It must be unique for each customer. The APX validates
the following specifications:

-~ Must not exceed 255 characters in length.

-~ Must not begin or end with an empty space.

- Must not begin with punctuation, including @#$%~&* () +_—, . /:;~{} [ |\ ' "?2="
—  Should not use newline, tab, flash or backslash.

— Config Description: This is an optional field that can contain explanatory text describing the
purpose and use of the configuration.

— Customer: By default, this is set to Not Assigned, which makes the configuration customer
independent. You can only list those customers for which you have permission. You will not be
able to list the configurations if appropriate permissions have not been granted to you for that
customer.

— Platform: This is a mandatory field. You must select either 11.31 or 11.23 from the drop-down
menu. Base configuration or Related Software Policies are dependent on platform selection. If
the platform was not selected and you try to select either Base configuration or Related Software
Policies, a warning message appears.

— Base Configuration: Content is displayed based on the HP-UX platform selected.

— Custom Config: This is an optional field that can be used to specify Ignite attributes. Any valid
Ignite attributes specified in this field overwrite the configuration values specified in the golden
image, which allows you to provision the servers in a customized manner.
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HP-UX Provisioning

The following are examples of Ignite attributes:

_hp_pri_swap=6291456Kb

"Create /export volume"=TRUE

_hp_root_disk="0/1/1/1.2.0"

_hp disk layout="Logical Volume manager (LVM) with VxXFS"

For detailed information on Ignite custom attributes, see

http://h20000.www?2.hp.com/bc/docs/support/SupportManual/c01942568/c01942568.pdf

If the attributes and values specified are valid, they are applied on the servers on top of the
standard image configurations. However, if the attributes specified are invalid or have incorrect
syntax, provisioning will not start.

In some cases, attributes and values are incompatible. For example, say that you want to
provision the server with the following Ignite attributes:

_hp_pri_swap=6291456Kb
"Create /export volume"=TRUE

The Ignite attributes syntax is correct and also has valid values but your target does not have
enough disk space to implement it. As a result, a warning message is displayed on the targets
before provisioning starts.

4 Related Software Policies: This is an optional field consisting of a drop-down menu whose contents
are displayed based on the platform selected. You can select multiple Related Software policies by
holding the CTRL key and dragging the policies to the selected software policies list to apply them on
the server after provisioning is completed and the agent is installed.

You can change the sequence of a selected software policy by dragging it up or down. Polices
specified in Selected Software Policies are applied on top of the standard policies in the golden Ignite
image.

After the details for all mandatory fields, Config Name, Platform and Base Config are specified, the
Create button is enabled.

5  Click the Create button. A confirmation message appears and the newly created configuration is

listed.
figure25 Newly Created Custom Config Profile
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Boot Target

The network booted integrity client requires selecting the desired LAN and target 0S to install. It waits for
server side install instructions to start HP-UX Provisioning. The following figure shows a target client
waiting to be installed.

.
£ 192168 240100 - PuTTY = T

For more information, see:
http://h20000.www2.hp.com/bc/docs/support/SupportManual/c01868281/c01868281.pdf

Provision the Target Servers

Once the custom configuration is created, it is listed on the HP-UX Provisioning APX on the SA Client. The
target server waiting at the network boot prompt is listed under the unprovisioned servers list on the
HP-UX Provisioning APX. The following section describes how to provision the targets.

HP-UX Provisioning APX
To access HP-UX Provisioning APX, follow these steps:

Log on to the SA Client.



2 Click the Library tab and select Extensions > Web > HP-UX Provisioning.
HP-UX Provisioning APX
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The HP-UX Provisioning APX popup window showing the HP-UX configuration opens.

figure28 HP-UX Provisioning APX - Listing of HP-UX Configurations
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HP-UX Provisioning

All the configurations created using the Custom Configuration Editor APX are listed on the HP-UX
Provisioning APX based on permissions granted. Configurations are listed with Name, Customer,

HP-UX Platform, Ignite Server, and Base configurations details. The Refresh, Next, and Start buttons
are also displayed. Select the HP-UX configuration you want installed on the servers and click Next.
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When you select a configuration, additional details, including Custom Configurations and Software
policies of the chosen configuration, are displayed. When you select a configuration, the Next button

is enabled.

figure29 HP-UX Provisioning APX - Select HP-UX Configuration
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3 Click Next to select the unprovisioned servers.

All unprovisioned servers waiting at the network boot prompt matching the selected configuration
platform are displayed and show MAC address, install 0S, Ignite Server and Model details. Servers in
the Unprovisioned Servers list register their presence, but do not have an operating system installed.

4 Select the server to provision. Hold down the CRTL key to select multiple servers to provision at the
same time using the same configuration.
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Once all servers are selected, provisioning starts immediately after you click the Start button.
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5

To set email notification, click the Next button. The following screen appears.

f'igure 31 Set the Email Notification
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HP-UX Provisioning

On Email Notification, by default, your email address (the user running the job) is displayed. To add
additional email addresses, click +Add. Select the check boxes to receive notifications when job
failure or success occurs. To remove an email address, select the address and click Remove.

You can also specify the Job Ticket ID in the Ticket Integration section. This Ticket ID is associated with
the Job.
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6 When you click Start, the job is initiated for program APX and the Job ID is assigned to it.

figure 32 Initializing the Provisioning Job
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figure 33  Initializing the Provisioning Job
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If the provisioning job was initiated successfully on the servers, you will see the following screen. This
screen has a progress bar that is refreshed with updated progress status messages. The following
status messages are updated during the provisioning job:

— Waiting_to_install

— Prepare_Config_File

— Configure_Disks

— Download_mini-system

— Loading_software

— Build_Kernel

— Boot_From_Client_Disk

— Run_Postconfigure_Scripts

— Agent Install
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— Remediate software policy

figure34  Progress Bar with Status Message
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Once the provisioning job starts, two different progress bars are displayed. The consolidated progress

bar displays the average percentage of progress on all servers being provisioned. It also displays the
average percentage of jobs finished with the job start time.

The progress bar for each of the servers being provisioned shows the percentage of provisioning
complete with Server Name, MAC address, Status, and Status Message details. The ¥ Completeand
Status Message are updated along with the progress of the provisioning job.

figure35 Progress Bar with Status Message Remediate Software Policies
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Once the server is provisioned, the agent is installed by default. Also, the software policies chosen in
the configuration are remediated on the servers. When the HP-UX Provisioning job completes, an

email is sent to you if you set up email notification.
figure36  Progress Bar with Job Completed Message
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The provisioned servers are managed by SA. The servers are listed under Devices >
All Managed Servers. Select the server, and then select Go to View > Properties. You can see the

customer value, which is the same as the configuration customer value. You can see the servers listed
as managed servers only if you have permission granted for the customer.

You can also verify the configuration name associated with the server. Go to View > Custom
Attributes. This can be useful to find out which configuration was used to provision the server.
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Jobs and Sessions on SA Core

HP-UX Provisioning APX assigns the job ID. You can use the job ID to verify the job status at the following
location: SA > Jobs and Sessions > Job Logs.

figure37  Job Status on SA Jobs and Sessions
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You can also find the specified Job Ticket ID in the notifications tab by double-clicking the job.
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Deleting Custom Configurations

To delete a custom configuration, perform the following tasks:

1 Open the HP-UX Custom Configuration Editor APX using Internet Explorer.

2 Select the configuration or hold the CTRL key to select multiple configurations and click Delete.

figure38 Delete Custom Config Profile
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3 Click Yes on the confirmation window. The selected configurations are deleted and are no longer
listed.

You are allowed to delete only those configurations for which you were granted privileges to execute
the delete configuration operation.

Glossary

Ignite-UX

An HP-UX administration toolset that allows:

simultaneous installation of HP-UX on multiple clients

creation of custom installation configurations (golden images) for multiple installations on
clients

creation of recovery media

recovery of HP-UX clients both locally and remotely

Ignite-UX server

A server from which Ignite-UX is used to install HP-UX on client systems.

Golden Image

A combination of a golden archive and a configuration file describing a system's disk layout and file
system. Used as a common configuration to install clients.
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Ignite Attributes

Custom attributes that allow provisioning of a server with new customized values that overwrite the
standard attributes values defined in the golden image.

Network boot
A system boot of the HP-UX install kernel over a network connection from an Ignite-UX server.
Target or Target Server
The HP Integrity server to be provisioned.
Custom Configuration Editor APX
The APX used to create and delete the custom configurations for HP-UX Provisioning.
HP-UX Provisioning APX
The APX used to start HP-UX Provisioning on target servers.
Sample Configuration

The first configuration created for the new customer by the SA Administrator for HP-UX Provisioning.
It is same as the custom configuration but is the first configuration for a new customer. It creates a
subfolder with the customer name under the HP-UX Configs folder in the SA Client Library.

Useful Links

HP-UX Provisioning

* 11iv3installation information:
http://h20000.www2.hp.com/bc/docs/support/SupportManual/c01916012/c01916012.pdf

*  White paper: Ignite-LUX: Management and Integration of Ignite-UX Software on a Server Running
Linux at:

http://www.hp.com/go/ignite-ux-docs
* Ignite-UX custom configuration files:
http://h20000.www?2.hp.com/bc/docs/support/SupportManual/c01942568/c01942568.pdf
* Ignite-UX:

http://h20000.www2.hp.com/bizsupport/TechSupport/
Documentindex.jsp?lang=en&cc=us&taskld=101&prodClassld=10008&contentType=SupportManual&
docindexld=64255&prodTypeld=18964&prodSeriesld=4077173
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Troubleshooting

Following are some problem scenarios and suggested solutions.
Scenario: No Servers Waiting to be Installed

If there are no servers waiting at the network boot prompt with the HP-UX version that matches the
selected configuration's HP-UX version, the following message is displayed:

figure39 No Servers Waiting to be Installed

There are no servers waiting to be installed in
SA with IINSTALL matching that of the config
platform: HP-UX 11.31

Please choose a different config

Ensure that you have the selected correct configuration.
Scenario: Servers Waiting to be Installed are Managed Servers

If there are servers waiting for network installation but they are already managed by SA, the following
warning message is displayed.

figure40 Servers Waiting to be Installed are Managed Servers

The folloning servers are mansged servars in
84, but are (n the waiting o be installed list

Flanre deleta tham from S& if you want to re-
provision HEF-UX on tham.
1Dl 1 L00SE Name 1 blade=-BE0

This warning message indicates that the listed servers are waiting for installation but are not candidates
for reprovisioning because they are listed as Managed Servers in SA. To continue reprovisioning these
servers, you must manually delete them from the SA managed server list.

For more information about deactivating and deleting a server from the SA managed servers list, see the
User’s Guide: Server Automation.

figure 41 List of Deleted Managed Servers for Reprovisioning
% HP-UX Prov
5 SO s

Select Servers to Provision (Step 2 of 3)

Choose one or more servers from the provisioning pool. To add a server to the poal, it must be network booted.

Selactad HPUX Config: @ Config 11.31 StandAlona2

Name MAC Install OS Ignite Server Modal
D% blade-850 00:11:0A:A5:40:07 B.11.31 192.168.184.195 iaG4 hp Integrity BLESOC
Refresh [ <Back || mext>

Once a server is deleted, it is not listed under the SA managed server list. Click Refresh in the HP-UX
Provisioning APX window and the server should be listed under the unprovisioned server pool. Select the
server and continue provisioning it.
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Scenario: Configurations Unavailable or Permissions Not Granted

This message appears when you do not have enough permission granted to list the configurations or there
are no configurations found.

figure42 No Configurations Available or Permissions Granted

¥ou do not have access to any HP-UX
Configurations or there are no HP-UX

Configurations created in SA. Please re-validate
then press the refresh button

Contact your SA Administrator to obtain permission or create required configurations using the Custom
Configuration Editor APX.

Scenario: Incorrect Target Listing

In certain error scenarios, you may see stale data in the APX client’s menu such as clients that are not
currently waiting to be network installed or clients with an incorrect hostname.

* Aclient that is not currently waiting to be network installed is displayed in the APX clients list.

If the target server is reset while waiting to be network installed, the Ignite-UX cannot detect the
change and does not update the client’s status.

Retry the installation or delete the directories for the target under /var/opt/ignite/clients/.
There are two directories for each client, one of the form <mac address> (for example,
0x00306EF37245) and the other a symbolic link to the directory. Delete both directories.

* Aclientis listed in the APX with an incorrect hostname.

This can happen when you modify DHCP to provide a different hostname after having previously
provisioned the client. Ignite UX reuses the directories in /var/opt/ignite/clients/ it set up for
a client (when it finds a client based on the MAC address), so the APX reuses that information. You can
delete the two directories for the client under

/var/opt/ignite/clients and retry the installation.

Scenario: Installation Timed Out Error

An installation timed out error occurs when the provisioning job is not initiated on the target server. This
could be due to a network issue, the golden image not being available, or for other reasons.

figure43  Provisioning Not Initiated on Server
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Wiew the status of the job. Active jobs will continue to run if the window is closed.
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Status: Completed successfully
Start tima: Wead May 15 13:55:05 GMT-0700 2010
End tima: Wed May 19 14:18:45 GMT-0700 2010

Server Name MAC address Status % Complete Status Message L
kosz2 00:30:6E:4B8:C7:47 install timed cut [ /=itino_To_install
081_wpar 00:0F:20:2B:23:2F Completad succassf [N = =m=dist= Softwars Policies

Ensure that the network connection and Ignite images are accessibility and run the APX again to initiate
provisioning.
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Scenario: Loading Software Error
A loading software error can occur due to:

*  Network issues

Corresponding archive missing or not accessible

Incorrect setup of golden images

figure44 GoldenImage Set Up Incorrectly
53 HP-UX Prov

E=lEen
- SO0 o

Job Progress for Job ID 14750053

Wiew the status of the job. Active jobs will continue to run if the window is closed.

Selected HPUX Config: &7 11.31 Blad=850C config

Status: Completed successfully
Start time: Wed May 19 14:58:32 GMT-0700 2010
End time: Wed May 19 15:21:44 GMT-0700 2010

Server Nama MAC address

blade-860

Status 20 Complate Status Message

00:11:04:A5:40:07 Error S o=ding_softvars

To resolve this, ensure that the Ignite-specific configuration file, Index file, and archives are correctly set
up and pointing to correct locations. Also ensure that the network connection between the target and the
Ignite server is accessible.

Scenario: Prepare Config File Error

The provisioning job fails to initiate on the server when any syntax errors are found in the custom
attributes specified in the configuration or when the custom attributes are not compatible.
figure45 Provisioning Failed Due to Invalid Ignite Attributes
9 HP-UX Prov
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Job Progress for Job ID 15540053
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View the status of the job. Active jobs will continue to run if the window is closed.
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Status: Completed successfully
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Status % Complete
kosz

Status Message
00:30:6E:48:C7:47 Error

I - -=r=_Config_Fis

You may need to reboot the system and bring it back to the network boot prompt, then create a new

configuration with corrected custom attributes. Ensure that the specified syntax is correct and
compatible.

Scenario: Agent Fails to Start

If, after successful job completion, the SA Agent fails to start on a newly provisioned target, the golden
image you used may already have an Agent installed.

For example, as part of the standard provisioning process, after HP-UX is installed on the server, a

post-install script that installs an Agent runs on the server. Because the Agent was previously installed
with the golden image, the Agent may not start.
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Linux
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SA Client Windows servers
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